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Notice
While reasonable efforts were made to ensure that the information in this 
document was complete and accurate at the time of printing, Avaya Inc. 
can assume no liability for any errors. Changes and corrections to the 
information in this document may be incorporated in future releases.

Documentation disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions 
to the original published version of this documentation unless such 
modifications, additions, or deletions were performed by Avaya. 
Customer and/or End User agree to indemnify and hold harmless Avaya, 
Avaya's agents, servants and employees against all claims, lawsuits, 
demands and judgments arising out of, or in connection with, subsequent 
modifications, additions or deletions to this documentation to the extent 
made by the Customer or End User. 

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked 
Web sites and does not necessarily endorse the products, services, or 
information described or offered within them. We cannot guarantee that 
these links will work all of the time and we have no control over the 
availability of the linked pages.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your 
sales agreement to establish the terms of the limited warranty. In 
addition, Avaya�s standard warranty language, as well as information 
regarding support for this product, while under warranty, is available 
through the following Web site:
http://www.avaya.com/support 

Preventing toll fraud
"Toll fraud" is the unauthorized use of your telecommunications system 
by an unauthorized party (for example, anyone who is not a corporate 
employee, agent, subcontractor, or person working on your company's 
behalf). Be aware that there may be a risk of toll fraud associated with 
your system and that, if toll fraud occurs, it can result in substantial 
additional charges for your telecommunications services.

Avaya fraud intervention
If you suspect that you are being victimized by toll fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya Web 
site:
http://www.avaya.com/support 

Providing telecommunications security
Telecommunications security (of voice, data, and video communications) 
is the prevention of any type of intrusion to (that is, either unauthorized or 
malicious access to or use of) your company's telecommunications 
equipment by some party.
Your company's "telecommunications equipment" includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, "networked equipment").
An "outside party" is anyone who is not a corporate employee, agent, 
subcontractor, or person working on your company's behalf. Whereas, a 
"malicious party" is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with 
either malicious or mischievous intent.
Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or 
packet-based) equipment or interfaces for reasons of:

� Use (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment. Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including, but not limited to, human and data privacy, 
intellectual property, material assets, financial resources, labor costs, and 
legal costs).

Your responsibility for your company's telecommunications 
security
The final responsibility for securing both this system and its networked 
equipment rests with you, an Avaya customer's system administrator, 
your telecommunications peers, and your managers. Base the fulfillment 
of your responsibility on acquired knowledge and resources from a 
variety of sources, including, but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure:

� Your Avaya-provided telecommunications systems and their 
interfaces

� Your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

� Any other equipment networked to your Avaya products.

Trademarks
Avaya is a trademark of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners.

Avaya support
Avaya provides a telephone number for you to use to report problems or 
to ask questions about your contact center. The support telephone 
number is 1-800-242-2121 in the United States. For additional support 
telephone numbers, see the Avaya Web site:
http://www.avaya.com/support

Avaya Training
Avaya provides training for Avaya Operational Analyst. For more 
information, contact Avaya University at:

Web site: http://www.avaya-learning.com/logon_form.asp 
E-mail address: avaya.u.helpdesk@accenture.com 
US telephone: 1-800-288-5327
Outside US telephone: +1-303-406-6089

http://www.avaya.com/support
http://www.avaya.com/support
http://www.avaya.com/support/
http://www.avaya-learning.com/logon_form.asp
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Preface

Avaya Operational Analyst Release 7.0 Installation and Configuration describes the Avaya 
Operational Analyst (OA) installation and configuration procedures. These procedures are 
valid for OA 7.0 and any subsequent 7.0.x releases until this document is reissued.

This section includes the following topics:

● Product description on page 9

● Intended users on page 10

● Reasons for reissue on page 10

● Organization on page 10

● Related information on page 11

Product description
Avaya OA allows businesses to perform operational reporting for a multimedia contact 
center, smoothly growing from single channel analysis, to full interaction, multi-channel 
analysis with a common data model and common user interfaces across the contact center 
systems.

Avaya OA works with Avaya Interaction Center (Avaya IC), functioning as a contact center 
performance analysis system. Avaya OA provides reporting capabilities that supplement 
the Avaya IC reporting tools. 

Avaya OA also works with the Avaya Call Management System (CMS) for extended, online 
historical data storage and multi-site analysis, receiving External Call History (ECH) data 
and historical interval data from up to 30 CMS servers and up to 240 ACDs.
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Intended users
This information is intended for Avaya Professional Services Organization (PSO) 
personnel, business partners, and customers who install their own OA software.

Reasons for reissue
This is the second issue of this document. This updated document describes platform 
enhancements for OA 7.0, plus other required updates and corrections.

Organization
This document includes the following information:

● Preparing for installation on page 13 describes the prerequisites that must be checked 
and the procedures that must be done before you install Avaya OA subsystems, client 
software, and data collection software.

● Installing Avaya OA components on page 29 describes how to install the Avaya OA 
subsystems, client software, and data collection software.

● Configuring Avaya OA subsystems and event collectors on page 117 describes how to 
configure the Avaya OA components.

● Making changes to installed Avaya OA components on page 149 describes how to add, 
repair, move, or remove Avaya OA components.

● Upgrading Avaya OA software on page 269 describes how to upgrade the Avaya OA 
software.

● Troubleshooting an installation on page 309 describes how to troubleshoot installation 
problems.

● Appendix A: Port assignments on page 319 describes the TCP ports used with Avaya 
OA and Avaya IC configurations.

● Appendix B: Changing the Cognos installation on page 341 describes how to move the 
location of a Cognos installation.

● Glossary on page 357.
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Related information
The following table lists all of the Avaya OA information, both documents and online help 
systems:

The following table lists Avaya IC information that may be helpful:

Title Number Compas 
ID

Avaya Operational Analyst 7.0 What�s New in Operational Analyst 07-300405 111978

Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites

07-300071 111976

Avaya Operational Analyst Release 7.0 Installation and Configuration 07-300072 111977

Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting

07-300073 107357

Avaya Operational Analyst Release 7.0 Reports Reference 07-300074 111980

Avaya Operational Analyst 6.1.3 Data API Utility 07-300075 101720

Avaya Operational Analyst 7.0 Administration Client Online Help See Administration client 
help or library CD-ROM

Avaya Operational Analyst 7.0 Basic Reports Online Help See Report client help

Data Model Help See product CD-ROM

Security Guide See product CD-ROM

Title Number Compas 
ID

Avaya Interaction Center Release 7.0 Installation Planning and 
Prerequisites

07-300099 107128

Avaya Interaction Center Release 7.0 Installation and Configuration 07-300100 107234

Avaya Interaction Center 7.0 Business Advocate Configuration and 
Administration

07-300106 107874
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The Release.pdf file contains the latest notes about installation of OA components. 
Avaya recommends that you read these notes before installation. 

After installation, you can view the release notes at:

● %PABASE%\doc\Release.pdf (Windows)

● $PABASE/doc/Release.pdf (Solaris and AIX)

The default installation directories that represent %PABASE% and $PABASE are:

● c:\Program Files\Avaya\BI (Windows)

● /export/home/biadmin/BI (Solaris)

● /home/biadmin/BI (AIX)

The database operations explained in this document require the services of either a 
qualified database administrator or a systems integrator who possesses in-depth 
knowledge of database fundamentals and of the operating system. Some suggested 
reference materials include:

● For Oracle databases:

- Oracle8i 8.1.7 Installation Guide for Windows

- Oracle8i 8.1.7 Client Installation Guide for Windows

- Oracle8i Administrator's Reference Release 3 (8.1.7) for Sun SPARC Solaris

- Oracle8i Installation Guide Release 3 (8.1.7) for Sun SPARC Solaris

- Oracle9i Database Installation Guide (Windows)

- Oracle9i Client Installation Guide Release 2 (9.2.0.1.0) for Windows

- Oracle9i Installation Guide Release 2 for UNIX Systems

- Oracle9i Administrator's Reference for UNIX Systems

- The Legato Storage Manager administrator guide

● For Microsoft SQL databases:

- Microsoft SQL Server 2000 Books Online

- Microsoft database documentation

● For DB2 databases, the DB2 documentation, which is available online after you install 
the database software.

● For TimesTen databases, the TimesTen documentation, which is available online after 
you install the Real-time subsystem. The documentation is copied to the following 
location:

- %PABASE%\doc\TimesTen (Windows)

- $PABASE/doc/TimesTen (Solaris and AIX)

For detailed information about how to install operating system software, refer to the 
documentation that accompanies the operating system software. 
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Preparing for installation

Before you begin the OA installation, read the following sections and do any procedures 
given in these sections:

● Software on the Avaya OA CD-ROM on page 14

● Path definitions on page 18

● Security for Unix platforms on page 21

● Preinstallation checklist on page 22

● Subsystem and client software installation considerations on page 26

● Avaya OA installation examples on page 27
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Software on the Avaya OA CD-ROM
The OA software CD-ROM includes the following:

● Server applications on page 14

- Historical subsystem

- Real-time subsystem

- Report subsystem

● Client applications on page 15

- Administration 

- Basic Reports

- Advanced Reports

- Data API Utility

● Data collection applications on page 16

- Source-CMS

- Source-EC (Event Collector)

- Source-EC Bridge (Event Collector Bridge)

● Third-party applications on page 17

- Java Runtime Environment (JRE)

- TimesTen Database

Server applications 
Avaya OA server components consist of core (common) software applications. This core is 
automatically and transparently installed when required, based on which components of 
OA are installed.

Historical subsystem 

The Historical subsystem analyzes the data in the database. This release of OA requires 
Oracle 8i, Oracle 9i, Microsoft SQL Server 2000, or DB2 to create and operate the 
database.
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Real-time subsystem 

The Real-time subsystem processes the active work items in the real-time database. This 
release of OA requires the TimesTen Real-time database software, which is installed 
automatically when you select the Real-time subsystem while installing OA.

Report subsystem

The Report subsystem and Advanced Report subsystem provides the Web-based report 
framework necessary to run Basic Reports or Advanced Reports. 

Client applications
Avaya OA client components are applications that are active on clients to help you manage 
many of the OA functions. These applications can be installed on hardware as described in 
Client PC minimum hardware requirements on page 33 and on software as described in 
Client software requirements on page 37 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites.

Administration

The Administration client is an OA utility that allows you to manage many of the OA 
components and operations using a graphical user interface running under Internet 
Explorer 6.0 SP1 or later.

Administration client can be installed on any or all of the Windows-based OA or Avaya IC 
servers or on a standalone Windows-based workstation.

Basic Reports

The Report client allows you to view the OA Basic Reports and the OA Tabular Reports. 
The Report client is installed on standalone Windows-based workstations.

! Important:! Important:
Important: When installing the Report client, consider the following:

● Do not install the Report client on any machine running Windows server 
software, either Windows 2000 or Windows 2003.

● Do not install the Report client coresident on any Avaya IC servers.

● For performance and different hardware and software requirement reasons, 
running the Basic Reports on the report server is not supported.
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Advanced Reports

Advanced Reports require Cognos Impromptu Administrator and PowerPlay 
Transformation Server to view non-web-based reports. Transformer is used to generate 
the cube, and PowerPlay is used to view the cube. If you want to view the web version of 
the reports, you must also install Cognos Impromptu Web Reports and Cognos PowerPlay 
Enterprise Server, which also automatically installs Cognos Upfront. You can install these 
applications from the Cognos CD-ROM that is shipped with the OA software. Refer to the 
Cognos documentation for more information on which Cognos components must be 
installed and where they are installed. Advanced Reporting must be installed on the same 
server as the Cognos Impromptu Administrator.

The Cognos catalog connects with the database from the machine running Cognos, and 
requires the appropriate database client. 

PowerPlay requires access to pre-defined PowerPlay cubes. Each user that wants to run 
PowerPlay must have access to the cubes. If you do not install the cubes on the same 
machine as PowerPlay, you need LAN access from the PowerPlay machine through a 
mapped drive to the location of the PowerPlay cubes.

Data API Utility

Operational Analyst offers a Data API Utility for exporting data from the real-time and 
historical databases to support work force management software. 

Data collection applications
Avaya OA data collection applications must be loaded on Avaya IC or Avaya Call 
Management System (CMS) servers from which data will be collected for reporting through 
OA.

Source-CMS subsystem

The Source-CMS subsystem is loaded on the CMS server to collect and send data to the 
OA historical server.

Source-EC (Event Collector) subsystem

The Source-EC (Event Collector) subsystem is loaded on an Avaya IC server to collect 
data from the ADU servers and send the data to the OA Real-time subsystem. 
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Source-EC Bridge (Event Collector Bridge) subsystem

The Source-EC Bridge (Event Collector Bridge) subsystem is loaded on an Avaya IC 
server to collect data from Avaya Business Advocate. 

Third-party applications

Java Runtime Environment (JRE)

JRE is required for Java-based applications, such as OA Administration client. JRE 
provides the environment that enables these applications to run. JRE is automatically 
installed during OA installation on servers, but must be manually installed when installing 
the Report client support files on a Windows system. For more information about which 
versions of JRE are installed, see Java Run-time Environment on page 54 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: Using this version of JRE could impact customer applications on Windows 

systems if the applications require a different version.

TimesTen Real-time database

This software provides the memory-resident database used by the OA Real-time 
subsystem to store real-time operational information about the contact center. TimesTen is 
automatically installed when you install the Real-time subsystem.
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Path definitions
It is important to understand the path definitions for the different operating systems:

● Windows path definitions on page 18

● Solaris path definitions on page 19

● AIX path definitions on page 20

! Important:! Important:
Important: If you choose to install OA in locations other than the defaults recommended 

by Avaya, this will affect all examples of install locations noted in this 
document.

Windows path definitions
The following variable is used in this document to represent the installation path for most 
OA software on Windows:

%PABASE%

For example, the location for a file in that path is shown as follows:

%PABASE%\stumbras\tomcat\work\localhost_8080

The following is the default installation path OA uses on a Windows server:

c:\Program Files\Avaya\BI

Note:
Note: When installing OA, the BI portion of the path is not displayed when the 

default path is shown in the Destination dialog box. This is added as part of 
the installation.

The following variable is used in this document to represent the installation path for EC 
Server and EC Bridge software on Windows:

%AVAYA_IC70_HOME%\bin

The following is the default installation path IC uses on a Windows server:

c:\Program Files\Avaya\IC70
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Solaris path definitions
The following variable is used in this document to represent the installation path for most 
OA software on Solaris:

$PABASE

For example, the location for a directory in that path is shown as follows:

$PABASE/data/log

Depending on how the OS was installed and how the filesystems were created, the 
following is the default installation path OA uses on a Solaris server:

/export/home/biadmin/BI

Note:
Note: When installing OA, the BI portion of the path is not displayed when the 

default path is shown in the Destination dialog box. This is added as part of 
the installation.

The following variables are used in this document to represent the installation path for the 
Sun Web Server software on Solaris:

$SUN_WEB_HOME

The following variables are used in this document to represent the installation path for EC 
Server software and libraries on Solaris:

$AVAYA_IC70_HOME/bin

$AVAYA_IC70_HOME/lib

Depending on how the OS was installed and how the filesystems were created, the 
following is the default installation path IC uses on a Solaris server:

/opt/Avaya/IC70
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AIX path definitions
The following variable is used in this document to represent the installation path for most 
OA software on AIX:

$PABASE

For example, the location for a directory in that path is shown as follows:

$PABASE/data/log

Depending on how the OS was installed and how the filesystems were created, the 
following is the default installation path OA uses on an AIX server:

/home/biadmin/BI

Note:
Note: When installing OA, the BI portion of the path is not displayed when the 

default path is shown in the Destination dialog box. This is added as part of 
the installation.

The following variables are used in this document to represent the installation path for the 
WebSphere software on AIX:

$WEBSPHERE_HOME

The following variables are used in this document to represent the installation path for EC 
Server software and libraries on AIX:

$AVAYA_IC70_HOME/bin

$AVAYA_IC70_HOME/lib

Depending on how the OS was installed and how the filesystems were created, the 
following is the default installation path IC uses on an AIX server:

/usr/Avaya/IC70
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Security for Unix platforms
Avaya recommends that users avoid running Avaya software as the root user for security 
reasons.

Note:
Note: This does not apply to the installation software itself, which must be run as 

the root user.
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Preinstallation checklist 
Before you install OA, verify that these prerequisites have been done:

Procedure

For a configuration that includes Avaya IC, verify that the Avaya IC components 
have been installed, configured, and are started before you install, configure, and 
start the OA components. For more information about Avaya IC planning and 
installation, see:
● Avaya Interaction Center Release 7.0 Installation Planning and Prerequisites
● Avaya Interaction Center Release 7.0 Installation and Configuration

Verify that the customer has obtained the required hardware for their configuration. 
See Server machine hardware sizing on page 34 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites for more information.

Verify that the operating system and any needed service packs or option packs 
have been installed. See Server software requirements on page 38 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites for more 
information.

Verify that the supporting software on each server has been installed. See Server 
software requirements on page 38 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites for more information.

Plan where the components will reside. This information will be required during 
installation. 
● Plan to install OA on a disk drive separate from the physical drive on which your 

operating system or database software resides. This is recommended to 
improve performance. 

● Please note that while one or more OA components can be installed on a given 
server, a specific component cannot be split among multiple servers. 

See Database and server machine considerations on page 24 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites for more 
information.

Verify that the minimum amount of recommended free disk space and memory is 
available. Avaya support personnel have sizing tools to determine engineering 
specifications for individual OA systems, and you should determine your free disk 
space, memory, and configuration specifications in collaboration with Avaya 
personnel. See Server machine hardware sizing on page 34 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites for more information.
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Verify that the database has been installed. For more information, refer to:
● Avaya Interaction Center Release 7.0 Installation Planning and Prerequisites
● Installing the historical database software on page 57 in Avaya Operational 

Analyst Release 7.0 Installation Planning and Prerequisites

! Important:! Important:
Important: The database operations used with Avaya OA require the services 

of either a qualified database administrator or a systems integrator 
who possesses an in-depth knowledge of database fundamentals 
on the installed operating system. It should not be done by 
personnel that are not familiar with the database software.

Verify that a user ID exists on the database that has read permission on the 
database. If one does not exist, create one.

Verify the connection between the database client and the database server. Refer 
to the database documentation for details.

If you are collecting data from Avaya IC, verify that Avaya IC has been installed and 
configured. Refer to Avaya Interaction Center Release 7.0 Installation and 
Configuration for more information.

Verify that each PC that is using the Report client or Administration client meets the 
minimum standards. See Client PC minimum hardware requirements on page 33 
and Client software requirements on page 37 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites for details.

Do not define a User Classpath other than what is created under normal software 
package installations.

On Windows servers, set the Maximum Log Size of the Application Event Log to at 
least 2 MB, and consider setting the logs to automatically roll over. See Error 
messages on page 99 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more information.

If your configuration is using a coresident Web server on Windows, collect the 
security settings of your existing Web server that you recorded from Installing the 
IIS Web Server on Windows on page 110 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites. If these settings have not been 
collected, collect them before you install the OA Report subsystem.

On Windows servers, review your Internet Information Services (IIS) logging 
strategy to be sure you allocate enough free disk space to prevent message loss 
and/or OA performance impact. Refer to Windows Internet Information Services 
(IIS) message log on page 102 in Avaya Operational Analyst Release 7.0 
Maintenance and Troubleshooting for details.

Procedure
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On Windows servers, open Control Panel > Services to determine if Terminal 
Services is being used on your server. If Terminal Services is being used, you must 
run a special command before and after you do any OA installs, additions, repairs, 
or upgrades. These commands are documented in the install, add, repair, and 
upgrade sections of this book.

Avaya recommends that you not install OA on the root file system on Solaris and 
AIX servers. Verify that /export/home (Solaris) and /home (AIX) are not on the 
root file system disk. If they are on the root file system disk, install the software in a 
different location.

Verify that there is a minimum of 512 MB of free temporary space on the c: drive 
for Windows, in /var/tmp for Solaris, and /tmp for AIX. If this space is not 
available, the installer may not run successfully.

Verify that there is at least 2.2 GB of free space and 512 MB of RAM on the server 
where the Real-time subsystem is being installed.

Verify that time synchronization software is installed and operating correctly on all 
servers. See Appendix A: Time synchronization on page 127 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites for more information.

Critical step. Verify that the servers are networked and communicating properly 
using dedicated IP addresses (DHCP may result in a different IP address each time 
a server is rebooted, resulting in networking failures). This includes validating or 
creating appropriate domain administrative accounts for Avaya IC and OA. See 
Appendix B: Networking on page 141 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites.

Verify that the OA license keys have been obtained by sending e-mail to 
icoakeyrequest@avaya.com with the SAP order number.

Verify that the OS parameters, such as user IDs and locale settings, have been set 
as described in Creating users and setting OS parameters on page 95 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

For Windows, determine whether Active Directory Service (ADS) is being used for 
authorization. This will affect how you set up the system during installation.

If installing OA components on an Avaya IC server, stop the following before 
installing OA:
● Avaya IC ICM Service
● Avaya IC ORB Service
● IC Manager application
Restart all of these after installing OA.

If installing the OA Source-EC or Source-EC Bridge subsystems on an Avaya IC 
server, verify that there is at least 100 MB of free disk space for the installation files.

Procedure
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Before you install OA, turn off all virus scan software. 

! SECURITY ALERT:
SECURITY ALERT: Temporarily turning off your virus scan software opens a potential 

risk for a virus attack. However, this risk should be low since the 
server is probably not being used at the same time when OA is 
being installed. After you complete the installation, remember to 
turn on the virus scan software.

Before you install OA:
● Back up your database.
● Close all other applications.
● Verify that the database services are started and automatic. This allows the 

database to be configured during installation. If this is not done, the installation 
will terminate and remove installed packages.

When possible, use a 19-inch or larger monitor with a resolution of 1024x768 when 
installing OA. If you use a smaller screen resolution, you may have trouble seeing 
all of the data fields in the installation dialog boxes, and you may have to resize the 
installation dialog boxes to see all of the data fields.

Procedure
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Subsystem and client software installation 
considerations

Consider the following when installing OA subsystems and client software:

● The Historical subsystem must be installed on only one machine in the configuration. It 
can be installed on either a Windows, Solaris, or AIX machine. 

● The Real-time subsystem, basic Report subsystem, and Administration client can be 
installed on any number of machines in any combination, as needed.

● You should not install the historical database on the same machine as the real-time 
TimesTen database.

● The basic Report subsystem can only be installed on machines that also have Web 
server software installed.

● The Advanced Reporting subsystem can be installed only on a Windows machine. 

● The Source-CMS data collection subsystem must be installed on a CMS server. It can 
only be installed on a Solaris machine.

● The Source-EC (Event Collector) data collection subsystem must be installed on the 
secondary Avaya IC server. It can be installed on either a Windows, Solaris, or AIX 
machine.

● The Source-EC Bridge (Event Collector Bridge) data collection subsystem must be 
installed on an Avaya IC machine that also has Avaya Business Advocate installed. The 
Source-EC Bridge can only be installed on a Windows machine.

● The Report client software must not be installed on an Avaya OA or Avaya IC server 
machine. Running reports on a server machine can adversely affect the performance of 
the server software.

● If the Advanced Reporting subsystem and basic Report subsystem are installed on the 
same machine, the databases allowed with the basic Report subsystem determine 
which database can be chosen. For Windows, Basic Reports support Oracle and 
Microsoft SQL. If the Advanced Reporting subsystem is also installed, it can only 
choose Oracle or Microsoft SQL.
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Avaya OA installation examples
This section shows examples of the OA-related software you must install on server and 
client machines. Software specific to Avaya IC is installed during Avaya IC installation.

For the following configuration:

Install the following OA-related software:

● At IC Site #1:

- Install the Source-EC subsystem and the Real-time subsystem on the Avaya OA 
server.

- Install the Source-EC Bridge subsystem on the Avaya IC server that has Business 
Advocate.

● On the database server, the database software should already be installed by the 
customer.

● On the main Avaya OA server, install the Historical subsystem, Report subsystem, and 
Advanced Reporting subsystem.

● At IC Site #2, install the Source-EC subsystem and the Real-time subsystem on the 
Avaya OA server.

● On the PC used by the system administrator, install the Administration client software.

● On the PCs used by supervisors viewing reports, install the Report client software.
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For the following configuration:

Install the following OA-related software:

● At Avaya CMS server #1, install the Source-CMS subsystem.

● At Avaya CMS server #2, install the Source-CMS subsystem.

● On the database server, the database software should already be installed by the 
customer.

● On the Avaya OA server, install the Historical subsystem and Report subsystem.

● On the PC used by the system administrator, install the Administration client software.

● On the PCs used by supervisors viewing reports, install the Report client software.
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Installing Avaya OA components

This section describes how to install the various subsystems, client software, data 
collection, and the Data API Utility of OA. For example, you may install some subsystems 
on one server, client software on other machines, and data collection on Avaya IC and 
Avaya CMS servers.

This section includes the following topics:

● Security for Unix platforms on page 30

● Installation checklist on page 31

● Before you begin the installation on page 31

● Installing Avaya OA components on a Windows platform on page 32

● Installing Avaya OA components on a Solaris platform on page 50 

● Installing Avaya OA components on an AIX platform on page 70

● Installing Avaya OA components on a CMS server on page 92

● Installing and testing the Report client on page 102

● Completing the installation on page 107
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Security for Unix platforms
Avaya recommends that users avoid running Avaya software as the root user for security 
reasons.

Note:
Note: This does not apply to the installation software itself, which must be run as 

the root user.
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Installation checklist 
To install OA, do the procedures shown in the following order:

Before you begin the installation
Consider the following while you are doing the installation:

● Avaya recommends that you write down all user IDs and database names used during 
installation as you will need them during configuration and when you make future 
changes. After installation, most of this information can be found using the oalist 
command.

● After installing the Administration client, you may want to customize the Administration 
client installation. See Customizing the Administration client on page 118.

● The dialog boxes that are displayed during installation depend on what components are 
being installed.

Procedure

Make sure you have done all the prerequisites detailed in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites and in Preparing for 
installation on page 13.

Read the information in Before you begin the installation on page 31

Install the OA components using the procedures in the following sections:
● Installing Avaya OA components on a Windows platform on page 32
● Installing Avaya OA components on a Solaris platform on page 50
● Installing Avaya OA components on an AIX platform on page 70

Install the Source-CMS subsystem on your CMS servers using the procedure in 
Installing Avaya OA components on a CMS server on page 92.

Install the Report client files using the procedures in Installing and testing the 
Report client on page 102.

Finish up the installation using the procedures in Completing the installation on 
page 107.
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Installing Avaya OA components on a Windows 
platform

This section describes how to install the following OA components on a Windows platform:

● Historical subsystem

● Real-time subsystem

● Source-EC subsystem

● Source-EC Bridge subsystem

● Report subsystem (basic)

● Data API Utility

● Advanced Reporting subsystem

● Administration client

Note:
Note: You can run the install from files copied to the server using FTP. For 

Windows, you must copy the WinSetup.exe and setup.jar files to a 
temporary folder on a disk drive that is local to the server, not a networked 
drive.

To start the OA installation process:

1. Make sure you have completed the prerequisites detailed in Preparing for 
installation on page 13.

2. Log in as a user with administration privileges.

3. If Windows Terminal Services is installed in Application mode, open a command 
prompt window and enter:

change user /install

! CAUTION:
CAUTION: If Windows Terminal Services was installed in Administration mode, you 

cannot properly install any OA subsystem on that machine. See Operating 
systems on page 48 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites.

4. Place the OA CD-ROM in the drive.
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5. Using Windows Explorer, navigate to the CD-ROM drive and double-click the 
WinSetup.exe file.

! Important:! Important:
Important: Install Avaya OA from a CD-ROM drive that is local to the server where you 

are installing OA. Installing from a networked CD-ROM drive is not 
supported.

6. After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 51). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

7. Click Next.
The License Key dialog box is displayed.

8. Enter the license key provided for the components purchased.

9. Click Next.
The License Agreement dialog box is displayed. 

10. Select I accept the terms in the license agreement.
11. Click Next. 

The User Information dialog box is displayed.
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12. Enter the User ID, User Password, Group ID, and Domain. Use a login ID (for 
example, oauser or biadmin) and password as discussed in Creating user IDs and 
group IDs on Windows servers on page 96 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites. This assigns an owner for all OA files and 
folders. If the user ID is on a domain, enter the domain name in the Domain field. If the 
user ID is local to this server, enter the server name in the Domain field.

Note:
Note: For the Domain field, you typically would not enter the fully-qualified domain 

name. However, some customer networks may require use of a 
fully-qualified domain name. Consult with the customer network 
administrator when administering this option.

13. Click Next.
The Destination dialog box is displayed.

14. Accept the default installation directory or change the directory.

! Important:! Important:
Important: The Advanced Reporting subsystem must be installed in c:\

Program Files\Avaya. If the customer wants to have this software 
installed at a location other than the c: drive, a custom procedure must be 
done by your Avaya planning and installation support representative or by 
your Avaya Business Partner. This procedure is also documented in 
Appendix B: Changing the Cognos installation on page 341.

15. To change the location where you want the components installed:

a. Click Browse. 

b. Select the directory.

The selected directory must be a local disk and have sufficient free disk space to 
accommodate the installed components.
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16. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. The 

destination is validated to ensure that it is on a local fixed disk for 
performance reasons.

The Feature Selection dialog box is displayed. The components on this dialog box 
may vary depending on the system on which you are installing OA.

17. Select the components you want to install by clicking those components. You can 
install components individually or in any combination.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.



Installing Avaya OA components

36 Operational Analyst 7.0 Installation and Configuration

18. Click Next.
The ADS Configuration dialog box is displayed:

19. Administer the dialog as shown in the following table:

Field Description

ADS Version Enter the LDAP version being used on the authentication server. 
OA supports versions 2 and 3, with the default set to 3.

ADS Port Enter the port number used for ADS. OA defaults to 389, which is 
the default when ADS is installed.

OA Administration 
Group Distinguished 
Name (DN)

Enter the DN for the administration group. For typical example of 
ADS setup, if you use the default group named oaadmin, a 
domain named oalab, and the company name is Telco, you 
would enter:
CN=oaadmin,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oaadmin
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20. Click Next.
21. The Historical Server Configuration dialog box is displayed.

Note:
Note: The fields that appear on the Historical Server Configuration dialog box 

vary depending on your component selections made previously. For 
example, if you are installing the Advanced Reporting subsystem but not the 
Report subsystem, any one of three databases (Oracle, Microsoft SQL, and 
DB2) can be used. If you are installing the Report subsystem, only two of the 
three databases (Oracle and Microsoft SQL) can be used.

OA Report Group 
Distinguished Name 
(DN)

Enter the DN for the report group. For typical example of ADS 
setup, if you use the default group named oarpt, a domain 
named oalab, and the company name is Telco, you would enter:
CN=oarpt,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oarpt

OA Report Writer 
Group Distinguished 
Name (DN)

Enter the DN for the report writer group. For typical example of 
ADS setup, if you use the default group named oawriter, a 
domain named oalab, and the company name is Telco, you 
would enter:
CN=oawriter,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oawriter

Field Description
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22. Administer the dialog as shown in the following table:

23. Click Next.

Field Description

Historical 
Subsystem Server 
Name

Do one of the following:
● If you are installing the Historical subsystem, the name of this 

server is displayed and cannot be changed.
● If you are not installing the Historical subsystem, enter the 

fully-qualified domain name of the machine where the Historical 
subsystem is installed.

Historical 
Database Server 
Name

Do one of the following:
● If the historical database is located on the same machine where 

the Historical subsystem is being installed, enter the machine 
name.

● If the historical database is located on a different machine than 
where the Historical subsystem is being installed, enter the 
fully-qualified domain name for the machine where the historical 
database is installed.

The filegroups or tablespaces must be manually created on the 
historical database server before this installation may continue. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Please choose a 
Historical 
Database

Select the appropriate database.
If the system can identify the database type based on the 
Historical Database Server Name, it will be the only type listed.

Create Historical 
Tables for these 
Collection Sources

Select the collection sources for the historical tables.
You can collect data from Avaya IC, CMS, or both depending on 
what is allowed with your product license. If you are using a 
back-end database, you must create filegroups or tablespaces for 
Avaya IC, CMS or both prior to selecting collection sources. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Alarm Services If you want to send alarm data to the Avaya IC server, click the IC 
box under Alarm Services and enter the fully-qualified domain 
name of the server where the Source-EC (Event Collector) 
subsystem is installed in the Server Name field.
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24. If you are installing the Historical or Report subsystems, the Database Configuration 
dialog box is displayed. If you are not installing the Historical or Report subsystems, 
continue with Step 42.

! Important:! Important:
Important: If you are installing the Historical subsystem on a server that is separate 

from the historical database, you must first install the database client 
software on the server where the Historical subsystem is being installed.

25. Use the following information to complete the dialog box. Use the values from your 
database installation, which is described in Installing the historical database 
software on page 57 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites. Some of the fields may include default values.

Field Oracle Microsoft SQL

DB Administrator 
Password

Password for the sys user ID Password for the sa user ID

OA DB User ID User ID for the OA database (OA 
creates this user ID during a new 
installation)

User ID for the OA database (OA 
creates this User ID during a new 
installation)

OA DB User 
Password

User password for the OA database User password for the OA database 

OA Database 
Name

New database name that will be 
created during install (for example, 
oadb)

New database name that will be 
created during install (for example, 
oadb)
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26. Click Next.
One of the following occurs:

● For Oracle, continue with Step 27.

● For Microsoft SQL, continue with Step 30.

27. A warning dialog about the Oracle archive log may be displayed.

28. Click OK to acknowledge the warning, if displayed.

29. For Oracle, the TNSnames.ora file is scanned to see if the TNS server name is 
contained within that file. If it is, the install continues with Step 34. If it is not, the 

IC DB User ID1 User ID for the Avaya IC Repository 
database (this must be an existing 
Avaya IC user ID, for example, 
repository)

User ID for the Avaya IC Repository 
database (this must be an existing 
Avaya IC user ID, for example, 
repository)

IC DB User 
Password1

User password for the Avaya IC 
Repository user ID

User password for the Avaya IC 
Repository user ID

IC Repository 
Database1

Avaya IC Repository database 
name (for example, repository)

Avaya IC Repository database 
name (for example, repository)

DB Instance Name Avaya IC and OA database instance 
name

Avaya IC and OA database instance 
name (MSSQLSERVER if you used 
the default database instance)

TCP/IP Port 
Number

1521 (if using the default 
configuration, otherwise the port 
number specified during database 
installation)

1433 (if using the default 
configuration, otherwise the port 
number specified during database 
installation)

Oracle TNS Server 
Name

A valid TNS server name. This 
name is assigned by the database 
administrator during Oracle 
installation. The default name is 
dbservername.oadb.
You must check the 
tnsnames.ora file and use the 
exact entry found there. If an entry 
is not found, ask the DBA to create 
a tnsnames.ora entry and then 
use the exact entry found there.

N/A

SQL Server 
DataBase Name

N/A New Microsoft SQL database 
created during installation

1. This field does not display if Avaya IC is not used as a collection source. During the creation of the Repository 
Database using Oracle as your database software, you will be asked to provide a password for the Repository 
database. Use this name as your IC DB User ID along with the password you enter.

Field Oracle Microsoft SQL
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following warning message is displayed asking if you want the installation program to 
modify the TNSnames.ora file to include the TNS server name.

● If you select No, you are returned to the Database Configuration dialog box. You 
can go no further until you resolve the TNS server name issue.

● If you select Yes, the installation program attempts to edit the file. One of the 
following occurs:

- If the permissions on the TNSnames.ora file allow writing, the file is modified to 
include the administered TNS server name and the install continues.

- If the permissions on the TNSnames.ora file are read-only, the file cannot be 
modified and a message is displayed stating that the permissions on the file 
must be changed manually. Select OK to return to the Database Configuration 
dialog box. You must change permissions on the file if you want to continue with 
the install.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

30. If a Microsoft SQL database is being used and if the database is coresident with 
Historical subsystem, the SQL Database Options dialog box is displayed. Otherwise, 
continue with Step 34.

31. Select Use Existing DB if you want to use an existing database.
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32. Enter the location and size of the Microsoft SQL Server Transaction Log. You can use 
the default location and size if you want.

33. Click Next.
34. If you are installing the Historical subsystem, the OA Common TableSpaces dialog 

box is displayed.

! Important:! Important:
Important: If the database is on a back-end database server, none of the table space 

dialog boxes are displayed. Continue with Step 42.

35. Enter the correct location and size for each common filegroup or tablespace. For more 
information on how to set these values, see Filegroup and tablespace sizing on 
page 59 in Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Note:
Note: If the filegroups and tablespaces do not already exist, the Use Existing 

checkboxes will not display and the Location and Size input fields will 
include editable default values. If the filegroups and tablespaces do already 
exist, the Use Existing checkboxes will be selected. You can clear the 
checkboxes and enter a different location and size.
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36. Click Next. 
If data will be collected from CMS, the OA CMS Specific dialog box is displayed.

37. Enter the correct location and size for each filegroup or tablespace. For more 
information on how to set these values, see Filegroup and tablespace sizing on 
page 59 in Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Note:
Note: If the filegroups and tablespaces do not already exist, the Use Existing 

checkboxes will not display and the Location and Size input fields will 
include editable default values. If the filegroups and tablespaces do already 
exist, the Use Existing checkboxes will be selected. You can clear the 
checkboxes and enter a different location and size.
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38. Click Next. 
If data will be collected from Avaya IC, the OA IC Specific dialog box is displayed.

39. Enter the correct location and size for each filegroup or tablespace. For more 
information on how to set these values, see Filegroup and tablespace sizing on 
page 59 in Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Note:
Note: If the filegroups and tablespaces do not already exist, the Use Existing 

checkboxes will not display and the Location and Size input fields will 
include editable default values. If the filegroups and tablespaces do already 
exist, the Use Existing checkboxes will be selected. You can clear the 
checkboxes and enter a different location and size.

40. Click Next. 
A warning dialog about storing the storage of historical data on one disk may be 
displayed.

41. Click OK to acknowledge the warning, if displayed.
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42. If you are installing the Real-time subsystem, the Real-time Configuration dialog box 
is displayed. If you are not installing the Real-time subsystem, continue with Step 46.

43. In the Real Time DB Location field, Avaya recommends that you enter a path name 
that is on a different disk drive from where the OA software is being installed, and that 
has at least 2.2 GB of free disk space.

44. In the Real Time DB Size(M) field, the only option is 128.

45. Click Next.

! Important:! Important:
Important: If you do not have at least 2.2 GB of free disk space to install TimesTen, a 

warning message is displayed. You cannot continue until you free up at 
least 2.2 GB of disk space.

46. If you are installing the Administration client, the Administration client locale 
settings dialog box is displayed. If you are not installing the Administration client, 
continue with Step 49.

47. Select a locale setting from the drop-down list. 

48. Click Next.
49. The Installation Preview dialog box is displayed listing the components you have 

selected.

50. Scroll through the preview dialog box to verify the selected components and 
configuration data.



Installing Avaya OA components

46 Operational Analyst 7.0 Installation and Configuration

! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

51. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the installation is finished, the Install Complete dialog box is displayed.

52. Click Next.
The Restart System dialog box is displayed.

53. Select the option to restart your system now and click Next.

! Important:! Important:
Important: You must always restart a Windows server at this time for OA to operate 

properly. If you are not requested to restart the server, you must manually 
restart the server.

54. Remove the OA CD-ROM and store it in a safe location.

55. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Windows servers on page 96 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

56. Open a command prompt window.

57. If Terminal Services is enabled, enter:

change user /execute
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58. In the command prompt window, enter the following command to show what processes 
are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

59. If you get the message mom is not active, enter:

pa start all

60. Repeat Step 58 to verify that OA has started.

 .       system boot  May 20 13:10
   .       run-level 4  May 20 13:10    4       0       @
java            .       May 20 13:10   .     2664  id=admb
java            .       May 20 13:10   .     2672  id=adm0
java            .       May 20 13:10   .     2680  id=ams
java            .       May 20 13:10   .     2688  id=aut
java            .       May 20 13:10   .     2696  id=schd

.

.

.
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61. Enter:

oalist

A message similar to the following is displayed listing what components are installed 
on this server:

62. Select Start > Programs > Administrative Tools > Services. 

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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63. Validate that the following services are started and are set to start automatically. If they 
are not administered to start automatically, administer them as such.

● If the Historical subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

● If the Real-time subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- TimesTen Data Manager 5.0

● If the Report subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- Stumbras-Tomcat

● If the Source-EC (Event Collector) subsystem is installed, check for the following:

- ORBacus Naming Service

64. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.
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Installing Avaya OA components on a Solaris 
platform

This section describes how to install the following OA components on a Solaris platform:

● Historical subsystem

● Real-time subsystem

● Source-EC subsystem

● Report subsystem (basic)

● Data API Utility

Note:
Note: For information about installing the Source-CMS subsystem, see Installing 

Avaya OA components on a CMS server on page 92.

Note:
Note: The dialog boxes shown in this section are based on using the CDE 

interface. If the customer is using the OpenWin interface, the installation 
dialog boxes will appear different. Avaya recommends that you use the CDE 
interface for installation.

Note:
Note: You can run the install from files copied to the server using FTP. For Solaris, 

you must copy the SolSetup and setup.jar files to a temporary folder on 
a disk drive that is local to the server, not a networked drive. You must also 
reset the permissions on Solsetup using the chmod +x SolSetup 
command.

To start the OA installation process on Solaris platforms:

1. Make sure you have completed the prerequisites detailed in Preparing for 
installation on page 13.

2. Log in as root.

3. Place the OA CD-ROM in the drive and wait about 15 seconds.

! Important:! Important:
Important: Install Avaya OA from a CD-ROM drive that is local to the server where you 

are installing OA. Installing from a networked CD drive is not supported.

A file manager window may be displayed showing the contents of the CD-ROM. 
Minimize this window.
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Note:
Note: If the File Manager window does not open, enter the following commands to 

start the volume manager:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

4. From a terminal window, enter the following commands:

cd /cdrom/cdrom0

./SolSetup

After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 41). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

5. Click Next.
The License Key dialog box is displayed.

6. Enter the provided license key for the components purchased.

7. Click Next.
The License Agreement dialog box is displayed. 

8. Select I accept the terms in the license agreement.
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9. Click Next. 
The User Information dialog box is displayed.

10. Enter the User ID, User Password, and Group ID. Use a login ID (for example, 
oauser or biadmin) and password as discussed in Creating user IDs and group IDs 
on Solaris servers on page 99 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites. This assigns an owner for all OA files and folders. 

! Important:! Important:
Important: The group ID must be the primary group ID for the user ID.

11. Click Next.
The Destination dialog box is displayed. The Destination dialog box allows you to 
specify the destination for installation of the OA software. This defaults to the directory 
defined for the user ID.

! Important:! Important:
Important: Avaya recommends that you not install OA on the root file system on Solaris 

servers. Verify that /export/home is not on the root file system disk. If it is 
on the root file system disk, install the software in a different location.

12. Accept the default directory or change the directory, if needed.

Note:
Note: If you are using an NIS user ID not local to the server, the destination field 

displays a "/" in the field. You must change this and provide the valid path.
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13. To change the location where you want the components installed

a. Click Browse. 

b. Select the directory.

The selected directory must have sufficient free disk space to accommodate the 
installed components. It should be on a local disk, not a remote file system. You 
cannot install OA software in any system directories such as the following:

● / (the root directory)

● /etc

● /var

● /tmp

● /usr/lib

● /opt/BI

14. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

The Feature Selection dialog box is displayed.
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15. Select the components you want to install by clicking those components. You can 
install components individually or in any combination.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.

16. Click Next.
One of the following occurs:

● If you are not installing the Historical subsystem or Report subsystem, continue with 
Step 19.

● If you are installing the Historical subsystem or the Report subsystem, the Reports 
Configuration dialog box is displayed.

Note:
Note: The Reports Group ID option and Report Writer Group ID option are 

displayed only when installing the Historical subsystem. The other options 
are displayed only when installing the Report subsystem.
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17. Enter the following information:

18. Click Next.

Field Description

Reports Group 
ID

oarpt 
This is the recommended ID and must match the group ID administered 
in Creating user IDs and group IDs on Solaris servers on page 99 in 
Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Report Writer 
Group ID

oawriter
This is the recommended ID and must match the group ID administered 
in Creating user IDs and group IDs on Solaris servers on page 99 in 
Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Sun Web 
Server Install 
Location 

/usr/iplanet/servers (Sun Java System Web Server Version 6.0)
/opt/SUNWwbsvr (Sun Java System Web Server Version 6.1)
This is the default installation location and must match the installation 
location selected in Installing and configuring the Sun Web server on a 
Solaris machine on page 112 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites.

Stumbras Port 
Number 

Enter any port from 1024 through 65535; 11000 is recommended.

Fully Qualified 
Reports Server 
Name 

Enter the fully-qualified domain name of the Web server as described in 
Installing and configuring the Sun Web server on a Solaris machine on 
page 112 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites
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19. The Historical Server Configuration dialog box is displayed.

Note:
Note: The fields that appear on this dialog box vary, depending on your 

component selections made previously. 

20. Administer the dialog as shown in the following table:

Field Description

Historical 
Subsystem Server 
Name

Do one of the following:
● If you are installing the Historical subsystem, the name of this 

server is displayed and cannot be changed.
● If you are not installing the Historical subsystem, enter the 

fully-qualified domain name of the machine where the Historical 
subsystem is installed.

Historical 
Database Server 
Name

Do one of the following:
● If the historical database is located on the same machine where 

the Historical subsystem is being installed, enter the machine 
name.

● If the historical database is located on a different machine than 
where the Historical subsystem is being installed, enter the 
fully-qualified domain name for the machine where the historical 
database is installed.

The filegroups or tablespaces must be manually created on the 
historical database server before this installation may continue. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.
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21. Click Next.
22. If you are installing the Historical or Report subsystems, the Database Configuration 

dialog box is displayed.

23. Use the following information to complete the dialog box.

Please choose a 
Historical 
Database

Select the appropriate database.
If the system can identify the database type based on the 
Historical Database Server Name, it will be the only type listed.

Create Historical 
Tables for these 
Collection Sources

Select the collection sources for the historical tables.
You can collect data from Avaya IC, CMS, or both depending on 
what is allowed with your product license. If you are using a 
back-end database, you must create filegroups or tablespaces for 
Avaya IC, CMS or both prior to selecting collection sources. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Alarm Services If you want to send alarm data to the Avaya IC server, click the IC 
box under Alarm Services, and enter the fully-qualified domain 
name of the server where the Source-EC (Event Collector) 
subsystem is installed in the Server Name field.
For an OA and CMS configuration without Avaya IC, leave these 
options blank.

Field Description
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! Important:! Important:
Important: If you are installing the Historical subsystem on a server that is separate 

from the historical database, you must first install the database client 
software on the server where the Historical subsystem is being installed.

24. Click Next.
25. A warning dialog about the Oracle archive log may be displayed.

Field Value

DB Administrator Password Password for the sys user ID

OA DB User ID User ID for the OA database (OA creates this user ID 
during a new installation)

OA DB User Password User password for the OA database 

OA Database Name New database name that will be created during install 
(for example, oadb)

IC DB User ID1

1. This field does not display if Avaya IC is not used as a collection source. During the creation of the 
Repository Database using Oracle as your database software, you will be asked to provide a 
password for the Repository database. Use this name as your IC DB User ID along with the 
password you enter.

User ID for the Avaya IC Repository database (this 
must be an existing Avaya IC user ID, for example, 
repository)

IC DB User Password1 User password for the Avaya IC Repository user ID

IC Repository Database1 Avaya IC Repository database name (for example, 
repository)

DB Instance Name Avaya IC and OA database instance name

TCP/IP Port Number 1521 (if using the default configuration, otherwise the 
port number specified during database installation; see 
Installing the historical database software on page 57 
in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites)

Oracle TNS Server Name A valid TNS server name. This name is assigned by 
the database administrator during Oracle installation. 
The default name is dbservername.oadb.
You must check the tnsnames.ora file and use the 
exact entry found there. If an entry is not found, ask the 
DBA to create a tnsnames.ora entry and then use 
the exact entry found there.
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26. Click OK to acknowledge the warning, if displayed.

The TNSnames.ora file is scanned to see if the TNS server name is contained within 
that file. If it is, the install continues with Step 27. If it is not, the following warning 
message is displayed asking if you want the installation program to modify the 
TNSnames.ora file to include the TNS server name.

● If you select No, you are returned to the Database Configuration dialog box. You 
can go no further until you resolve the TNS server name issue.

● If you select Yes, the installation program attempts to edit the file. One of the 
following occurs:

- If the permissions on the TNSnames.ora file allow writing, the file is modified to 
include the administered TNS server name and the install continues.

- If the permissions on the TNSnames.ora file are read-only, the file cannot be 
modified and a message is displayed stating that the permissions on the file 
must be changed manually. Select OK to return to the Database Configuration 
dialog box. You must change permissions on the file if you want to continue with 
the install.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

27. One of the following occurs:

● If you are not installing the Historical subsystem, continue with Step 35.

● If the database is on a back-end database server, none of the dialog boxes in this 
section are displayed. Continue with Step 35.
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● The OA Common Table Spaces dialog box is displayed. 

28. Enter the correct location and size for each tablespace. For more information on how 
to set these values see Filegroup and tablespace sizing on page 59 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: If the tablespaces do not already exist, the Use Existing checkboxes will 

not display and the Location and Size input fields will include editable 
default values. If the tablespaces do already exist, the Use Existing 
checkboxes will be selected. You can clear the checkboxes and enter a 
different location and size.
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29. Click Next. 
If data will be collected from CMS, the OA CMS Specific dialog box is displayed.

30. Enter the correct location and size for each tablespace. For more information on how 
to set these values see Filegroup and tablespace sizing on page 59 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: If the tablespaces do not already exist, the Use Existing checkboxes will 

not display and the Location and Size input fields will include editable 
default values. If the tablespaces do already exist, the Use Existing 
checkboxes will be selected. You can clear the checkboxes and enter a 
different location and size.
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31. Click Next. 
If data will be collected from Avaya IC, the OA IC Specific dialog box is displayed.

32. Enter the correct location and size for each tablespace. For more information on how 
to set these values see Filegroup and tablespace sizing on page 59 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: If the tablespaces do not already exist, the Use Existing checkboxes will 

not display and the Location and Size input fields will include editable 
default values. If the tablespaces do already exist, the Use Existing 
checkboxes will be selected. You can clear the checkboxes and enter a 
different location and size.

33. Click Next. 
A warning dialog about storing historical data on one disk may be displayed.

34. Click OK to acknowledge the warning, if displayed.
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35. One of the following occurs:

● If you are not installing the Real-time subsystem, continue with Step 39.

● If you are installing the Real-time subsystem, the Real-time Configuration dialog 
box is displayed. 

36. In the Real Time DB Location field, Avaya recommends that you enter a path name 
that is on a different disk drive from where the OA software is being installed, and that 
has at least 2.2 GB of free disk space.

37. In the Real Time DB Size(M) field, the only option is 128.

38. Click Next.

! Important:! Important:
Important: If you do not have at least 2.2 GB of free disk space to install TimesTen, a 

warning message is displayed. You cannot continue until you free up at 
least 2.2 GB of disk space.

39. The Installation Preview dialog box is displayed listing the components you have 
selected.
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40. Scroll through the preview dialog box to verify the selected components and 
configuration data.

! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

41. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the installation is finished, the Install Complete dialog box is displayed.

42. Click Next.
The Install Successful dialog box is displayed.

43. Click Next.
44. Close all but one terminal window and enter:

cd /

eject cdrom

45. Remove the OA CD-ROM and store it in a safe location.

46. Log out of the desktop environment.

47. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Solaris servers on page 99 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

48. Enter:

. /opt/BI/.profile
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49. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

50. If you get the message mom is not active, enter:

pa start all

51. Repeat Step 49 to verify that OA has started.

52. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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53. Enter:

oalist

A message similar to the following is displayed:

54. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv
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b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

55. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root   233     1  0   Dec 23 ?        0:01 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend
    root   234   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 0
    root   235   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 1
    root   236   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 2
    root   237   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 3
 biadmin   244   182  0 10:34:22 pts/11   0:00 grep timesten
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56. If the Report subsystem is installed, enter the following commands to start Stumbras:

cd $SUN_WEB_HOME/https-stumbras

./start

The following message is displayed.

57. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

The OA environment will be set.
.
.
.

Startup: server started successfully

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if Stumbras-Tomcat is running:

ps -ef | grep https-stumbras

A message similar to the following should be displayed.

● For Sun Java System Web Server 6.0:

● For Sun Java System Web Server 6.1:

58. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 biadmin  6141     1  0   Dec 31 ?        0:00 ./uxwdog -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6143  6142  0   Dec 31 ?        1:01 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6142  6141  0   Dec 31 ?        0:03 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin   254   182  0 10:38:51 pts/11   0:00 grep https-stumbras

 biadmin 28604 28603  0 16:38:23 ?        1:58 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 28602     1  0 16:38:22 ?        0:00 ./webservd-wdog -r /opt/SUNWwbsvr
 -d //opt/SUNWwbsvr/https-stumbras/config -n h
 biadmin 28603 28602  0 16:38:22 ?        0:01 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 29266 29259  0 18:55:22 pts/22   0:00 grep https-stumbras

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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Installing Avaya OA components on an AIX platform
This section describes how to install the following OA components on an AIX platform:

● Historical subsystem

● Real-time subsystem

● Source-EC subsystem

● Report subsystem (basic)

● Data API Utility

Note:
Note: Depending on the size and resolution of your display terminal, you may have 

to resize some installation dialog boxes to view all option fields.

Note:
Note: You can run the install from files copied to the server using FTP. For AIX, 

you must copy the AixSetup, AixSetup.cp2, and setup.jar files to a 
temporary folder on a disk drive that is local to the server, not a networked 
drive.

To start the OA installation process on AIX platforms:

1. Make sure you have completed the prerequisites detailed in Preparing for 
installation on page 13.

2. Log in as root.

3. To set the monitor display, enter:

export DISPLAY=hostname:0.0

where hostname is the name of the server.

4. Place the OA CD-ROM in the drive and wait about 15 seconds.

! Important:! Important:
Important: Install Avaya OA from a CD-ROM drive that is local to the machine where 

you are installing OA. Installing from a networked CD drive is not supported.

5. If you are installing the Historical subsystem on the same server as the DB2 client 
software, or you are installing the Report subsystem, enter the following command to 
set the environment:

. /home/INSTANCE_ID/.profile

where INSTANCE_ID matches the ID used when the DB2 database instance was 
installed. The default instance ID is db2inst1.
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6. If you are installing the Historical subsystem, enter the following commands to set the 
DB2 environment:

export EXTSHM=ON

db2set DB2ENVLIST=EXTSHM

db2stop

db2start

7. If you are installing the Report subsystem, enter the following commands to start the 
WebSphere software:

cd $WEBSPHERE_HOME/bin

./startServer.sh server1 -username userID

where, if a Global Security user ID has been administered:

● userID is the user ID administered for Global Security on WebSphere.

8. Enter the following commands to start the installation:

export LANG=en_US

mkdir /cdrom (if this directory does not already exist)

mount -v cdrfs -r /dev/cd0 /cdrom

cd /cdrom

./AixSetup

After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 44). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

9. Click Next.
The License Key dialog box is displayed.

10. Enter the provided license key for the components purchased.

11. Click Next.
The License Agreement dialog box is displayed.

12. Select I accept the terms in the license agreement.
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13. Click Next. 
The User Information dialog box is displayed.

14. Enter the User ID, User Password, and Group ID. Use a login ID (for example, 
oauser or biadmin) and password as discussed in Creating user IDs and group IDs 
on AIX servers on page 105 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites. This assigns an owner for all OA files and folders.

! Important:! Important:
Important: The group ID must be the primary group ID for the user ID.

15. Click Next.
The Destination dialog box is displayed. The dialog box defaults to the directory 
defined for the user ID entered above.

! Important:! Important:
Important: Avaya recommends that you not install OA on the root file system on AIX 

servers. Verify that /home (AIX) is not on the root file system disk. If it is on 
the root file system disk, install the software in a different location.

16. Accept the default directory or change the directory, if needed.

Note:
Note: If you are using an NIS user ID not local to the server, the destination field 

displays a "/" in the field. You must change this and provide the valid path.
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17. To change the location where you want the components installed

a. Click Browse. 

b. Select the directory.

The selected directory must have sufficient free disk space to accommodate the 
installed components. It should be on a local disk, not a remote file system. You 
cannot install OA software in any system directories such as the following:

● / (the root directory)

● /etc

● /var

● /tmp

● /usr/lib

● /opt/BI

18. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

The Feature Selection dialog box is displayed.
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19. Select the components you want to install by clicking those components. You can 
install components individually or in any combination.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.

20. Click Next.
If you are installing the Historical subsystem or the Report subsystem, the Reports 
Configuration dialog box is displayed. If you are not installing the Historical 
subsystem or Report subsystem, continue with Step 24.

Note:
Note: The Reports Group ID option and Report Writer Group ID option are 

displayed only when installing the Historical subsystem. The other options 
are displayed only when installing the Report subsystem. The DB2 Version 
option is displayed only when installing the Reporting subsystem on a server 
separate from the Historical subsystem.
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21. Enter the following information:

Field Description

Reports Group ID oarpt
This is the recommended ID and must match the group ID 
administered in Creating user IDs and group IDs on AIX 
servers on page 105 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites.

Report Writer Group 
ID 

oawriter
This is the recommended ID and must match the group ID 
administered in Creating user IDs and group IDs on AIX 
servers on page 105 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites.

WebSphere Install 
Location 

/usr/IBM/WebSphere/AppServer
This is the default installation location and must match the 
installation location selected in Installing and configuring 
WebSphere Application Server on an AIX machine on page 114 
in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites.

IBM HTTP Server 
Install Location

/usr/IBMIHS
This is the default installation location. If the IC Web Channel and 
the OA Report subsystem will be installed on the same server 
machine, there must be two instances of the HTTP Server 
software installed on that machine. You must determine where 
the HTTP Server software was installed for Avaya IC, which is 
typically in the default location /usr/IBMIHS/bin. Once that 
location has been determined, you must select a different 
location where the HTTP Server software will be installed for OA, 
for example, /usr/OA_IBMHttpServer/bin. See Installing 
and configuring WebSphere Application Server on an AIX 
machine on page 114 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites for more information.

WebSphere 
Application Server 
Name

server1
This is the default server name for WebSphere and must match 
the name used during installation in Installing and configuring 
WebSphere Application Server on an AIX machine on page 114 
in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites.

OA Profile Name default
This is set during WAS installation. See Installing and configuring 
WebSphere Application Server on an AIX machine on page 114 
in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites for more information.
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22. Click Next.
A warning message is displayed if you did not enter WebSphere Admin Console login 
ID and password. Confirm that, if the login ID was assigned for Global Security during 
WebSphere installation, you have entered the login ID and password. See Creating a 
secure login by enabling Global Security (optional) on page 124 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites for more information. If a 
login ID for global security was not assigned, these fields can be empty.

23. Select OK to confirm the warning message, if displayed.

OA Node Name hostnameNode01
This is set during WAS installation. See Installing and configuring 
WebSphere Application Server on an AIX machine on page 114 
in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites for more information.

OA Cell Name hostnameNode01Cell
This is set during WAS installation. See Installing and configuring 
WebSphere Application Server on an AIX machine on page 114 
in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites for more information.

WebSphere Admin 
Console Login ID

If you configured WebSphere for Global Security (see Creating a 
secure login by enabling Global Security (optional) on page 124 
in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites), enter the login ID in this field. Otherwise, 
leave this field blank.

WebSphere Admin 
Console Password

Enter and confirm the Administrative Console password, if 
assigned. Otherwise, leave this field blank.

DB2 Version Although the only option in this field is 8, OA 7.0 supports DB2 
V8.1 and V8.2. 

Field Description
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24. The Historical Server Configuration dialog box is displayed.

Note:
Note: The fields that appear on this dialog box vary, depending on the component 

selections made previously. 

25. Administer the dialog as shown in the following table:

Field Description

Historical 
Subsystem Server 
Name

Do one of the following:
● If you are installing the Historical subsystem, the name of this 

server is displayed and cannot be changed.
● If you are not installing the Historical subsystem, enter the 

fully-qualified domain name of the machine where the Historical 
subsystem is installed.

Historical 
Database Server 
Name

Do one of the following:
● If the historical database is located on the same machine where 

the Historical subsystem is being installed, enter the machine 
name.

● If the historical database is located on a different machine than 
where the Historical subsystem is being installed, enter the 
fully-qualified domain name for the machine where the historical 
database is installed.

The filegroups or tablespaces must be manually created on the 
historical database server before this installation may continue. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Please choose a 
Historical 
Database

Select the appropriate database: DB2 is the only possible selection.
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26. Click Next.
27. If you are installing the Historical or Report subsystems, the Database Configuration 

dialog box is displayed. 

! Important:! Important:
Important: If you are installing the Historical subsystem on a server that is separate 

from the historical database, you must first install the database client 
software on the server where the Historical subsystem is being installed.

28. Use the following information to complete the dialog box. Use the values from your 
database installation, which is described in Installing the historical database 

Create Historical 
Tables for these 
Collection Sources

Select the collection sources for the historical tables.
You can collect data from Avaya IC, CMS, or both depending on 
what is allowed with your product license. If you are using a 
back-end database, you must create filegroups or tablespaces for 
Avaya IC, CMS or both prior to selecting collection sources. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Alarm Services If you want to send alarm data to the Avaya IC server, click the IC 
box under Alarm Services, and enter the fully-qualified domain 
name of the server where the Source-EC (Event Collector) 
subsystem is installed in the Server Name field.

Field Description
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software on page 57 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites. Some of the fields may include default values.

Field Value

OA DB User ID User ID for the OA database (OA creates this user ID 
during a new installation)

OA DB User Password User password for the OA database 

OA Database Name The database name given when DB2 was installed and 
an instance was created. 

IC DB User ID1

1. This field does not display if Avaya IC is not used as a collection source.

User ID for the Avaya IC Repository database (this 
must be an existing Avaya IC user ID, for example, 
db2inst1)

IC DB User Password1 User password for the Avaya IC Repository user ID

IC Repository Database1 Avaya IC Repository database/schema name (for 
example, repository)

DB Instance Name Avaya IC and OA database instance name (for 
example, db2instl, which is the default).

TCP/IP Port Number Port number assigned to the database instance 
creation during the DB2 installation. If you are not sure 
of the number, check /etc/services and look for 
the DB2 instance name. The port number is included.

OA Database Schema Name OA database schema name (for example, oaschema). 
Avaya recommends that you do not change this default 
name.
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29. Click Next.
The DB2 Options dialog box is displayed.

30. Use the following information to complete the dialog box. 

31. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

32. The OA Common Table Spaces dialog box is displayed.

Field Value

Use Existing DB Determines whether you are using an 
existing DB2 database.

Temp Tablespace Location The file location for the temporary tables.

Syscat Tablespace location The file location for the system catalog.

Please choose a DB2 Territory Select the proper territory for your locale.
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! Important:! Important:
Important: If the database is on a back-end database server, none of the table space 

dialog boxes are displayed. Continue with Step 40.
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33. Enter the correct location and size for each tablespace. For more information on how 
to set these values see Filegroup and tablespace sizing on page 59 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: If the tablespaces do not already exist, the Use Existing checkboxes will 

not display and the Location and Size input fields will include editable 
default values. If the tablespaces do already exist, the Use Existing 
checkboxes will be selected. You can clear the checkboxes and enter a 
different location and size.

34. Click Next. 
If data will be collected from CMS, the OA CMS Specific dialog box is displayed.

35. Enter the correct location and size for each tablespace. For more information on how 
to set these values see Filegroup and tablespace sizing on page 59 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: If the tablespaces do not already exist, the Use Existing checkboxes will 

not display and the Location and Size input fields will include editable 
default values. If the tablespaces do already exist, the Use Existing 
checkboxes will be selected. You can clear the checkboxes and enter a 
different location and size.
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36. Click Next. 
If data will be collected from Avaya IC, the OA IC Specific dialog box is displayed.

37. Enter the correct location and size for each tablespace. For more information on how 
to set these values see Filegroup and tablespace sizing on page 59 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: If the tablespaces do not already exist, the Use Existing checkboxes will 

not display and the Location and Size input fields will include editable 
default values. If the tablespaces do already exist, the Use Existing 
checkboxes will be selected. You can clear the checkboxes and enter a 
different location and size.

38. Click Next. 
A warning dialog about storing the historical database on one disk may be displayed.

39. Click OK to acknowledge the warning, if displayed.
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40. One of the following occurs:

● If you are not installing the Real-time subsystem, continue with Step 44.

● If you are installing the Real-time subsystem, the Real-time Configuration dialog 
box is displayed.

41. In the Real Time DB Location field, Avaya recommends that you enter a path name 
that is on a different disk drive from where the OA software is being installed, and that 
has at least 2.2 GB of free disk space.

42. In the Real Time DB Size(M) field, the only option is 128.

43. Click Next.

! Important:! Important:
Important: If you do not have at least 2.2 GB of free disk space to install TimesTen, a 

warning message is displayed. You cannot continue until you free up at 
least 2.2 GB of disk space.

44. The Installation Preview dialog box is displayed listing the components you have 
selected.

45. Scroll through the preview dialog box to verify the selected components and 
configuration data.
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! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

46. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the installation is finished, the Install Complete dialog box is displayed.

47. Click Next.
The Install Complete dialog box closes.

48. Close all but one terminal window and enter:

cd /

umount /cdrom

49. Press the eject button on the CD-ROM drive, remove the OA CD-ROM, and store it in 
a safe location.

50. Log out of the desktop environment.

51. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
AIX servers on page 105 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

52. Enter:

. /opt/BI/.profile
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53. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

54. If OA is not running (mom is not active), enter:

pa start all

55. Repeat Step 53 to verify that OA has started.

56. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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57. Enter:

oalist

A message similar to the following is displayed:

58. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv
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b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

59. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 biadmin 20858 48090   0 13:01:34  pts/0  0:00 grep timesten
    root 31910 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 2 -facility user
    root 32664 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 1 -facility user
    root 36302 36980   0   Apr 16      -  3:35 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 3 -facility user
    root 36980  6302   0   Apr 16      -  0:42 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend -fg
    root 40150 36980   0   Apr 16      -  0:18 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 0 -facility user
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60. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

61. If the Report subsystem is installed and administered, enter the following commands to 
stop and restart the WebSphere software:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT 
-u userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

62. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX
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a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if WebSphere is running:

ps -ef | grep WebSphere

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

    root 24424 25566   2 15:49:03  pts/3  0:00 grep WebSphere 
 biadmin 28514     1   0   Jun 03      -  4:39 /usr/IBM/WebSphere/AppServer/java/
bin/java -Xbootclasspath/p:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/
ibmorb.jar:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/ibmext.jar 
-Dwas.status.socket=53964 -classpath /usr/IBM/WebSphere/AppServer/profiles/
default/properties:/usr/IBM/WebSphere/AppServer/properties:/usr/IBM/WebSphere/
AppServer/lib/bootstrap.jar:/usr/IBM/WebSphere/AppServer/lib/j2ee.jar:/usr/IBM/
WebSphere/AppServer/lib/lmproxy.jar:/usr/IBM/WebSphere/AppServer/lib/
urlprotocols.jar:/usr/opt/db2_08_01/java/db2jcc.jar:/usr/opt/db2_08_01/java/
db2jcc_license_cu.jar:/usr/opt/db2_08_01/java/db2jcc_license_cisuz.jar -Xms50m 
-Xmx512m -Dws.ext.dirs=/usr/IBM/WebSphere/AppServer/java/lib:/usr/IBM/WebSphere/
AppServer/profiles/default/classes:/usr/IBM/WebSphere/AppServer/classes:/usr/
IBM/WebSphere/AppServer/lib:/usr/IBM/WebSphere/AppServer/installedChannels:/usr/
IBM/WebSphere/AppServer/lib/ext:/usr/IBM/WebSphere/AppServer/web/help:/usr/IBM/
WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.ejbdeploy/runtime 
-Dcom.ibm.itp.location=/usr/IBM/WebSphere/AppServer/bin 
-Djava.util.logging.configureByServer=true -Dibm.websphere.preload.classes=true 
-Duser.install.root=/usr/IBM/WebSphere/AppServer/profiles/default 
-Dwas.install.root=/usr/IBM/WebSphere/AppServer 
-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager 
-Ddb2j.system.home=/usr/IBM/WebSphere/AppServer/cloudscape -Dserver.root=/usr/
IBM/WebSphere/AppServer/profiles/default -Djava.awt.headless=true 
-Djava.security.auth.login.config=/usr/IBM/WebSphere/AppServer/profiles/default/
properties/wsjaas.conf -Djava.security.policy=/usr/IBM/WebSphere/AppServer/
profiles/default/properties/server.policy com.ibm.ws.bootstrap.WSLauncher 
com.ibm.ws.runtime.WsServer /usr/IBM/WebSphere/AppServer/profiles/default/config 
groverNode01Cell groverNode01 server1 
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63. To verify that OA reports are running using the WebSphere Administrative Console:

a. In a browser window, enter:

http://report_server_FQDN:port_number/admin

where report_server_FQDN is the fully-qualified domain name of the server 
where the Report subsystem is installed and port_number is the port number 
assigned to the WebSphere Administrative Console (for example, 9060).

b. Log in to the WebSphere Administrative Console using the Global Security user ID 
and password (if assigned). Otherwise, enter any user ID.

c. Select Applications > Enterprise Applications.

d. Verify that there is a green arrow next to OAReports. If there is a red X, select the 
check box to the left of OAReports and select Start. This should change the status 
to a green arrow. If not, escalate the problem using the normal channels.

Note:
Note: If the WebSphere server instance for OA reports is not the default server1, 

the WebSphere Administrative Console must be deployed to the non-default 
server instance. Otherwise, the WebSphere Administrative Console cannot 
control OA reports.
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Installing Avaya OA components on a CMS server
This section describes how to install the following OA components on a CMS server:

● Source-CMS subsystem

● Data API Utility

If you want to collect CMS historical data, you must install the Source-CMS subsystem on 
each of the CMS servers from which you are collecting data. 

Note:
Note: The dialog boxes shown in this section are based on using the CDE 

interface. If the customer is using the OpenWin interface, the installation 
dialog boxes will appear different. Avaya recommends that you use the CDE 
interface for installation.

Note:
Note: You can run the install from files copied to the server using binary copy 

mode of FTP. For Solaris, you must copy the SolSetup and setup.jar 
files to a temporary directory on a disk drive that is local to the server, not a 
networked drive. See Remote installation of CMS data collection 
software on page 355 for instructions.

This section includes the following topics:

● Installing the OA components on page 92

● Stopping and starting IDS on the CMS server (R3V9 only) on page 97

● Configuring time zone offsets on page 98

Installing the OA components
To install the OA components on a CMS server:

1. Log in as root to the CDE on the local CMS machine.

2. Place the OA CD-ROM in the drive and wait about 15 seconds.

! Important:! Important:
Important: Install Avaya OA from a CD-ROM drive that is local to the server where you 

are installing OA. Installing from a networked CD-ROM drive is not 
supported.

A file manager window is displayed showing the contents of the CD-ROM.
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Note:
Note: If the File Manager window does not open, enter the following commands to 

start the volume manager:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

3. From a terminal window, enter the following commands:

cd /cdrom/cdrom0

./SolSetup

After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 22). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

4. Click Next.
The License Key dialog box is displayed.

5. Enter the provided license key for the components purchased.

6. Click Next.
The License Agreement dialog box is displayed. 

7. Select I accept the terms in the license agreement.
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8. Click Next. 
The User Information dialog box is displayed.

9. Enter the User ID, User Password, and Group ID.

Use a login ID and password (typically biadmin) as discussed in Creating user IDs 
and group IDs on Solaris servers on page 99 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites. This assigns an owner for all OA 
files and folders.

10. Click Next.
The Destination dialog box is displayed.

The Destination dialog box allows you to specify the destination for installation of the 
OA software. This defaults to the directory defined for the user ID. On a CMS server, 
you may want to install the Source-CMS subsystem on the /cms file system instead of 
the root (/) file system, which is the default location. Consult the CMS administrator 
when selecting a destination.

11. To change the location where you want the components installed

a. Click Browse. 

b. Select the directory.

The selected directory must have sufficient free disk space to accommodate the 
installed components. It should be on a local disk, not a remote file system. You 
cannot install OA software in any system directories such as the following:

● / (the root directory)

● /etc

● /var
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● /tmp

● /usr/lib

● /opt/BI

12. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

The Feature Selection dialog box is displayed.

13. Select Source-CMS Subsystem and, if needed, Data API Utility.

14. Click Next.
The Historical Server Configuration dialog box is displayed.

15. Enter the Historical Subsystem Server Name using the fully-qualified domain name 
of the server where the Historical subsystem is located.

16. If you want to send alarm data to the Avaya IC server, click the IC box under Alarm 
Services, and enter the fully-qualified domain name of the server where the 
Source-EC (Event Collector) subsystem is installed in the Server Name field. For an 
OA and CMS configuration without Avaya IC, leave these options blank.
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17. Click Next.
The CMS Database Configuration dialog box is displayed.

18. Enter the informix user ID and password as administered on the CMS server.

Tip:
Tip: If a password has not been assigned, use the passwd informix 

command to assign a password before you continue.

19. Click Next.
20. The Installation Preview dialog box is displayed listing the components you have 

selected.

21. Scroll through the preview dialog box to verify the components you selected. 

! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

22. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the installation is finished, the Install Complete dialog box is displayed.

23. Click Next.
The Install Complete dialog box closes.
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24. Close all but one terminal window and enter:

cd /

eject cdrom

25. Remove the OA CD-ROM and store it in a safe location.

26. Use the following command and response to verify that the required service is running. 
If the service is not running, escalate the problem using the normal channels.

ps -ef | grep nameserv

A message similar to the following should be displayed.

Stopping and starting IDS on the CMS server (R3V9 only)
For CMS servers with R3V9 software, you must stop and start the Informix Dynamic 
Server (IDS) software after you have installed the data collection software. This is not 
required if the CMS server is R3V11 or later.

To stop and start the IDS software:

1. Log in as root.

2. Enter:

. /opt/BI/.profile

pa stop all

3. Enter:

cmssvc

The system displays the CMSSVC menu.

4. Enter 4 to select run_cms.

5. Enter 3 to turn off both CMS and IDS.

6. Enter:

cmssvc

7. Enter 3 to select run_ids.

8. Enter 1 to turn on IDS.

9. Enter:

cmssvc

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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10. Enter 4 to select run_cms.

11. Enter 1 to turn on CMS.

12. Enter:

pa start all

Configuring time zone offsets
Avaya OA uses data collected from a CMS server to create reports about contact center 
performance. To correlate data from multiple ACDs (switches), the time zone configuration 
on the CMS server must be configured properly to use Greenwich Mean Time (GMT) 
offsets and recognize Daylight Savings Time (DST) rules. In addition, the forwarder files on 
the CMS server may need to be configured for non-standard DST rules. Adjusting the ACD 
time zone offset does not affect the time as stored in OA. It will always be the time zone of 
the switch as adjusted for GMT.

This section includes the following topics:

● Basic CMS time zone settings on page 98

● Forwarder file time zone settings on page 99

Basic CMS time zone settings

Standard provisioning for a CMS server configures time zones based on geographic 
region, which automatically compensates for DST rules and converts the internal time of 
the CMS to GMT. You should verify that the time zone is set correctly on the CMS server.

To verify that the CMS server time zone is set properly:

1. Log in to the CMS server as root.

2. Enter:

vi /etc/default/init

A file similar to the following is displayed.

# @(#)init.dfl 1.5 99/05/26
#
# This file is /etc/default/init.  /etc/TIMEZONE is a symlink to this file.
# This file looks like a shell script, but it is not.  To maintain
# compatibility with old versions of /etc/TIMEZONE, some shell constructs
# (i.e., export commands) are allowed in this file, but are ignored.
#
# Lines of this file should be of the form VAR=value, where VAR is one of
# TZ, LANG, CMASK, or any of the LC_* environment variables.
#
TZ=US/Mountain
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3. Verify that the time zone has been set using a geographic region, similar to what is 
shown in the above example. If the time zone has not been set using a geographic 
region, change the line with geographic regions as shown in the /usr/share/lib/
zoneinfo directories (for example, /usr/share/lib/zoneinfo/US, where you 
would use the Mountain time zone file).

4. Press Esc.

5. Enter:

:wq!

This writes and quits the file editor.

6. Enter:

/usr/sbin/shutdown -y -i6 -g0

This reboots the CMS server.

The CMS must then be administered to change the switch time zone offset for all ACDs 
reporting to the CMS server. To administer this option, see the section Changing switch 
time zone in the chapter "Configuring CMS system settings" in the CMS Administration 
document for your CMS release.

! Important:! Important:
Important: The administration of switch time zone offsets do not automatically adjust for 

DST. When DST changes occur, the CMS administrator must readminister 
the offset value.

Forwarder file time zone settings

By default, the CMS server is configured to use the standard North American DST rules 
that apply to the United States and Canada. If all ACDs are located where standard North 
American DST rules are observed, no changes are required to the configuration.

However, for any ACDs that are located where standard North American DST rules are not 
observed, you must configure those ACDs on the CMS server.

For example, a customer has a CMS server in Chicago (which does observe standard 
North American DST rules) and ACD number 3 is located in Phoenix (which does not 
observe standard North American DST rules). The CMS has been administered with an 
offset of -1 hours for the Phoenix ACD. Since Arizona does not observe DST, the ACD is -1 
hour behind Chicago during Standard Time and -2 hours behind Chicago during DST.

CMS administrators must remember to manually change the offset for this ACD when 
going from DST to Standard Time and from Standard Time to DST (the administered offset 
of -1 hour is valid as long as it was administered for Standard Time, and not -2 hours 
because the CMS server was administered when DST was in effect).

For call data that is forwarded from CMS to OA, the CMS server must be configured to 
automatically reset the time zone offsets for any ACDs in locations that do not observe 
standard North American DST rules. You must edit the following property files, which are 
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located at $PABASE/data/admin/forwarder on the CMS server, and add two time 
zone run-time property settings:

● cmsagent.properties

● cmscallhistory.properties

● cmscwc.properties

● cmsskill.properties

● cmssynonyms.properties

● cmsvdn.properties

First, you must add the following line to the end of each of these files to define the local 
offset from GMT:

acdNtz=XX 

where N is the number of the ACD and XX is the offset values, which range from -12 (New 
Zealand) west to 11 (Bering).

! Important:! Important:
Important: The time zone offset from GMT used with forwarder files is a nonstandard 

numbering format. Do not confuse these settings with standard GMT offsets.

Based on the example above for the Phoenix ACD, you would add the following line at the 
end of each property file on the CMS server:

acd3tz=7

where 7 is the number of hours difference between GMT and Phoenix time.

In addition, you must set a second run-time property that further defines the DST rules for 
an ACD. This second run-time property uses the following formats:

where N is the number of the ACD and the values are defined as:

● NoAm - the North American DST rules (default)

● NoDST - DST is never observed (no is also valid) 

● WeEu - much of Western Europe, except the United Kingdom 

● OfficialEU - official European Union DST rules 

acdNdst=NoAm 
acdNdst=NoDST 
acdNdst=WeEu 
acdNdst=OfficialEU 
acdNdst=mon,week,day,min,mon,week,day,min
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● mon,week,day,min,mon,week,day,min - an explicit beginning and ending time for 
DST, where:

- the first four values represent the beginning of the alternate DST observance and 
the last four values represent the end of the alternate DST observance

- mon = 0 to 11 (0 = January, 1 = February, and so on)

- week = 0 to 4 (0 = first week, 1 = second week, and so on) or -1 (no specific week)

- day = 0 to 6 (0 = Sunday, 1 = Monday, and so on) or 0 to 31 (if week = -1)

- min = 0 to 1439 minutes after midnight (usually 2AM, which = 120)

The example acdNdst=3,4,0,120,9,4,0,120 represents DST from 2AM on the 
last Sunday in April through 2AM on the last Sunday in October.

Based on the example above for the Phoenix ACD, you would add the following line at the 
end of each property file on the CMS server:

acd3dst=NoDST
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Installing and testing the Report client
All workstations at which reports will be viewed must have JRE and the Report client 
support files installed. After the files are installed, you can run a test report to verify that the 
reports are working.

! Important:! Important:
Important: The Report client can only be installed on a Windows client workstation. You 

cannot install the Report client on a Windows 2000 or Windows 2003 server 
machine.

This section includes the following topics:

● Installing the Report client support files on page 102

● Running a test report on page 105

Installing the Report client support files
To install JRE and the Report client:

1. Log in to a Windows client workstation with a user ID that has administrator privileges.

2. Open Internet Explorer.

3. Do one of the following:

● If the Report subsystem is installed on a Windows platform, enter:

http://report_server_FQDN/reports1

where report_server_FQDN is the fully-qualified domain name of the Report 
server.

● If the Report subsystem is installed on a Solaris platform, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the Report 
server and port_number is the number assigned when the Report subsystem was 
installed (typically, 11000).
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● If the Report subsystem is installed on an AIX platform, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the Report 
server and port_number is the number assigned when the HTTP Server was 
installed (typically 80 for the default HTTP Server port; the alternative port number is 
typically 81). See Changing the HTTP Server properties (optional) on page 123 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites.

A login screen is displayed.

4. Log in with the appropriate user ID and password of a user who belongs to the OA 
Report group (see Creating user IDs and group IDs on Windows servers on page 96 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites).

5. Click Basic Reports to expand the report tree, as shown below.
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6. Click Install Reporting Support Files.

Installation instructions are displayed in the right pane as shown below.

7. Follow the instructions displayed to:

a. Check your Control Panel settings to see which version of JRE is currently installed 
on your computer.

! CAUTION:
CAUTION: If JRE version 1.4.2_08 is already installed (for example, you have already 

installed the Administration client on this computer), DO NOT REINSTALL 
JRE. If you reinstall JRE and the Administration client is installed on this 
computer, the Administration client policy information is deleted.

! CAUTION:
CAUTION: Installing the JRE could adversely affect any applications currently using a 

different version of JRE. You may have to reinstall those applications that 
use a different version of JRE.

b. Install JRE version 1.4.2_08 (if not already installed) using the link in the instructions 
that are displayed.
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c. Install the Report Client support files using the link in the instructions that are 
displayed.

When the installation is finished, the message Please close your browser when 
installation is complete is displayed.

8. Click Close to close the browser window and end the installation.

9. Continue with Running a test report on page 105.

Note:
Note: If you have any problems installing the Report client files, see 

Troubleshooting an installation on page 309 for help.

Running a test report
If you have problems running a test report, see Troubleshooting Basic Reports and the 
report server on page 175 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting.

To run a test report:

1. Log in to the client workstation with a user ID that has reporting privileges.

2. Open Internet Explorer.

3. Do one of the following:

● If the Report subsystem is installed on a Windows platform, enter:

http://report_server_FQDN/reports1

where report_server_FQDN is the fully-qualified domain name of the server 
where the Report subsystem is installed.

● If the Report subsystem is installed on a Solaris platform, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the Report 
server and port_number is the number assigned when the Report subsystem was 
installed (typically, 11000).

● If the Report subsystem is installed on an AIX platform, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the Report 
server and port_number is the number assigned when the HTTP Server was 
installed (typically 80 for the default HTTP Server port; the alternative port number is 
typically 81). See Changing the HTTP Server properties (optional) on page 123 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites.

A login screen is displayed.
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4. Log in with the appropriate user ID and password of a user who belongs to the OA 
Report group (see Creating user IDs and group IDs on Windows servers on page 96 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites).

5. Click Basic Reports to expand the report tree, as shown below.

6. Expand the report folders in the left pane and run a test report.
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Completing the installation
This section includes the following topics:

● Setting up remote access on page 107

● Configuring the NumDSWorkerThreads parameter on the Report servers on page 107

● Configuring the SMPOptLevel parameter on the TimesTen server on page 109

● Configuring Cognos for multibyte language support on page 110

● Configuring IIS on Windows for coresident Avaya IC and Avaya OA on page 111

● Adding external jobs on page 116

Setting up remote access
For server machines that require remote troubleshooting by Avaya, at least one Avaya 
machine in the customer network must be equipped for remote access. The details of what 
this includes depends on the agreement with the customer. Contact Avaya for more 
information.

Configuring the NumDSWorkerThreads parameter on the 
Report servers

The NumDSWorkerThreads parameter must be configured for every server where the 
Report subsystem is installed. This parameter affects the performance of the system.

To set the NumDSWorkerThreads parameter:

1. Open a command prompt window.

2. Open the following file in a text editor:

● %PABASE%\Stumbras\webapp\WEB-INF\config\RTPAService\
RTPAService.properties (Windows)

● $SUN_WEB_HOME/https-stumbras/webapp/WEB-INF/config/
RTPAService/RTPAService.properties (Solaris Sun Java Web Server 6.0)

● $SUN_WEB_HOME/https-stumbras/webapps/WEB-INF/config/
RTPAService/RTPAService.properties (Solaris Sun Java Web Server 6.1)

● $WEBSPHERE_HOME/profiles/default/installedApps/
hostnameNode01Cell/OAReports.ear/stumbras.war/WEB-INF/config/
RTPAService/RTPAService.properties (AIX)
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3. Search for the NumDSWorkerThreads parameter. See the following file for an 
example:

4. Change the value to equal the number of CPUs on the server. For example, if the 
Report server has 4 CPUs, enter 4.

5. Save and close the file.

6. Restart Stumbras on each Report server.

● For Windows:

i. Select Start > Programs > Administrative Tools > Services.

The Services dialog box is displayed.

ii. Highlight the Stumbras service and restart it.

● For Solaris:

i. Open a command prompt window.

ii. Enter the following commands:

cd $SUN_WEB_HOME/https-stumbras

./stop

./start

● For AIX:

i. Open a command prompt window.

ii. Enter the following commands:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT 
-u userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 

#-------------------------------------------------------------------------
#-  RTPAService.properties
#-
#-  This is a configuration file that contains properties that are independent
#-  of the OA Admin Mgr provided properties.
#-
#-  The content of RTPAService.properties will not require any localization.
#-------------------------------------------------------------------------

# Number of DataSet event processing worker threads.  Should be set to the
# number of CPUs on the reporting server host platform.
#
NumDSWorkerThreads = 1
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installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

Configuring the SMPOptLevel parameter on the TimesTen 
server

The SMPOptLevel (SMP Optimization Level) parameter for TimesTen should be set on the 
server where the Real-time subsystem is installed. The procedure for setting this 
parameter differs for Windows and Solaris and AIX.

Windows setup - To set the SMPOptLevel parameter:

1. Select Start > Settings > Control Panel.
The Control Panel dialog box is displayed.

2. Select Administrative Tools.

The Administrative Tools dialog box is displayed.

3. Select Data Services (ODBC).
The ODBC Data Source Administrator dialog box is displayed.

4. Under the System DSN tab, select dss128.

5. Click Configure.

6. Select the First Connection tab.

7. Under the SMP Optimization Level, enter 0 if the server has one CPU, or enter 1 if 
the server has two or more CPUs.

8. Click OK three times so save the setting.

Solaris and AIX setup - To set the SMPOptLevel parameter:

1. Open a command prompt window.

2. Enter:

vi /var/TimesTen/sys.odbc.ini

3. Search for the SMPOptLevel parameter.

4. Change the value to 0 if the server has one CPU, or change it to 1 if the server has two 
or more CPUs.
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5. Press Esc.

6. Enter:

:wq!

This writes and quits the file.

Configuring Cognos for multibyte language support
If you install the Advanced Reporting subsystem and the customer has installed Cognos 
Impromptu Administrator Version 6.2 multibyte English to support Japanese and other 
multibyte languages, you must rename two program folders.

Note:
Note: If you are not using Cognos Impromptu Administrator Version 6.2, you may 

skip this procedure.

The following extra folders are created:

● cubes_intl

● Impromptu_intl

These folders must be renamed so that correct programs are used by the Advanced 
Reporting subsystem.

To rename the folders:

1. Open Windows Explorer.

2. Navigate to c:\Program Files\Avaya\BI\reports\cognos.

3. Rename the folder cubes to cubes_ver7.

4. Rename the folder cubes_intl to cubes.

5. Rename the folder Impromptu to Impromptu_ver7.

6. Rename the folder Impromptu_intl to Impromptu.

Note:
Note: The detail Impromptu reports under the Impromptu\oadb folder, 

ContactsBy*Site.imr and ContactsBy*Media.imr are not available 
with this configuration.
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Configuring IIS on Windows for coresident Avaya IC and 
Avaya OA

For Windows, Web server software is normally installed by the customer as part of the 
prerequisite software installation described in Server software requirements on page 38 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites. However, 
there are conditions when the normal installation of the Windows Web server must be 
altered.

A coresident Web server configuration is necessary when: 

● The OA Report subsystem is located on the same server machine that contains the 
Avaya IC Web Server components, and the Avaya IC and OA systems share the same 
commercial Web Server. Refer to Report server considerations on page 29 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites for information 
about which Avaya IC Web Server components may be coresident with the OA Report 
subsystem.

! Important:! Important:
Important: Install a coresident Web server only if the Avaya IC Web Server components 

that reside inside your firewall are physically located on the same machine 
where the OA Report subsystem is located. If the Avaya IC Web Server 
components are physically located on the same machine, you must do the 
procedures in this section to install a Web server. If the Avaya IC Web 
Server components are not physically located on the same machine, 
continue with installing OA.

For the OA Report server to be coresident with the Avaya IC Web Server 
component or other applications, it must meet the maximum runtime 
requirements specified in Report server considerations on page 29 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites.

● Other applications with another type of Web container are using the default Web site on 
IIS. In this case, the default port number is already occupied by these applications. You 
must assign another port number to the OA Report subsystem by manually configuring 
a new Web site on the same Web server.

● Other applications using the default Web site on IIS cannot share the same HTTP 
security settings as the server where the OA Report subsystem is installed.

If you are already using the default Web site of IIS with other applications, you must follow 
the steps given below to prevent the deletion of the settings of your existing Web site.

! Important:! Important:
Important: Failure to create the OA Web site in the order indicated below will cause the 

OA Web server standard installation to modify the settings of any existing 
default Web site.
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The procedure is different for Windows 2000 and Windows 2003. See the following 
sections:

● Configuring IIS for Windows 2000 Server on page 112

● Configuring IIS for Windows Server 2003 on page 114

Configuring IIS for Windows 2000 Server

To configure IIS for Windows 2000:

1. Collect your original security settings as described in Installing the IIS Web Server on 
Windows on page 110 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites.

2. If not already installed, install the OA Report subsystem and any other required 
subsystems or client software. See Installing Avaya OA components on a Windows 
platform on page 32.

3. On the Windows Web server, stop Stumbras-Tomcat service (via Services as 
described in Starting and stopping OA-related processes on page 41 in Avaya 
Operational Analyst Release 7.0 Maintenance and Troubleshooting).

4. Delete the folder at:

%PABASE%\stumbras\tomcat\work\localhost_8080

5. Select Start > Programs > Administrative Tools > Internet Services Manager.
6. Expand the tree view server-name > Default Web Site and right click on the server 

name > New > Web Site. 

7. Click Next to continue.

a. Enter Stumbras for description. 

b. Enter an unused port number. For example: 81 for the TCP port. Leave IP Address 
set to All Unassigned. No Host Header is needed.

c. Enter C:\Inetpub\wwwroot for the home directory path and leave the rest of the 
default settings for the Web Site Home Directory page.

d. Select the Execute box and accept the rest of the default settings for the Web Site 
Access Permissions page.

e. Click Next. Click Finish.

8. Right click on the new Web site Stumbras > New > Virtual Directory.

9. Click Next to continue.

a. Enter jakarta for the Alias in the Virtual Directory Alias page.

b. Enter the path of the Stumbras-Tomcat install directory (for example, %PABASE%\
stumbras\tomcat\bin).
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c. Select the Execute box and accept the rest of the default settings for the Access 
Permissions page.

10. Right click on the new Web site Stumbras > Properties. 

a. Click on the ISAPI Filters tab. 

b. Click Add. 

c. In the Filter Name box enter: isapi 

d. Enter:

%PABASE%\stumbras\tomcat\bin\isapi_redirect.dll

e. Click OK. Click Apply.

f. Select the Directory Security tab.

g. Click Edit under the Anonymous access and authentication control section.

h. Verify that only the Anonymous access box is selected in the first section and the 
Integrated Windows authentication box is selected in the Authenticated access 
section.

i. Click OK.

j. Click Apply.

11. Expand Stumbras in the tree-view.

12. Right click on jakarta > Properties.

a. Click on the Directory Security tab.

b. Click Edit under the Anonymous access and Authentication control section.

c. Verify that only the Anonymous access box is selected in the first section.

d. Click Edit next to Account used for anonymous access.

e. In the Anonymous User Account window, enter the OA user ID entered during 
installation into the Username box. For example: oauser. Make sure the Allow IIS 
to control password is selected. Click OK, Apply, and OK.

13. Select Start > Programs > Administrative Tools > Services. 

14. Start the Stumbras-Tomcat service.

15. Start the browser report from http://<servername>:<port number>/reports1

where <servername> is the name of the report server and <port number> is the 
port number entered earlier in this procedure.

16. Go back into the Default Web site (server-name > Default Web Site) and reset the 
security settings as noted in Installing the IIS Web Server on Windows on page 110 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites.
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Configuring IIS for Windows Server 2003

To configure IIS for Windows 2003:

1. Collect your original security settings as described in Installing the IIS Web Server on 
Windows on page 110 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites.

2. If not already installed, install the OA Report subsystem and any other required 
subsystems or client software. See Installing Avaya OA components on a Windows 
platform on page 32.

3. On the Windows Web server, stop Stumbras-Tomcat service (via Services as 
described in Starting and stopping OA-related processes on page 41 in Avaya 
Operational Analyst Release 7.0 Maintenance and Troubleshooting).

4. Delete the folder at:

%PABASE%\stumbras\tomcat\work\localhost_8080

5. Select Start > Programs > Administrative Tools > Internet Information Services 
Manager.

6. Expand the tree view server-name > Web Sites > Default Web Site. 

7. Right click Default Web Site and expand to New > Web Site. 

8. Click Next to continue.

a. Enter Stumbras for description. 

b. Enter an unused port number. For example: 81 for the TCP port. Leave IP Address 
set to All Unassigned. No Host Header is needed.

c. Enter C:\Inetpub\wwwroot for the home directory path and leave the rest of the 
default settings for the Web Site Home Directory page.

d. Select the Execute box and accept the rest of the default settings for the Web Site 
Access Permissions page.

e. Click Next. Click Finish.

9. Right click Default Web Site and expand to New > Virtual Directory.

10. Click Next to continue.

a. Enter jakarta for the Alias in the Virtual Directory Alias page.

b. Enter the path of the Stumbras-Tomcat install directory (for example, %PABASE%\
stumbras\tomcat\bin).

c. Select the Execute box and accept the rest of the default settings for the Access 
Permissions page.

11. Right click on the new Web site Stumbras > Properties. 

a. Click on the ISAPI Filters tab. 

b. Click Add. 
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c. In the Filter Name box enter: isapi 

d. Enter:

%PABASE%\stumbras\tomcat\bin\isapi_redirect.dll

e. Click OK. Click Apply.

f. Select the Directory Security tab.

g. Click Edit under the Anonymous access and authentication control section.

h. Verify that only the Anonymous access box is selected in the first section and the 
Integrated Windows authentication box is selected in the Authenticated access 
section.

i. Click OK.

j. Click Apply.

12. Expand Stumbras in the tree-view.

13. Right click on jakarta > Properties.

a. Click on the Directory Security tab.

b. Click Edit under the Anonymous access and Authentication control section.

c. Verify that only the Anonymous access box is selected in the first section.

d. Click Edit next to Account used for anonymous access.

e. In the Anonymous User Account window, enter the OA user ID entered during 
installation into the Username box. For example: oauser. Make sure the Allow IIS 
to control password is selected. Click OK, Apply, and OK.

14. Select Start > Programs > Administrative Tools > Services. 

15. Start the Stumbras-Tomcat service.

16. Start the browser report from http://<servername>:<port number>/reports1

where <servername> is the name of the report server and <port number> is the 
port number entered earlier in this procedure.

17. Go back into the Default Web site (server-name > Default Web Site) and reset the 
security settings as noted in Installing the IIS Web Server on Windows on page 110 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites.
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Adding external jobs
External jobs are custom-designed instruction sets that specify when certain processes 
should be executed. Any *.bat, *.cmd or *.exe executable can be added to the OA 
Administration client and scheduled to run just once or periodically. Develop the batch 
script or program and test it through stand-alone use. Include any necessary parameters to 
verify that it completes without problems. Copy the script or program to %PABASE%\
add_on\external\bin (Windows) or $PABASE/add_on/external/bin (Solaris and 
AIX).

When you start the Administration Client again you will see the new job in the Scheduled 
Jobs, Job Type drop-down combo-box. You can then select the program and click on Add 
to schedule the job. The console output of the job will be sent to an automatically 
generated log file in the %PABASE%\add_on\external\bin\output (Windows) or 
$PABASE/add_on/external/bin/output (Solaris and AIX) directory and the log file 
name will have a time-stamp to indicate when it was run.

Note:
Note: If the program calls sub-scripts, these files should not be placed in the 

%PABASE%\add_on\external\bin (Windows) or $PABASE/add_on/
external/bin (Solaris and AIX) directory since they will also be visible to 
the administration client.

Refer to the Administration Client Help for more information.
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Configuring Avaya OA subsystems and event 
collectors

This section describes how to configure the various subsystems, client software, and data 
collection software of OA. The OA software is configured using the OA Administration 
client to permit data collection and reporting. Before you can configure the Event Collector 
server for Avaya IC, you must administer the Real-time subsystem and create a 
corresponding IC source subsystem in Avaya OA.

If your installation includes CMS (whether or not it includes Avaya IC) you must add CMS 
and ACD source subsystems.

This section includes the following topics:

● Administration client options on page 118

● Starting the Avaya OA Administration client on page 121

● Adding a Real-time subsystem on page 123

● Adding an Avaya IC Source subsystem on page 126

● Adding a CMS subsystem on page 128

● Adding an ACD Source subsystem on page 130

● Adding a Report subsystem on page 132

● Administering the Source-EC (Event Collector) server on page 135

● Administering the Source-EC Bridge (Event Collector Bridge) on page 143

● Completing initial administration on page 147

Refer to the Administration Client Help for more information.



Configuring Avaya OA subsystems and event collectors

118 Operational Analyst 7.0 Installation and Configuration

Administration client options
Before you configure subsystems and event collectors, you may want to set options on the 
Administration client.

This section includes the following topics:

● Customizing the Administration client on page 118

● Setting the archive time zone definition on page 120

Customizing the Administration client
The Administration client installation process creates two HTML files in the %PABASE% 
directory, AdminPol.html and AdminSig.html. To launch the Administration client, one 
of these HTML files is used. To use the Java policy file security model, use 
AdminPol.html. To use the signed jar file security model, use AdminSig.html.

Both of the HTML files include a set of applet parameters that can be customized. All of the 
applet parameters are set to a default value at the time of installation. In most cases, these 
parameters will never need to be changed. 

! CAUTION:
CAUTION: Care must be taken when changing any of these values as it can cause the 

HTML file to become corrupt and you will not be able to launch the 
Administration client. Before editing either of the files, make a backup 
version of the original files (for example, AdminPol.html.orig and 
AdminSig.html.orig).

Lines in the HTML file that specify the value of an applet parameter have the following 
format:

<PARAM NAME="name" VALUE="value">

The applet parameters that can be customized include:

Parameter name Value

SERVER_NAME Host name for historical server to which the client will 
connect. This is set to the historical server specified 
during installation.
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Changing fonts - By default the Arial Unicode MS font will be used for the FONT 
parameter. This font is capable of displaying the characters in any language. The 
associated TTF file (ARIALUNI.TTF) is installed into the %windir%\Fonts directory. 
When the administration client is uninstalled, this font will not be removed. This is done to 
prevent removing a file that existed before OA was installed.

The FONT parameter can be set to any other valid, installed font. For example, to better 
display simplified Chinese, someone might want to use the SimSun font. As long as the 
OS has that font, the FONT applet parameter can be changed to use the font. For most 
installations, the default font will be adequate and no modification of this parameter is 
needed.

LOCALE Set to the locale of the language selected during install.
zh_CN - Chinese (Simplified)
zh_TW - Chinese (Traditional)
en_US  - English (US) [default value]
fr_FR - French (Parisian)
de_DE  - German (Traditional)
hu_HU - Hungarian
it_IT - Italian
ja_JP - Japanese
ko_KR - Korean (South Korea)
pt_BR - Portuguese (Brazilian)
re_RU - Russian
es_CO - Spanish (Colombian)
th_TH - Thai

FONT Arial Unicode MS (default value)

TRACE_LEVEL Logging trace level: 10, 20 or 30.

CORBA_TRACE Turns on/off Corba trace ability (yes/no).

DAYLIGHT_APPLIES Set to yes only when custom daylight savings settings 
are needed.

DAYLIGHT_START Set to start date only when custom daylight savings 
settings are needed.

DAYLGIHT_END Set to end date only when custom daylight savings 
settings are needed.

DAYLIGHT_CLOCK_CHANGE Clock offset, only when custom daylight savings 
settings are needed.

Parameter name Value
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Administering multiple OA sites - The Administration client is installed on Windows 
machines that are typically separate from the OA servers. It is possible to use one 
Administration client to administer multiple, independent OA installations. To set this up for 
multiple OA installations, the HTML files that are used to launch it are set at installation 
with the name of the historical server to which the client should connect. If there are 
multiple OA servers that you want to access from a single Administration client install, you 
need to edit the appropriate HTML file to point the client to the historical server for each OA 
install. If signed jar files are being used, edit the %PABASE%\AdminSig.html file. If java 
policy files are being used, edit the %PABASE%\AdminPol.html file. By default java 
policy files are used. In either case, the following line in the HTML file needs to be altered: 

<PARAM NAME="SERVER_NAME" VALUE=xxxxx> 

Replace xxxxx with the fully qualified domain name for the historical server of the OA to 
be administered from this client. The next time the Administration client is launched, it will 
connect to the new historical server. This file is found on the client machine. See 
Appendix B: Networking on page 141 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites for more information.

Setting the archive time zone definition
Most time zones will have more than one time zone definition. For example, GMT+8 
has 14 different definitions, including Australia/Perth and Asia/Singapore. When an 
upgrade is done to OA 7.0, default time zones are used. By default, the Administration 
client defaults to Australia/Perth if the corresponding 6.1.3 start of day equates to midnight 
GMT+8. 

To change the archive time zone definition:

1. Open the Administration client (see Starting the Avaya OA Administration client on 
page 121 for more information).

2. Select Container Archives.

The Container Archives screen displays in the right pane.

3. Under Archive Time Zone, if the selected time zone definition does not match Local 
(Client) time zone, select the proper time zone definition. For example, if it is set to 
the default of Australia/Perth and you are in Singapore, select Asia/Singapore.

4. Click Save.
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Starting the Avaya OA Administration client
To start OA Administration client:

1. Go to the directory where you installed the Administration client.

2. Double-click on the AdminPol.html file in that directory.

The Administration Login dialog box is displayed.

3. Enter the user ID and password.

4. Click OK.

The OA Welcome dialog box is displayed for a few seconds, followed by the 
Administration Client screen.
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5. Administer the appropriate subsystems:

● Adding a Real-time subsystem on page 123

● Adding an Avaya IC Source subsystem on page 126

● Adding a CMS subsystem on page 128

● Adding an ACD Source subsystem on page 130

● Adding a Report subsystem on page 132

● Administering the Source-EC (Event Collector) server on page 135

● Administering the Source-EC Bridge (Event Collector Bridge) on page 143

Note:
Note: The Historical subsystem is added automatically when OA is installed.
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Adding a Real-time subsystem 
To add a Real-time subsystem:

1. In the OA Administration tree, select Subsystems.

The Subsystems administration screen is displayed in the right pane.

2. Click Add.

The Add Subsystem screen is displayed.

3. Select the Real-time option under Type.
The Add Subsystem screen is displayed showing the fields required to add a 
Real-time subsystem.

4. Enter the Name of the server where the Real-time subsystem is installed.
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5. Enter the Location of the server where the Real-time subsystem is installed. You can 
enter the Internet domain name (the fully-qualified domain name) or the IP address 
of the server. 

Depending on what you enter, one of the following occurs:

● If you enter a domain name and the IP address is found using DNS or entries in a 
hosts file, you may proceed to the next step.

● If you enter a domain name and the IP address cannot be determined using DNS or 
entries in a hosts file, you may not proceed to the next step until you have fixed the 
DNS administration or have updated the hosts file.

● If you enter an IP address and its associated domain name is found, you may 
proceed to the next step.

● If you enter an IP address and its associated domain name cannot be determined 
using DNS or entries in a hosts file, the following message is displayed:

The Internet domain name associated with the IP address could not be found. 
Do you wish to continue using the specified IP address?
You can proceed to the next step, but you should fix the DNS administration or 
update the hosts file.
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6. Click OK.

The new subsystem is added to the table in the Subsystems screen, as shown below.

7. Click Save.

The request is submitted to the server where the Historical subsystem is installed.
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Adding an Avaya IC Source subsystem 
You add an Avaya IC Source subsystem for each Event Collector to associate it with a 
Real-time subsystem. 

To add an Avaya IC Source subsystem:

1. In the OA Administration tree, select Subsystems.

The Subsystems administration screen is displayed in the right pane.

2. Click Add.

The Add Subsystem screen is displayed.

3. Select the Source option under Type.

4. Select Avaya Interaction Center from the Source Type drop down list.

The Add Subsystem screen is displayed showing the options for an IC Source 
subsystem.
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5. Select Automatic generation to allow OA to generate a Source ID.

You will need this Source ID to configure the Event Collector server. See Administering 
the Source-EC (Event Collector) server on page 135 for more information.

6. In Name, enter a unique subsystem name.

Note:
Note: Select a name that indicates which Real-time subsystem this Avaya IC 

source subsystem is associated with. This helps reduce confusion if your 
installation contains several Real-time subsystems and several Avaya IC 
source subsystems.

7. Select the name of the Real-time subsystem to which to send the data.

8. Select the checkbox next to the appropriate Historical Store and select the 
appropriate Historical subsystem.

9. Click OK.

The new subsystem is added to the table in the Subsystems screen.

10. Click Save.

The request is submitted to the server where the Historical subsystem is installed.

11. Repeat this procedure for each Event Collector and Real-time subsystem pair.
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Adding a CMS subsystem 
To add a CMS subsystem:

1. In the OA Administration tree, select Subsystems.

The Subsystems administration screen is displayed in the right pane.

2. Click Add.

The Add Subsystem screen is displayed.

3. Select the CMS option under Type.

The Add Subsystem screen is displayed showing the options for a CMS subsystem.

4. Enter the Name of the CMS server.



Adding a CMS subsystem

Issue 2.0 July 2005 129

5. Enter the Location of the CMS server. You can enter the Internet domain name (the 
fully-qualified domain name) or the IP address of the server. 

Depending on what you enter, one of the following occurs:

● If you enter a domain name and the IP address is found using DNS or entries in a 
hosts file, you may proceed to the next step.

● If you enter a domain name and the IP address cannot be determined using DNS or 
entries in a hosts file, you may not proceed to the next step until you have fixed the 
DNS administration or have updated the hosts file.

● If you enter an IP address and its associated domain name is found, you may 
proceed to the next step.

● If you enter an IP address and its associated domain name cannot be determined 
using DNS or entries in a hosts file, the following message is displayed:

The Internet domain name associated with the IP address could not be found. 
Do you wish to continue using the specified IP address?
You can proceed to the next step, but you should fix the DNS administration or 
update the hosts file.

6. Click OK.

The new subsystem is added to the table in the Subsystems screen.

7. Click Save.

The request is submitted to the server where the Historical subsystem is installed.
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Adding an ACD Source subsystem 
To start the flow of ACD data, you must first create a CMS subsystem, then add an ACD 
Source subsystem to link them together.

1. In the OA Administration tree, select Subsystems.

The Subsystems Administration screen is displayed in the right pane.

2. Click Add.

The Add Subsystem screen is displayed.

3. Select the Source option under Type.

4. Select ACD from the Source Type drop down list.

The Add Subsystem screen is displayed showing the options for an ACD subsystem.

5. Leave the Source ID Automatic generation option selected.
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6. Enter a name for the subsystem.

7. Select the associated CMS subsystem from the CMS subsystem drop down list.

8. Enter the ACD number (1-8) for this ACD. This must correspond to an ACD number 
administered on the CMS server.

9. Select the types of data that should be kept in the Historical subsystem.

10. Enter a name for the static data collection job that will be created.

11. Click OK.

The new subsystem is added to the table in the Subsystems screen. Up to eight 
ACDs can be added for each CMS. Up to 30 CMS servers can be handled by OA, for a 
total of up to 240 ACDs.

12. Click Save.

The request is submitted to the server where the Historical subsystem is installed.
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Adding a Report subsystem 
To generate reports about the data you have collected, you must add a Report subsystem:

1. In the OA Administration tree, select Subsystems.

The Subsystems administration screen is displayed in the right pane.

2. Click Add.

The Add Subsystem screen is displayed.

3. Select the Report option under Type.

The Add Subsystem screen is displayed with the options for the Report subsystem.

4. Enter the Name of the server where the Report subsystem is installed.
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5. Enter the Location of the server where the Report subsystem is installed. You can 
enter the Internet domain name (the fully-qualified domain name) or the IP address 
of the server. 

Depending on what you enter, one of the following occurs:

● If you enter a domain name and the IP address is found using DNS or entries in a 
hosts file, you may proceed to the next step.

● If you enter a domain name and the IP address cannot be determined using DNS or 
entries in a hosts file, you may not proceed to the next step until you have fixed the 
DNS administration or have updated the hosts file.

● If you enter an IP address and its associated domain name is found, you may 
proceed to the next step.

● If you enter an IP address and its associated domain name cannot be determined 
using DNS or entries in a hosts file, the following message is displayed:

The Internet domain name associated with the IP address could not be found. 
Do you wish to continue using the specified IP address?
You can proceed to the next step, but you should fix the DNS administration or 
update the hosts file.

6. Click OK.

The new subsystem is added to the table in the Subsystems screen.

7. Click Save.

The request is submitted to the server where the Historical subsystem is installed.

8. Restart the Report subsystem on the server where the Report subsystem is installed. 
Do one of the following:

● For Windows:

i. Log in using the appropriate user ID and password (see Creating user IDs and 
group IDs on Windows servers on page 96 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites).

ii. Select Start > Programs > Administrative Tools > Services. 

iii. Stop and restart the Stumbras-Tomcat service.

● For Solaris:

i. Log in using the appropriate user ID and password (see Creating user IDs and 
group IDs on Solaris servers on page 99 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites).
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ii. Enter the following commands:

. /opt/BI/.profile

cd $SUN_WEB_HOME/https-stumbras

./stop

./start

The following message is displayed.

● For AIX:

i. Log in using the appropriate user ID and password (see Creating user IDs and 
group IDs on AIX servers on page 105 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites).

ii. Enter:

. /opt/BI/.profile

iii. Enter the following command to stop the WebSphere software:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

iv. Enter the following commands to start the WebSphere software:

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT 
-u userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

.

.

.
The server is currently on

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX
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Administering the Source-EC (Event Collector) 
server

After you have created an Avaya IC Source subsystem, you must configure the Source-EC 
(Event Collector) server. The Event Collector server collects many types of data from ADU 
servers, including agent data, queue data, service class data, and outbound job statistics. 
There is a one-to-one relationship between each Event Collector server and the 
associated OA Real-time subsystem to which it sends data. If you have more than one 
Real-time subsystem, you will need more than one Event Collector server.

Before you administer an Event Collector server, you must know the following information:

● The Real-time System ID (Source ID) of the OA Real-time subsystem that will receive 
data from the Event Collector server. 

● The host system name (or IP address) of the server where the Real-time subsystem is 
installed that will receive data from the Event Collector server. See Adding a Real-time 
subsystem on page 123.

● Which Avaya IC domains the Event Collector server will monitor for agent ADU data. 
The list of monitored domains for an Event Collector server must include all the domains 
at the site that contain agents and all the domains containing ADU servers that monitor 
agents at the site.

● Which Event Collector server (if more than one) will monitor service class detail data for 
web channels (for example, chat and e-mail).

This section includes the following topics:

● Determining Real-time System ID and Data Manager Host on page 136

● Administering the Event Collector server on page 137
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Determining Real-time System ID and Data Manager Host
The Real-time System ID and Data Manager Host values are required to administer the 
Event Collector Server. You input these values on the Event Collector tab of the Event 
Collector Server Editor window in Steps 18 and 19 of Administering the Source-EC (Event 
Collector) server on page 135. 

Follow these steps to determine the values of Real-time System ID and Data Manager 
Host from the Subsystems window of the OA Administration client:

1. On the Subsystems window, locate the Real-time subsystem that is communicating 
with this Event Collector instance. Its row displays the host name and IP address 
information in the appropriate columns of the table.

2. Select the Avaya IC data source associated with the selected Real-time subsystem.

Note:
Note: If you do not know the subsystem name of the Avaya IC data source, you 

may have to select several data sources until you locate the correct one.

3. Press Modify.

4. The Modify Subsystem dialog box is displayed.

5. Verify the Real-time subsystem field matches the Real-time subsystem you selected 
in Step 1.

6. The Real-time System ID is the value displayed in the Source ID field.
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Administering the Event Collector server
To administer the Event Collector Server:

1. In the IC Manager administration window, select the Server tab.

The Server tab displays information on each of the servers.

2. Select Server > New...
The Select or enter server type dialog box is displayed.
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3. Select EventCollector from the Server Type list and click Ok.

The Server Editor dialog box is displayed.

4. Enter the name of the Event Collector server in the Name field.

Select a meaningful name. If you will define multiple Event Collector servers, use a 
unique name for each Event Collector server.

5. Select the IP address where the Event Collector server will run from the Host 
drop-down box.

The Event Collector server should run on the same host as the agent ADU servers that 
it monitors.

6. Accept the default Port number.

7. Select the Avaya IC Domain within which this instance will run.

See Avaya Interaction Center Release 7.0 Installation Planning and Prerequisites for 
more information on determining the proper domain.

8. Accept the default directory where Avaya IC will execute. This directory will be:

● For Windows, %AVAYA_IC70_HOME%\etc

● For Solaris and AIX, $AVAYA_IC70_HOME/etc

9. Accept the path and filename in the Executable field:

● For Windows, %AVAYA_IC70_HOME%\bin\ECServer

● For Solaris and AIX, $AVAYA_IC70_HOME/bin/ECServer

10. Select Auto Start. Clear Use UTC and Security.

! Important:! Important:
Important: After configuring the Event Collector server, verify that all ADU and Directory 

servers are configured to use GMT.



Administering the Source-EC (Event Collector) server

Issue 2.0 July 2005 139

11. Select the Event Collector tab.

12. Select the site associated with this instance of Event Collector server from the Site 
drop-down list.

Note:
Note: This value must always match the site configured for the Telephony Queue 

Statistics server (or servers) from which the Event Collector server will 
collect Telephony Server Queue statistics.

13. Choose the domains that the Event Collector server will monitor by clicking on the 
ellipses (�) after the Domains to Monitor field.

The Domains to Monitor dialog box is displayed.
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14. To add a domain, select >= in the dialog.

The Domains to Monitor dialog box is displayed with a drop-down list.

15. Click the Domains drop-down list.

A list of domains is displayed.

16. Click on the domain you want to add. Repeat the same process for each domain you 
want to add.

The list of monitored domains for an Event Collector server must include all the 
domains at the site that contain agents and all the domains containing ADU servers 
that monitor agents at the site. For example, if the agents at site taos are configured to 
be in domains taos_user1 and taos_user2, and the ADU servers monitoring those 
agents are in domains taos_voice1 and taos_voice2, then the Event Collector for site 
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taos must be configured to monitor domains taos_user1, taos_user2, taos_voice1, 
and taos_voice2. The order that the domains are listed does not matter.

17. When you are done adding domains, select Ok.

The EventCollector tab is displayed.

! CAUTION:
CAUTION: If the configuration has two Event Collector servers, do not use the same 

value when administering the Real-time System ID and the Data Manager 
Host in the next two steps. If the same value is assigned, the connection to 
the servers will not stay active.

18. Enter the Real-time System ID associated with the real time system that is to receive 
data from this Event Collector server instance.

Note:
Note: Real-time System IDs are numeric values that a system administrator 

assigns and associates with an OA Real-time subsystem during OA 
subsystem administration. The Real-time System ID must match the Source 
ID configured for the OA Real-time system. Refer to Determining Real-time 
System ID and Data Manager Host on page 136 for information on obtaining 
the Source ID.

19. Enter the Data Manager Host for this Event Collector server instance. This is the 
name or IP address of the server hosting the OA Real-time subsystem that is to 
receive data from this Event Collector server instance. The OA Real-time subsystem 
can be co-located on the same machine as the Event Collector server. If this is the 
case, use the name or IP address of the system hosting both Avaya IC and the OA 
Real-time subsystem.

20. The Agent Availability Algorithm should be configured as follows:
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● Inbound Availability: If advocateflag=1 for an agent, OA should apply the agent 
load based algorithm in determining agent availability. Otherwise, OA should use 
the agent or channel-based availability algorithm as specified by the EC 
configuration. 

● Agent load based: If the summation of media.contactcount is less than load, set 
availability to available; otherwise, set availability to unavailable.

● Channel load based: If the summation of media.contactcount is less than the 
summation of media.load, set availability to available; otherwise, set availability to 
unavailable.

These configuration options indicate that if the agent is an Advocate agent, the agent 
load based algorithm is automatically used. If the agent is non-Advocate, the algorithm 
will be used based on the setting chosen during the EC configuration in IC Manager.

21. The Monitor WAA field specifies whether this EC instance will listen to service class 
details for web channels (for example, chat and e-mail). The default value is No. Only 
one EC server in an installation can monitor the WAA. Avaya recommends that the EC 
instance at the same site as the WAA should monitor the WAA.

22. Select the Debug tab.

23. Click the ellipses (�) next to Trace levels.

24. In the Trace Levels dialog box, set the fields as shown in the following table:

25. Click Ok.

For more information about the other options in the Trace Levels dialog box, see 
Avaya IC Administration Volume 1: Servers and Domains.

26. Click Ok to complete the Event Collector server administration.

For troubleshooting information see Troubleshooting data collection problems on page 122 
in Avaya Operational Analyst Release 7.0 Maintenance and Troubleshooting.

Field Recommended entry

idl Clear this option.

flush Clear this option.

usr5 Select this option. This causes the Event 
Collector server to log messages to the 
trace file. This trace file may assist in 
troubleshooting problems.
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Administering the Source-EC Bridge (Event 
Collector Bridge)

If you have installed Business Advocate, you must configure the Source-EC Bridge (Event 
Collector Bridge). The Event Collector Bridge functions as a gateway between the Event 
Collector and Avaya Business Advocate. It queries Business Advocate data and collects 
Business Advocate administration events that are published to Microsoft Message 
Queuing (MSMQ) by Business Advocate. This data is sent to the Event Collector which in 
turn forwards the data to the OA Real-time subsystem. This data supports OA real-time 
and historical reporting requirements.

Before you administer an Event Collector Bridge, you must know the system name of the 
primary Business Advocate Avaya IC subsystem. If there is only one Business Advocate 
subsystem installed, that subsystem will be the primary Business Advocate subsystem. If 
there are multiple Business Advocate subsystems installed, the first subsystem that was 
installed will be designated as the primary Business Advocate subsystem.

Note:
Note: The system name of the primary Business Advocate system is a system 

name and not an IP address. This is the name of the system as it is known 
by the MSMQ subsystem.

To administer the Event Collector Bridge:

1. In the IC Manager administration window, select the Server tab.

The Server tab displays information on each of the servers.
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2. Select Server > New...
The Select or enter server type dialog box is displayed.

3. Select ECB from the Server Type list and click Ok.

The Server Editor dialog box is displayed.

4. Enter the name of the Event Collector Bridge in the Name field.

Select a meaningful name. If you are defining multiple Event Collector Bridges, use a 
unique name for each.
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5. Select the IP address where the Event Collector Bridge will run from the Host 
drop-down box.

The Event Collector Bridge must run on the same host where Business Advocate is 
installed.

6. Accept the default Port number.

7. Select the Avaya IC Domain in which this instance will run.

This should be the same domain as the Business Advocate Resource Manager which 
is installed on the same system as the Event Collector Bridge. See Avaya Interaction 
Center Release 7.0 Installation Planning and Prerequisites for more information.

8. Accept the default directory where Avaya IC will execute. This directory will be 
%AVAYA_IC70_HOME%\etc.

9. Accept the path and filename in the Executable field, %AVAYA_IC70_HOME%\bin\
ECServer.

10. Select Auto Start. Clear Use UTC and Security.

11. Select the Event Collector Bridge tab.

12. Specify the name of the primary Business Advocate host system. This is the host 
name as known to the MSMQ subsystem for the first (or only) installed Business 
Advocate subsystem.

! Important:! Important:
Important: Do not use an IP address for the Business Advocate host name.

13. Select the Debug tab.
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14. Click the ellipses (�) next to Trace levels.

15. In the Trace Levels dialog box, set the fields as shown in the following table:

16. Click Ok.

For more information about the other options in the Trace Levels dialog box, see 
Avaya IC Administration Volume 1: Servers and Domains.

17. Click Ok to complete the Event Collector Bridge administration.

For troubleshooting information see Troubleshooting data collection problems on page 122 
in Avaya Operational Analyst Release 7.0 Maintenance and Troubleshooting.

Field Recommended entry

idl Clear this option.

flush Clear this option.

usr5 Select this option. This causes the Event 
Collector server to log messages to the 
trace file. This trace file may assist in 
troubleshooting problems.
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Completing initial administration
Tasks that are administered using the OA Administration client are not covered in this 
document. These tasks include:

● Activating the remaining subsystems and interface services

● Defining daily intervals

● Configuring data collection properties

● Setting data retention time (Max Capacity)

● Designing data containers

● Aggregating and archiving data

● Purging data

● Maintaining data consistency

● Activating appropriate CMS Aux Reason Code columns

These topics are described in the Administration Client Help for the OA Administration 
client. Your Avaya planning and installation support representative or your Avaya Business 
Partner can provide support with these database administration tasks.
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Making changes to installed Avaya OA 
components

You can change your OA installation by doing any of the following:

● Add - add subsystems or client software that were not previously installed, or that were 
once installed but were previously removed

● Repair - repair corrupted files by reinstalling subsystems or client software that were 
previously installed, thereby replacing the corrupted files

● Move - move subsystems between servers

● Remove - remove subsystems or client software that were previously installed, or 
remove the entire OA software package

This section includes the following topics:

● Preparation checklist on page 150

● Stopping or starting processes and services before making changes on page 151

● Adding Avaya OA components on page 155

● Repairing Avaya OA components on page 193

● Moving subsystems on page 221

● Changing subsystem attributes on page 232

● Removing Avaya OA components on page 243

! Important:! Important:
Important: If you are planning to upgrade your OA software to the latest version, do not 

do any additions or repairs to existing components until you have first 
upgraded your OA software. For instructions on how to upgrade to a new 
version of Avaya OA software, see Upgrading Avaya OA software on 
page 269.
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Preparation checklist
Before you make any changes to your OA installation, follow these important steps and 
recommendations.

Procedure

Have the original installation media available for use during the process.

Before performing any OA change, Avaya strongly recommends that you perform a 
backup of the database and file systems.

For a configuration that includes Avaya IC, verify that the Avaya IC components 
have been installed, configured, and are started before you add, repair, configure, 
and start the OA components. For more information about Avaya IC planning and 
installation, see:
● Avaya Interaction Center Release 7.0 Installation Planning and Prerequisites
● Avaya Interaction Center Release 7.0 Installation and Configuration

Verify that there is a minimum of 512 MB of free temporary space on the c: drive 
for Windows, in /var/tmp for Solaris, and /tmp for AIX. If this space is not 
available, the installer may not run successfully.

Verify that there is at least 2 GB of free space on the server where the Real-time 
subsystem is being added.

If installing the OA Source-EC and Source-EC Bridge subsystems on an Avaya IC 
server, verify that there is at least 100 MB of free disk space for the installation files.

Before you make changes to the OA installation, turn off all virus scan software. 

! SECURITY ALERT:
SECURITY ALERT: Temporarily turning off your virus scan software opens a potential 

risk for a virus attack. However, this risk should be low since the 
server is probably not being used at the same time when OA is 
being installed. After you complete the changes, remember to turn 
on the virus scan software.

Verify that no OA files are open.

Verify that all OA Administration client users have logged off and closed their 
browser windows before you make changes to the OA software.
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Consider the following while you are making changes to the installed components:

● Avaya recommends that you write down all user IDs and database names used when 
adding components as you will need them during configuration and when you make 
future changes. After installation, most of this information can be found using the 
oalist command.

● After adding the Administration client, you may want to customize the Administration 
client installation. See Customizing the Administration client on page 118.

● The dialog boxes that are displayed when making changes depend on what 
components are being installed.

Stopping or starting processes and services before 
making changes

Before you add, repair, move, or remove any OA components, you must stop certain 
processes on the server. This is required when you currently have the Historical 
subsystem, Real-time subsystem, Report subsystem (basic), Source-CMS data collection 
software, Source-EC (Event Collector) data collection software, or Source-EC Bridge 
(Event Collector Bridge) on the server.

Determining which components are installed on your server

Before you stop processes or traffic for data collection, use the oalist command to 
display the components currently installed on your server.



Making changes to installed Avaya OA components

152 Operational Analyst 7.0 Installation and Configuration

To use the oalist command:

1. Enter the following commands:

. /opt/BI/.profile (Solaris and AIX only)

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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Stopping processes and services on a Windows server

Based on the subsystems that are installed, use the following table to determine which 
procedures should be done to stop processes and services:

Subsystems Procedure

Historical
Real-time

1. Log in as an administrative user.
2. In a command prompt window, enter pa stop all.
3. Select Start > Programs > Administrative Tools > Services. 
4. Stop the Avaya Business Intelligence and ORBacus Naming 

services.

Report 1. Log in as an administrative user.
2. In a command prompt window, enter pa stop all.
3. Select Start > Programs > Administrative Tools > Services. 
4. Stop the Avaya Business Intelligence, ORBacus Naming, and 

Stumbras-Tomcat services.

Source-EC
Source-EC 
Bridge

1. Log in as an administrative user.
2. From IC Manager, stop the Source-EC subsystems.
3. Select Start > Programs > Administrative Tools > Services. 
4. Stop the ORBacus Naming service.

Data API 
Utility

1. Log in as an administrative user.
2. In a command prompt window, enter pa stop all.
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Stopping processes on a Solaris server

Based on the subsystems that are installed, use the following table to determine which 
procedures should be done to stop processes and services:

Stopping processes on an AIX server

Based on the subsystems that are installed, use the following table to determine which 
procedures should be done to stop processes and services:

Subsystems Procedure

Historical
Real-time
Source-CMS
Data API 
Utility

1. Log in using an OA user ID and password.
2. Enter the following commands:
. /opt/BI/.profile

pa stop all

Report 1. Log in using an OA user ID and password.
2. Enter the following commands:
. /opt/BI/.profile

pa stop all

cd $SUN_WEB_HOME/https-stumbras

./stop

Source-EC From IC Manager, stop the Source-EC subsystems.

Subsystems Procedure

Historical
Report
Real-time
Data API 
Utility

1. Log in using an OA user ID and password.
2. Enter the following commands:
. /opt/BI/.profile

pa stop all

Source-EC From IC Manager, stop the Source-EC subsystems.
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Adding Avaya OA components
You can add subsystems and client software to an existing OA installation. When adding a 
subsystem or client software, many of the installation option fields will have data already 
populated from the original installation. In most cases, that data cannot be changed.

Note:
Note: The procedure given in this section does not include adding a Source-CMS 

data collection subsystem. See Installing Avaya OA components on a CMS 
server on page 92 for more information.

This section includes the following topics:

● License key considerations on page 155

● Interactions on page 156

● Adding Avaya OA components on page 156

● Completing an addition to Avaya OA on page 177

License key considerations
When adding Avaya IC as a data source to a configuration that previously only received 
CMS data, you must upgrade to an Avaya IC and Avaya CMS Analytical license. To do 
this, you must reinstall (repair) the Historical subsystem, making sure to select Avaya IC as 
a data source. See Repairing Avaya OA components on page 193.
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Interactions
When adding components to an existing installation, there are some combinations that will 
not be allowed. This section describes those combinations and how to handle the 
interaction.

Adding Report subsystem to Advanced Reporting subsystem and DB2 database -

The Advanced Reporting subsystem can only be installed on a Windows server. If the 
Advanced Reporting subsystem is on a server that is using a DB2 database installed on a 
dedicated AIX database server, you cannot add the basic Report subsystem to the same 
server where the Advanced Reporting subsystem is located because the basic Report 
subsystem must use a database that is supported on Windows (Microsoft SQL or Oracle). 
If you must use a Windows server for the basic Report subsystem, you must first remove 
the Advanced Reporting subsystem before you add the basic Report subsystem.

Adding new data collection source - If you need to add a new data collection source, do 
a repair on the existing installation. See Repairing Avaya OA components on page 193 for 
more information.

Adding Avaya OA components

Note:
Note: The procedures for adding Avaya OA software is almost identical for all 

operating systems. For this procedure, the Windows dialog boxes are 
shown and any differences for the other operating systems are described.

To add OA components:

1. Stop all OA processes. See Stopping or starting processes and services before making 
changes on page 151.

2. Do one of the following to access and start the installation executable:
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! CAUTION:
CAUTION: Install from a CD-ROM drive that is local to the server where you are 

installing OA. Installing from a networked CD drive is not supported.

Operating 
System

Procedure

Windows 1. Log in with a user ID that has administration privileges.
2. If Windows Terminal Services is installed in Application mode, open a 

command prompt window and enter:
change user /install

! CAUTION:
CAUTION: If Windows Terminal Services was installed in Administration 

mode, you cannot properly install any OA subsystem on that 
machine. See Operating systems on page 48 in Avaya 
Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

3. Place the OA CD-ROM in the drive.
4. Using Windows Explorer, navigate to the CD-ROM drive and 

double-click the WinSetup.exe file.
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Solaris 1. Log in as root.
2. Place the OA CD-ROM in the drive and wait about 15 seconds. A file 

manager window is displayed showing the contents of the CD-ROM.

Note:
Note: If the File Manager window does not open, enter the 

following commands to start the volume manager:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

3. From a terminal window, enter the following commands:
. /opt/BI/.profile

cd /cdrom/cdrom0

./SolSetup

Operating 
System

Procedure
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After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 47). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

3. Click Next.
The License Key dialog box is displayed.

4. Enter the provided license key for the components purchased.

AIX 1. Log in as root.
2. To set the monitor display, enter:
export DISPLAY=hostname:0.0

where hostname is the name of the server.

3. If you are adding the Historical subsystem, enter the following 
commands to set the DB2 environment:
- As the instance owner, or any member of DB2 SYSADM group:
export EXTSHM=ON

db2set DB2ENVLIST=EXTSHM

db2stop

db2start

- As the user launching the OA Installation (root):
# export EXTSHM=ON

# ./AixSetup

4. Place the OA CD-ROM in the drive and wait about 15 seconds.
export LANG=en_US

. /opt/BI/.profile

mkdir /cdrom (if this directory does not already exist)

mount -v cdrfs -r /dev/cd0 /cdrom

cd /cdrom

./AixSetup

Operating 
System

Procedure
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5. Click Next.
The License Agreement dialog box is displayed.

6. Select I accept the terms in the license agreement.
7. Click Next. 

The User Information dialog box is displayed.

Note:
Note: The Domain field is only displayed for Windows systems.

8. Enter and confirm the password for the installed user ID.
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9. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

The Feature Selection dialog box is displayed.

This dialog box indicates the components that were previously installed. In this 
example, the Historical subsystem, Report subsystem, and Administration client are 
already installed.
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10. Select the components you want to add.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.

Do not select any components that are already installed. If you want to repair an 
already installed component, see the procedure Repairing Avaya OA 
components on page 193.

The following example shows the Feature Selection dialog box with the Real-time 
subsystem, Data API Utility, and Advanced Reporting subsystem selected:
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11. Click Next.
The ADS Configuration dialog box is displayed:

12. Administer the dialog as shown in the following table:

Field Description

ADS Version Enter the LDAP version being used on the authentication server. 
OA supports versions 2 and 3, with the default set to 3.

ADS Port Enter the port number used for ADS. OA defaults to 389, which is 
the default when ADS is installed.

OA Administration 
Group Distinguished 
Name (DN)

Enter the DN for the administration group. For typical example of 
ADS setup, if you use the default group named oaadmin, a 
domain named oalab, and the company name is Telco, you 
would enter:
CN=oaadmin,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oaadmin
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13. Click Next.
If you are adding the Historical subsystem or the Report subsystem, the Reports 
Configuration dialog box is displayed. If you are not adding the Historical subsystem 
or the Report subsystem, continue with Step 16.

14. For Solaris and AIX, enter the installation data for the Web server software.

See the following table for Solaris field information:

OA Report Group 
Distinguished Name 
(DN)

Enter the DN for the report group. For typical example of ADS 
setup, if you use the default group named oarpt, a domain 
named oalab, and the company name is Telco, you would enter:
CN=oarpt,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oarpt

OA Report Writer 
Group Distinguished 
Name (DN)

Enter the DN for the report writer group. For typical example of 
ADS setup, if you use the default group named oawriter, a 
domain named oalab, and the company name is Telco, you 
would enter:
CN=oawriter,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oawriter

Field Description

Field Description

Sun Web Server 
Install Location 

/usr/iplanet/servers (Sun Java System Web Server Version 6.0)
/opt/SUNWwbsvr (Sun Java System Web Server Version 6.1)
This is the default installation location and must match the installation 
location selected in Installing and configuring the Sun Web server on a 
Solaris machine on page 112 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites.

Stumbras Port 
Number 

Enter any port from 1024 through 65535; 11000 is recommended

Fully Qualified 
Reports Server 
Name 

Enter the fully-qualified domain name of the Web server as described in 
Installing and configuring the Sun Web server on a Solaris machine on 
page 112 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites
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See the following table for AIX field information:

15. Click Next.
For AIX only, a warning message is displayed if you did not enter WebSphere Admin 
Console login ID and password. Confirm that, if the login ID was assigned for Global 
Security during WebSphere installation, you have entered the login ID and password. 
See Creating a secure login by enabling Global Security (optional) on page 124 in 
Avaya Operational Analyst Release 7.0 Installation Planning and Prerequisites for 

Field Description

WebSphere 
Install Location 

/usr/IBM/WebSphere/AppServer
This is the default installation location and must match the installation 
location selected in Installing and configuring WebSphere Application 
Server on an AIX machine on page 114 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites.

IBM HTTP Server 
Install Location

/usr/IBMIHS
This is the default installation location. If the IC Web Channel and the 
OA Report subsystem will be installed on the same server machine, 
there must be two instances of the HTTP Server software installed on 
that machine. You must determine where the HTTP Server software 
was installed for Avaya IC, which is typically in the default location /
usr/IBMIHS/bin. Once that location has been determined, you must 
select a different location where the HTTP Server software will be 
installed for OA, for example, /usr/OA_IBMHttpServer/bin. See 
Installing and configuring WebSphere Application Server on an AIX 
machine on page 114 in Avaya Operational Analyst Release 7.0 
Installation Planning and Prerequisites for more information.

WebSphere 
Application 
Server Name

server1
This is the default server name for WebSphere and must match the 
name used during installation in Installing and configuring WebSphere 
Application Server on an AIX machine on page 114 in Avaya 
Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

WebSphere 
Admin Console 
Login ID

If you configured WebSphere for Global Security (see Creating a secure 
login by enabling Global Security (optional) on page 124 in Avaya 
Operational Analyst Release 7.0 Installation Planning and 
Prerequisites), enter the login ID in this field. Otherwise, leave this field 
blank.

WebSphere 
Admin Console 
Password

Enter and confirm the Administrative Console password, if assigned. 
Otherwise, leave this field blank.

DB2 Version Select from the drop-down box which version of DB2 you are using for 
the historical database.
The DB2 Version field is displayed only if the Report subsystem is 
being installed on a server without the Historical subsystem.
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more information. If a login ID for global security was not assigned, these fields can be 
empty.

16. A warning message may be displayed about deleting the TimesTen database log files. 
Follow any instructions shown. When finished, click OK.

17. The Historical Server Configuration dialog box is displayed.

Note:
Note: The fields that appear on the Historical Server Configuration dialog box 

vary depending on your selections.
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18. Administer the dialog as shown in the following table:

19. Click Next.

Field Description

Historical 
Subsystem Server 
Name

Do one of the following:
● If you are installing the Historical subsystem, the name of this 

server is displayed and cannot be changed.
● If you are not installing the Historical subsystem, enter the 

fully-qualified domain name of the machine where the Historical 
subsystem is installed.

Historical 
Database Server 
Name

Do one of the following:
● If the historical database is located on the same machine where 

the Historical subsystem is being installed, enter the machine 
name.

● If the historical database is located on a different machine than 
where the Historical subsystem is being installed, enter the 
fully-qualified domain name for the machine where the historical 
database is installed.

The filegroups or tablespaces must be manually created on the 
historical database server before this installation may continue. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Please choose a 
Historical 
Database

Select the appropriate database.
If the system can identify the database type based on the 
Historical Database Server Name, it will be the only type listed.

Create Historical 
Tables for these 
Collection Sources

Select the collection sources for the historical tables.
You can collect data from Avaya IC, CMS, or both depending on 
what is allowed with your product license. If you are using a 
back-end database, you must create filegroups or tablespaces for 
Avaya IC, CMS or both prior to selecting collection sources. See 
Filegroup and tablespace sizing on page 59 in Avaya Operational 
Analyst Release 7.0 Installation Planning and Prerequisites.

Note:
Note: You cannot remove these collection sources when 

adding components to an OA installation.

Alarm Services If you want to send alarm data to the Avaya IC server, click the IC 
box under Alarm Services, and enter the fully-qualified domain 
name of the server where the Source-EC (Event Collector) 
subsystem is installed in the Server Name field.
For an OA and CMS configuration without Avaya IC, leave these 
options blank.
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20. If you are adding the Historical or Report subsystem, the Database Configuration 
dialog box is displayed.

! Important:! Important:
Important: If you are adding the Historical subsystem to a server that is separate from 

the historical database, you must first install the database client software on 
the server where the Historical subsystem is being added.

21. Use the following information to complete the dialog box. Use the values from your 
database installation, which is described in Installing the historical database 
software on page 57 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites. Some of the fields may include default values.

Field Oracle Microsoft SQL DB2

DB Administrator 
Password

Password for the sys 
user ID

Password for the sa user 
ID

N/A

OA DB User ID User ID for the OA 
database (OA creates 
this user ID during a new 
installation)

User ID for the OA 
database (OA creates 
this User ID during a new 
installation)

User ID for the OA 
database (OA creates 
this user ID during a new 
installation)

OA DB User 
Password

User password for the 
OA database 

User password for the 
OA database 

User password for the 
OA database 

OA Database 
Name

New database name 
that will be created 
during install (for 
example, oadb)

New database name that 
will be created during 
install (for example, 
oadb)

The database name 
given when DB2 was 
installed and an instance 
was created. 
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IC DB User ID1 User ID for the Avaya IC 
Repository database 
(this must be an existing 
Avaya IC user ID, for 
example, repository)

User ID for the Avaya IC 
Repository database 
(this must be an existing 
Avaya IC user ID, for 
example, repository)

User ID for the Avaya IC 
Repository database 
(this must be an existing 
Avaya IC user ID, for 
example, db2inst1)

IC DB User 
Password1

User password for the 
Avaya IC Repository 
user ID

User password for the 
Avaya IC Repository 
user ID

User password for the 
Avaya IC Repository 
user ID

IC Repository 
Database1

Avaya IC Repository 
database name (for 
example, repository)

Avaya IC Repository 
database name (for 
example, repository)

Avaya IC Repository 
database/schema name 
(for example, 
repository)

DB Instance Name Avaya IC and OA 
database instance name

Avaya IC and OA 
database instance name 
(MSSQLSERVER if you 
used the default 
database instance)

Avaya IC and OA 
database instance name 
(for example, 
db2instl, which is the 
default).

TCP/IP Port 
Number

1521 (if using the 
default configuration, 
otherwise the port 
number specified during 
database installation)

1433 (if using the 
default configuration, 
otherwise the port 
number specified during 
database installation)

Port number assigned to 
the database instance 
creation during the DB2 
installation. If you are 
not sure of the number, 
check /etc/services 
and look for the DB2 
instance name. The port 
number is included.

Oracle TNS Server 
Name

A valid TNS server 
name. This name is 
assigned by the 
database administrator 
during Oracle 
installation. The default 
name is 
dbservername.oadb.
You must check the 
tnsnames.ora file and 
use the exact entry 
found there. If an entry is 
not found, ask the DBA 
to create a 
tnsnames.ora entry 
and then use the exact 
entry found there.

N/A N/A

SQL Server 
DataBase Name

N/A New Microsoft SQL 
database created during 
installation

N/A

Field Oracle Microsoft SQL DB2
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22. Click Next.
One of the following occurs:

● For Oracle, continue with Step 23.

● For Microsoft SQL, continue with Step 26.

● For AIX, continue with Step 30.

23. A warning dialog about the Oracle archive log may be displayed.

24. Click OK to acknowledge the warning, if displayed.

25. For Oracle, the TNSnames.ora file is scanned to see if the TNS server name is 
contained within that file. If it is, the install continues with Step 30. If it is not, the 
following warning message is displayed asking if you want the installation program to 
modify the TNSnames.ora file to include the TNS server name.

● If you select No, you are returned to the Database Configuration dialog box. You 
can go no further until you resolve the TNS server name issue.

● If you select Yes, the installation program attempts to edit the file. One of the 
following occurs:

- If the permissions on the TNSnames.ora file allow writing, the file is modified to 
include the administered TNS server name and the install continues.

- If the permissions on the TNSnames.ora file are read-only, the file cannot be 
modified and a message is displayed stating that the permissions on the file 
must be changed manually. Select OK to return to the Database Configuration 
dialog box. You must change permissions on the file if you want to continue with 
the install.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

1. This field does not display if Avaya IC is not used as a collection source. During the creation of the Repository 
Database using Oracle as your database software, you will be asked to provide a password for the Repository 
database. Use this name as your IC DB User ID along with the password you enter.
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26. The following dialog box is displayed when using Microsoft SQL Server. If you are not 
using Microsoft SQL, continue with Step 30.

27. Select Use Existing DB if you want to use an existing database.

28. If you choose to not use the existing database, enter the size and location of the 
Microsoft SQL Server Transaction Log. You can use the default locations if you want.

29. Click Next.
If you are adding the Historical subsystem, the next step is to configure tablespaces.

! Important:! Important:
Important: If the database is on a back-end database server, none of the dialog boxes 

shown in this section are displayed. Continue with Step 38.
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30. The OA Common Table Spaces dialog box is displayed.

31. Enter the correct location and size for each filegroup or tablespace. For more 
information on how to set these values see Filegroup and tablespace sizing on 
page 59 in Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Note:
Note: If the filegroups and tablespaces do not already exist, the Use Existing 

checkboxes will not display and the Location and Size input fields will 
include editable default values. If the filegroups and tablespaces do already 
exist, the Use Existing checkboxes will be selected. You can clear the 
checkboxes and enter a different location and size.
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32. Click Next. 
If data will be collected from CMS, the OA CMS Specific dialog box is displayed.

33. Enter the correct location and size for each filegroup or tablespace. For more 
information on how to set these values see Filegroup and tablespace sizing on 
page 59 in Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Note:
Note: If the filegroups and tablespaces do not already exist, the Use Existing 

checkboxes will not display and the Location and Size input fields will 
include editable default values. If the filegroups and tablespaces do already 
exist, the Use Existing checkboxes will be selected. You can clear the 
checkboxes and enter a different location and size.
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34. Click Next. 
If data will be collected from Avaya IC, the OA IC Specific dialog box is displayed.

35. Enter the correct location and size for each filegroup or tablespace. For more 
information on how to set these values see Filegroup and tablespace sizing on 
page 59 in Avaya Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

Note:
Note: If the filegroups and tablespaces do not already exist, the Use Existing 

checkboxes will not display and the Location and Size input fields will 
include editable default values. If the filegroups and tablespaces do already 
exist, the Use Existing checkboxes will be selected. You can clear the 
checkboxes and enter a different location and size.

36. Click Next. 
A warning message concerning the storage of historical data on one disk may be 
displayed.

37. Click OK to acknowledge the warning, if displayed.
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38. One of the following occurs:

● If you are not adding a Real-time subsystem, continue with Step 42.

● If you are adding a Real-time subsystem, the Real-time Configuration dialog box 
is displayed. 

39. In the Real Time DB Location field, Avaya recommends that you enter a path name 
that is on a different disk drive from where the OA software is being installed, and that 
has at least 2.2 GB of free disk space.

40. In the Real Time DB Size(M) field, the only option is 128.

41. Click Next.

! Important:! Important:
Important: If you do not have at least 2.2 GB of free disk space to install TimesTen, a 

warning message is displayed. You cannot continue until you free up at 
least 2.2 GB of disk space.

42. If you are adding the Administration client (Windows only), the Administration client 
locale settings dialog box is displayed. If you are not adding the Administration client, 
continue with Step 45.

43. Select a locale setting from the drop-down list.

44. Click Next.
45. The Installation Preview dialog box is displayed listing the components you have 

selected.
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46. Scroll through the preview dialog box to verify the selected components and 
configuration data.

! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

47. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the installation is finished, the Install Complete dialog box is displayed.

48. Click Next.
● On Solaris and AIX, the Install Complete dialog closes and the addition is finished.

● On Windows, the Restart System dialog box is displayed.

Before you reboot the server, make sure that a copy of the server.properties 
file is saved in case it is deleted during the reboot. Do the following:

i. Open Windows Explorer.

ii. Navigate to %PABASE%\BI\data\admin.

iii. Copy the server.properties file onto the Windows clipboard.

iv. Go to your Windows desktop (or some other location other than the OA 
installation directory) and paste the server.properties file there.

! Important:! Important:
Important: You must always restart a Windows server at this time for OA to operate 

properly. If you are not requested to restart the server, you must manually 
restart the server.

v. Go back to the Restart System dialog box, select the option to restart your 
system now, and click Next.

vi. After the system reboots, navigate to %PABASE%\BI\data\admin.

vii. Verify that the server.properties file is in the folder.

viii. If the file is not in the folder, go to the location where you saved a copy of 
server.properties and copy the file onto the Windows clipboard.

ix. Navigate to %PABASE%\BI\data\admin.

x. Paste the server.properties file into the folder.
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49. Do one of the following:

● On Windows, press the eject button on the CD-ROM drive, remove the CD-ROM, 
and store it in a safe location.

● On Solaris, close all but one terminal window and enter:

cd /

eject cdrom

● On AIX, close all but one terminal window and enter:

cd /

umount /cdrom

50. Press the eject button on the CD-ROM drive (AIX only).

51. Remove the OA CD-ROM and store it in a safe location.

52. If you added the Report subsystem, remember to install the Report client support files 
(see Installing and testing the Report client on page 102).

Completing an addition to Avaya OA
Depending on the platform you are using, use the procedures in the following sections to 
complete your addition:

● To complete an addition to a Windows system on page 177

● To complete an addition to a Solaris system on page 181

● To complete an addition to an AIX system on page 186

To complete an addition to a Windows system
1. Log in using an OA user ID and password (see Creating user IDs and group IDs on 

Windows servers on page 96 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

2. Open a command prompt window.

3. If Terminal Services is enabled, enter:

change user /execute
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4. In the command prompt window, enter the following command to show what processes 
are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If you get the message mom is not active, enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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7. Enter:

oalist

A message similar to the following is displayed listing what components are installed 
on this server:

8. Select Start > Programs > Administrative Tools > Services. 

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. Validate that the following services are started and are set to start automatically. If they 
are not administered to start automatically, administer them as such.

● If the Historical subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

● If the Real-time subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- TimesTen Data Manager 5.0

● If the Report subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- Stumbras-Tomcat

● If the Source-EC (Event Collector) subsystem is installed, check for the following:

- ORBacus Naming Service

10. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.
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To complete an addition to a Solaris system
1. Log out of the desktop environment.

2. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Solaris servers on page 99 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

3. Enter:

. /opt/BI/.profile

4. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If you get the message mom is not active, enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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7. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

8. Enter:

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

10. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

11. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

12. If the Report subsystem is installed, enter the following commands to start Stumbras:

cd $SUN_WEB_HOME/https-stumbras

./start

The following message is displayed.

 root   233     1  0   Dec 23 ?        0:01 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend
    root   234   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 0
    root   235   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 1
    root   236   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 2
    root   237   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 3
 biadmin   244   182  0 10:34:22 pts/11   0:00 grep timesten

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 1000
0 -OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

.

.

.
Startup: server started successfully



Adding Avaya OA components

Issue 2.0 July 2005 185

13. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if Stumbras-Tomcat is running:

ps -ef | grep https-stumbras

A message similar to the following should be displayed.

● For Sun Java System Web Server 6.0:

● For Sun Java System Web Server 6.1:

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 biadmin  6141     1  0   Dec 31 ?        0:00 ./uxwdog -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6143  6142  0   Dec 31 ?        1:01 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6142  6141  0   Dec 31 ?        0:03 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin   254   182  0 10:38:51 pts/11   0:00 grep https-stumbras

 biadmin 28604 28603  0 16:38:23 ?        1:58 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 28602     1  0 16:38:22 ?        0:00 ./webservd-wdog -r /opt/SUNWwbsvr
 -d //opt/SUNWwbsvr/https-stumbras/config -n h
 biadmin 28603 28602  0 16:38:22 ?        0:01 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 29266 29259  0 18:55:22 pts/22   0:00 grep https-stumbras
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To complete an addition to an AIX system
1. Log out of the desktop environment.

2. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
AIX servers on page 105 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

3. Enter:

. /opt/BI/.profile

4. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If OA is not running (mom is not active), enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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7. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

8. Enter:

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

10. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

11. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

12. If the Report subsystem is installed, enter the following commands to stop and restart 
the WebSphere software:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT -u 
userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

 biadmin 20858 48090   0 13:01:34  pts/0  0:00 grep timesten
    root 31910 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 2 -facility user
    root 32664 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 1 -facility user
    root 36302 36980   0   Apr 16      -  3:35 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 3 -facility user
    root 36980  6302   0   Apr 16      -  0:42 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend -fg
    root 40150 36980   0   Apr 16      -  0:18 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 0 -facility user

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv



Making changes to installed Avaya OA components

190 Operational Analyst 7.0 Installation and Configuration

Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

13. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if WebSphere is running:

ps -ef | grep WebSphere

A message similar to the following should be displayed.

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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 biadmin 28514     1   0   Jun 03      -  4:39 /usr/IBM/WebSphere/AppServer/java/
bin/java -Xbootclasspath/p:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/
ibmorb.jar:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/ibmext.jar 
-Dwas.status.socket=53964 -classpath /usr/IBM/WebSphere/AppServer/profiles/
default/properties:/usr/IBM/WebSphere/AppServer/properties:/usr/IBM/WebSphere/
AppServer/lib/bootstrap.jar:/usr/IBM/WebSphere/AppServer/lib/j2ee.jar:/usr/IBM/
WebSphere/AppServer/lib/lmproxy.jar:/usr/IBM/WebSphere/AppServer/lib/
urlprotocols.jar:/usr/opt/db2_08_01/java/db2jcc.jar:/usr/opt/db2_08_01/java/
db2jcc_license_cu.jar:/usr/opt/db2_08_01/java/db2jcc_license_cisuz.jar -Xms50m 
-Xmx512m -Dws.ext.dirs=/usr/IBM/WebSphere/AppServer/java/lib:/usr/IBM/WebSphere/
AppServer/profiles/default/classes:/usr/IBM/WebSphere/AppServer/classes:/usr/
IBM/WebSphere/AppServer/lib:/usr/IBM/WebSphere/AppServer/installedChannels:/usr/
IBM/WebSphere/AppServer/lib/ext:/usr/IBM/WebSphere/AppServer/web/help:/usr/IBM/
WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.ejbdeploy/runtime 
-Dcom.ibm.itp.location=/usr/IBM/WebSphere/AppServer/bin 
-Djava.util.logging.configureByServer=true -Dibm.websphere.preload.classes=true 
-Duser.install.root=/usr/IBM/WebSphere/AppServer/profiles/default 
-Dwas.install.root=/usr/IBM/WebSphere/AppServer 
-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager 
-Ddb2j.system.home=/usr/IBM/WebSphere/AppServer/cloudscape -Dserver.root=/usr/
IBM/WebSphere/AppServer/profiles/default -Djava.awt.headless=true 
-Djava.security.auth.login.config=/usr/IBM/WebSphere/AppServer/profiles/default/
properties/wsjaas.conf -Djava.security.policy=/usr/IBM/WebSphere/AppServer/
profiles/default/properties/server.policy com.ibm.ws.bootstrap.WSLauncher 
com.ibm.ws.runtime.WsServer /usr/IBM/WebSphere/AppServer/profiles/default/config 
groverNode01Cell groverNode01 server1
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14. To verify that OA reports are running using the WebSphere Administrative Console:

a. In a browser window, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the server 
where the Report subsystem is installed and port_number is the port number 
assigned to the WebSphere Administrative Console (for example, 9060).

b. Log in to the WebSphere Administration Console using the Global Security user ID 
and password (if assigned). Otherwise, enter any user ID.

c. Select Applications > Enterprise Applications.

d. If there is a green arrow next to Default, select the check box to the left of Default 
and select Stop.

e. Verify that there is a green arrow next to OAReports. If there is a red X, select the 
check box to the left of OAReports and select Start. This should change the status 
to a green arrow. If not, escalate the problem using the normal channels.
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Repairing Avaya OA components
The repair process reinstalls software that was previously installed for components that are 
not working properly. When repairing a subsystem or client software, many of the 
installation dialog box fields will have data already populated from the original installation 
and that data cannot be changed.

This section includes the following topics:

● Considerations when doing a repair on page 193

● Repairing Avaya OA components on page 193

● Completing a repair to Avaya OA software on page 204

Considerations when doing a repair
When doing a repair, consider the following:

● During the repair process, some directories and files are not repaired because they 
have been previously modified during the running of OA. The components located 
under the %PABASE%\data or $PABASE/data directories are not touched. Therefore, 
it is critical to have a valid backup of this area in case file system problems develop and 
this directory needs to be restored after the repair.

● Further, the repair process does not repair the contents of a historical or real-time 
database. Problems with databases must be resolved by the database administrator.

● After doing a repair of the Basic Report subsystem, you must go to each Report client 
machine, uninstall the Report client, and reinstall the Report client. See Installing and 
testing the Report client on page 102 for more information.

Repairing Avaya OA components

Note:
Note: The procedures for repairing Avaya OA software is almost identical for all 

operating systems. For this procedure, the Windows dialog boxes are 
shown and any differences for the other operating systems are described.

To repair OA components:

1. Stop all OA processes. See Stopping or starting processes and services before making 
changes on page 151.

2. Do one of the following to access and start the installation executable:
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! CAUTION:
CAUTION: Install from a CD-ROM drive that is local to the server where you are 

installing OA. Installing from a networked CD drive is not supported.

Operating 
System

Procedure

Windows 1. Log in with a user ID that has administration privileges.
2. If Windows Terminal Services is installed in Application mode, open a 

command prompt window and enter:
change user /install

! CAUTION:
CAUTION: If Windows Terminal Services was installed in Administration 

mode, you cannot properly install any OA subsystem on that 
machine. See Operating systems on page 48 in Avaya 
Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

3. Place the OA CD-ROM in the drive.
4. Using Windows Explorer, navigate to the CD-ROM drive and 

double-click the WinSetup.exe file.
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Solaris 1. Log in as root.
2. Place the OA CD-ROM in the drive and wait about 15 seconds. A file 

manager window is displayed showing the contents of the CD-ROM.

Note:
Note: If the File Manager window does not open, enter the 

following commands to start the volume manager:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

3. From a terminal window, enter the following commands:
. /opt/BI/.profile

cd /cdrom/cdrom0

./SolSetup

AIX 1. Log in as root.
2. To set the monitor display, enter:
export DISPLAY=hostname:0.0

where hostname is the name of the server.

3. If you are adding the Historical subsystem, enter the following 
commands to set the DB2 environment:
- As the instance owner, or any member of DB2 SYSADM group:
export EXTSHM=ON

db2set DB2ENVLIST=EXTSHM

db2stop

db2start

- As the user launching the OA Installation (root):
# export EXTSHM=ON

# ./AixSetup

4. Place the OA CD-ROM in the drive and wait about 15 seconds.
. /opt/BI/.profile

mkdir /cdrom (if this directory does not already exist)

mount -v cdrfs -r /dev/cd0 /cdrom

cd /cdrom

./AixSetup

Operating 
System

Procedure
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After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 28). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

3. Click Next.
The License Key dialog box is displayed.

4. Enter the provided license key for the components purchased.

5. Click Next.
The License Agreement dialog box is displayed.

6. Select I accept the terms in the license agreement.
7. Click Next. 

The User Information dialog box is displayed.

Note:
Note: The Domain field is only displayed for Windows systems.

8. Enter and confirm the password for the installed user ID.
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9. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

The Feature Selection dialog box is displayed showing the components that were 
previously installed. In this example, all available components are installed.
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10. Select the components to you want to repair.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.

You can only select components that are already installed. If you want to install a 
new component, see the procedure Adding Avaya OA components on page 155.

The following example shows the Feature Selection dialog box with the Historical 
subsystem, Reporting subsystem, Data API Utility, and Administration client selected 
for repair:

11. Click Next. One of the following occurs:

● If you are repairing the Historical subsystem or the Report subsystem on a Windows 
or Solaris system, the Reports Configuration dialog box is displayed, but no 
options can be changed. Continue with Step 12.

● If you are repairing the Report subsystem on an AIX system, and the Report 
subsystem was previously installed using a non-default WebSphere Administrative 
Console user ID, the Reports Configuration dialog box is displayed showing the 
current WebSphere Admin Console User ID. The user ID password must be 
entered and confirmed. Continue with Step 12.

● If you are not repairing the Historical subsystem or the Report subsystem, the 
process continues with Step 13.

12. Click Next.
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13. If you are repairing the Historical subsystem, the Historical Server Configuration 
dialog box is displayed. If you are not repairing the Historical subsystem, continue with 
Step 16.

14. Do the following:

● If you need to add a new data collection source, select that source, either IC or 
CMS.

● If you are just repairing an existing data collection source, do not select a new 
source.

● Complete the Alarm Services options as needed. The server name must be the 
server where the Source-EC subsystem is installed. This information may already 
be displayed, but can be changed if needed.

15. Click Next.
16. One of the following occurs:

● If you are repairing only the Source-CMS subsystem on a Solaris server, the CMS 
User ID dialog box is displayed and you must enter and confirm the password for 
the Informix user ID. Continue with Step 26.

● If you are repairing only the Real-time subsystem, continue with Step 24.

● If you are repairing the Historical subsystem, continue with Step 17.



Making changes to installed Avaya OA components

200 Operational Analyst 7.0 Installation and Configuration

17. The Database Configuration dialog box is displayed. Only the password fields can be 
changed.

18. Enter and confirm the administrator password. If during the repair you are adding 
Avaya IC as a data collection source, enter the IC DB User ID, IC DB User Password, 
IC Repository Database name (not shown in the above example).

19. Click Next.
A warning message may be displayed.
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20. Click OK to acknowledge the warning.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

The following dialog box is displayed when using Microsoft SQL Server. If you are not 
using Microsoft SQL, continue with Step 24.

21. Select Use Existing DB if you want to use an existing database.

22. If you choose to not use the existing database, enter the size and location of the 
Microsoft SQL Server Transaction Log. You can use the default locations if you want.

23. Click Next.
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24. If you are repairing the Real-time subsystem, the Real-time Database dialog box is 
displayed, but no options can be changed. If you are not repairing the Real-time 
subsystem, continue with Step 26.

25. Click Next.

Note:
Note: There may be a long delay before the next dialog box is displayed. 

26. The Installation Preview dialog box is displayed listing the components you have 
selected.

27. Scroll through the preview dialog box to verify the selected components and 
configuration data.

! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

28. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the installation is finished, the Install Complete dialog box is displayed.
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29. Click Next.
● On Solaris and AIX, the Install Complete dialog closes and the repair is finished.

● On Windows, the Restart System dialog box is displayed.

Before you reboot the server, make sure that a copy of the server.properties 
file is saved in case it is deleted during the reboot. Do the following:

i. Open Windows Explorer.

ii. Navigate to %PABASE%\BI\data\admin.

iii. Copy the server.properties file onto the Windows clipboard.

iv. Go to your Windows desktop (or some other location other than the OA 
installation directory) and paste the server.properties file there.

! Important:! Important:
Important: You must always restart a Windows server at this time for OA to operate 

properly. If you are not requested to restart the server, you must manually 
restart the server.

v. Go back to the Restart System dialog box, select the option to restart your 
system now, and click Next.

vi. After the system reboots, navigate to %PABASE%\BI\data\admin.

vii. Verify that the server.properties file is in the folder.

viii. If the file is not in the folder, go to the location where you saved a copy of 
server.properties and copy the file onto the Windows clipboard.

ix. Navigate to %PABASE%\BI\data\admin.

x. Paste the server.properties file into the folder.

30. Do one of the following:

● On Windows, press the eject button on the CD-ROM drive, remove the CD-ROM, 
and store it in a safe location.

● On Solaris, close all but one terminal window and enter:

cd /

eject cdrom

● On AIX, close all but one terminal window and enter:

cd /

umount /cdrom

31. Press the eject button on the CD-ROM drive (AIX only), remove the OA CD-ROM, and 
store it in a safe location.
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Completing a repair to Avaya OA software
Depending on the platform you are using, use the procedures in the following sections to 
complete your repair:

● To complete a repair to a Windows system on page 204

● To complete a repair to a Solaris system on page 207

● To complete a repair to an AIX system on page 213

To complete a repair to a Windows system
1. Log in using an OA user ID and password (see Creating user IDs and group IDs on 

Windows servers on page 96 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

2. Open a command prompt window.

3. If Terminal Services is enabled, enter:

change user /execute

4. In the command prompt window, enter the following command to show what processes 
are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If you get the message mom is not active, enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

7. Enter:

oalist

A message similar to the following is displayed listing what components are installed 
on this server:

8. Select Start > Programs > Administrative Tools > Services. 

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. Validate that the following services are started and are set to start automatically. If they 
are not administered to start automatically, administer them as such.

● If the Historical subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

● If the Real-time subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- TimesTen Data Manager 5.0

● If the Report subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- Stumbras-Tomcat

● If the Source-EC (Event Collector) subsystem is installed, check for the following:

- ORBacus Naming Service

10. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.
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To complete a repair to a Solaris system
1. Log out of the desktop environment.

2. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Solaris servers on page 99 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

3. Enter:

. /opt/BI/.profile

4. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If you get the message mom is not active, enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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7. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

8. Enter:

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

10. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following is displayed.

11. If the Source-CMS subsystem is installed, use the following command and response to 
verify that the required service is running. If the service is not running, escalate the 
problem using the normal channels.

ps -ef | grep nameserv

A message similar to the following should be displayed.

12. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root   233     1  0   Dec 23 ?        0:01 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend
    root   234   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 0
    root   235   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 1
    root   236   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 2
    root   237   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 3
 biadmin   244   182  0 10:34:22 pts/11   0:00 grep timesten

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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13. If the Report subsystem is installed, enter the following commands to start Stumbras:

cd $SUN_WEB_HOME/https-stumbras

./start

The following message is displayed.

14. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

.

.

.
Startup: server started successfully

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if Stumbras-Tomcat is running:

ps -ef | grep https-stumbras

A message similar to the following should be displayed.

● For Sun Java System Web Server 6.0:

● For Sun Java System Web Server 6.1:

 biadmin  6141     1  0   Dec 31 ?        0:00 ./uxwdog -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6143  6142  0   Dec 31 ?        1:01 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6142  6141  0   Dec 31 ?        0:03 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin   254   182  0 10:38:51 pts/11   0:00 grep https-stumbras

 biadmin 28604 28603  0 16:38:23 ?        1:58 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 28602     1  0 16:38:22 ?        0:00 ./webservd-wdog -r /opt/SUNWwbsvr
 -d //opt/SUNWwbsvr/https-stumbras/config -n h
 biadmin 28603 28602  0 16:38:22 ?        0:01 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 29266 29259  0 18:55:22 pts/22   0:00 grep https-stumbras
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To complete a repair to an AIX system
1. Log out of the desktop environment.

2. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
AIX servers on page 105 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

3. Enter:

. /opt/BI/.profile

4. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If OA is not running (mom is not active), enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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7. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

8. Enter:

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

10. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following is displayed.

11. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

12. If the Report subsystem is installed, enter the following commands to stop and restart 
the WebSphere software:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT -u 
userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

 biadmin 20858 48090   0 13:01:34  pts/0  0:00 grep timesten
    root 31910 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 2 -facility user
    root 32664 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 1 -facility user
    root 36302 36980   0   Apr 16      -  3:35 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 3 -facility user
    root 36980  6302   0   Apr 16      -  0:42 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend -fg
    root 40150 36980   0   Apr 16      -  0:18 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 0 -facility user

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX
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13. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if WebSphere is running:

ps -ef | grep WebSphere

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv



Repairing Avaya OA components

Issue 2.0 July 2005 219

 biadmin 28514     1   0   Jun 03      -  4:39 /usr/IBM/WebSphere/AppServer/java/
bin/java -Xbootclasspath/p:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/
ibmorb.jar:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/ibmext.jar 
-Dwas.status.socket=53964 -classpath /usr/IBM/WebSphere/AppServer/profiles/
default/properties:/usr/IBM/WebSphere/AppServer/properties:/usr/IBM/WebSphere/
AppServer/lib/bootstrap.jar:/usr/IBM/WebSphere/AppServer/lib/j2ee.jar:/usr/IBM/
WebSphere/AppServer/lib/lmproxy.jar:/usr/IBM/WebSphere/AppServer/lib/
urlprotocols.jar:/usr/opt/db2_08_01/java/db2jcc.jar:/usr/opt/db2_08_01/java/
db2jcc_license_cu.jar:/usr/opt/db2_08_01/java/db2jcc_license_cisuz.jar -Xms50m 
-Xmx512m -Dws.ext.dirs=/usr/IBM/WebSphere/AppServer/java/lib:/usr/IBM/WebSphere/
AppServer/profiles/default/classes:/usr/IBM/WebSphere/AppServer/classes:/usr/
IBM/WebSphere/AppServer/lib:/usr/IBM/WebSphere/AppServer/installedChannels:/usr/
IBM/WebSphere/AppServer/lib/ext:/usr/IBM/WebSphere/AppServer/web/help:/usr/IBM/
WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.ejbdeploy/runtime 
-Dcom.ibm.itp.location=/usr/IBM/WebSphere/AppServer/bin 
-Djava.util.logging.configureByServer=true -Dibm.websphere.preload.classes=true 
-Duser.install.root=/usr/IBM/WebSphere/AppServer/profiles/default 
-Dwas.install.root=/usr/IBM/WebSphere/AppServer 
-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager 
-Ddb2j.system.home=/usr/IBM/WebSphere/AppServer/cloudscape -Dserver.root=/usr/
IBM/WebSphere/AppServer/profiles/default -Djava.awt.headless=true 
-Djava.security.auth.login.config=/usr/IBM/WebSphere/AppServer/profiles/default/
properties/wsjaas.conf -Djava.security.policy=/usr/IBM/WebSphere/AppServer/
profiles/default/properties/server.policy com.ibm.ws.bootstrap.WSLauncher 
com.ibm.ws.runtime.WsServer /usr/IBM/WebSphere/AppServer/profiles/default/config 
groverNode01Cell groverNode01 server1
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14. To verify that OA reports are running using the WebSphere Administrative Console:

a. In a browser window, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the server 
where the Report subsystem is installed and port_number is the port number 
assigned to the WebSphere Administrative Console (for example, 9060).

b. Log in to the WebSphere Administration Console using the Global Security user ID 
and password (if assigned). Otherwise, enter any user ID.

c. Select Applications > Enterprise Applications.

d. If there is a green arrow next to Default, select the check box to the left of Default 
and select Stop.

e. Verify that there is a green arrow next to OAReports. If there is a red X, select the 
check box to the left of OAReports and select Start. This should change the status 
to a green arrow. If not, escalate the problem using the normal channels.
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Moving subsystems
You may find that you need to move subsystems between servers. Some examples of 
situations that would require moving subsystems include the following:

● An existing machine in the OA configuration needs to be replaced with a faster machine 
in order to handle more traffic or more users.

● A single server OA configuration needs to grow to accommodate more traffic or more 
users. One or more of the OA subsystems are moved from the server to another 
machine. See Example of moving subsystems on page 223.

● A machine may need to be replaced because of a hardware failure.

● You may want to consolidate multiple CMS systems into one CMS system. 

● The network is changing in such a way that the fully-qualified domain name for one or 
more machines changes. See Example for changing a domain name on page 232 for 
an example.

Note:
Note: There is a prerequisite that TCP/IP and Domain Name Service (DNS) 

administration be set up for each machine in an OA configuration. See 
Appendix B: Networking on page 141 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites for more information on 
the TCP/IP administration and DNS resolution prerequisites.

This section includes the following topics:

● General guidelines on page 222

● Example of moving subsystems on page 223

● Moving the Real-time subsystem on page 224

● Moving the Event Collector subsystem on page 226

● Moving the Event Collector Bridge subsystem on page 227

● Moving CMS and ACD subsystems on page 228

● Moving the Report subsystem on page 231
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General guidelines
Follow these general guidelines when moving subsystems:

● Install no more than one of the same type of subsystem on a physical machine. For 
example there can only be one historical, one real-time, one report, or one CMS 
subsystem per machine. Some subsystems can be co-resident. CMS is the only 
subsystem that must reside on a separate physical machine from the other subsystems.

● Choose a low- or no-traffic time to move subsystem. Many subsystem changes require 
significant changes in data flow. 

● Moving the historical database is not supported. Doing so impacts a significant amount 
of OA and Avaya IC administration.

● Moving the Historical subsystem is not supported.

● Because real-time data is transient, you can install the Real-time subsystem on a new 
machine. This installs the real-time database on that machine as well. The system 
forces a pump-up (that is, administration copy from Avaya IC to OA). Change Avaya IC 
to point to the new Real-time subsystem, and the data flows from Avaya IC to the new 
machine. See Moving the Real-time subsystem on page 224.

● If communication between the Historical subsystem and any of the subsystems 
containing interfaces is failing, attempting to delete those subsystems results in an 
Admin Client error message. You can stop the delete and work to re-establish the 
communication or you can proceed with the delete. If you proceed with the delete, the 
OA database will be updated, but you leave obsolete but functioning interface services 
on the original server. Use the system console on the original server to stop the services 
(see Making changes to installed Avaya OA components on page 149). Then remove 
the original subsystem, following the instructions in Removing Avaya OA 
components on page 243.
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Example of moving subsystems
The following example shows how you can take a single-server OA configuration and 
move to a two-server configuration.

In this example, assume that the following subsystems in a single server system are all on 
server A:

● Historical

● Real-time

● Avaya IC

● Report

If you want to move the Real-time and Report subsystems to server B:

1. Install the OA Real-time and Report subsystems on the new server, B.

The standard OA installation program installs the software needed for these 
subsystems, including the real-time database.

2. Move the Real-time subsystem. Follow the instructions in Moving the Real-time 
subsystem on page 224.

3. Move the Report subsystem. Follow the instructions in Moving the Report 
subsystem on page 231.
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Moving the Real-time subsystem
Move an existing Real-time subsystem to another physical machine by following these 
steps:

1. Install the OA Real-time subsystem software on the new server (see Installing Avaya 
OA components on page 29).

2. Stop all traffic from Avaya IC to OA by stopping the Event Collector server in the IC 
Manager.

3. On the subsystem window of the Administration client, modify the Real-time 
subsystem and change the location to be the domain name or IP address for the new 
machine.

The Administration client will present a list of any interface services that must be 
disabled before proceeding. 

4. Access the Interface Services window and select the services in the list. View the 
current status for each service, then disable each service.

5. Return to the subsystem window and change the server location to that of the new 
machine.

6. For each Avaya IC subsystem, click Modify... to verify that its Real-time subsystem 
drop-down box reflects the correct Real-time subsystem.

7. Access IC Manager and change the Event Controller administration properties to point 
to the new real-time machine. 

8. Using the IC Manager:
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a. Select the Server tab.

b. Select the Event Collector that corresponds to the Real-time subsystem that is 
being moved. In this case, the name is ECServer. 

c. Double-click to access the Server Editor dialog. 

d. Select the Event Collector tab.

e. Change the Data Manager Host name for the new real-time server.

f. Click Apply and click Ok.
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9. Return to the main IC Manager page and view the Services tab. Highlight the Event 
Collector Server to stop it and start it. Use the buttons with the red and green 
stoplights.

The Avaya IC and new real-time should be communicating at this point. Traffic can be 
restarted. The change in data flow will force a pump-up (copy of administration data) 
from the Avaya IC to OA when the new database comes up.

10. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.

Moving the Event Collector subsystem
To move the Event Collector subsystem:

1. Install the Avaya IC software on the new server (see Avaya Interaction Center 
Release 7.0 Installation and Configuration).

2. Install the Source-EC (Event Collector) component on the new server (see Installing 
Avaya OA components on page 29).

3. On the new server, configure the Event Collector so that its properties, Data Manager 
Host and Real-time System ID, are set correctly. See Determining Real-time System 
ID and Data Manager Host on page 136 for more details.

● The Data Manager Host should refer to the host for the Real-time subsystem.

● The Real-time System ID should match the Source ID for this Avaya IC subsystem 
in the OA Administration client.

Note:
Note: There are no changes in OA administration for Avaya IC. OA does not store 

location data (that is, host name or IP address) for the Avaya IC subsystem. 
In OA, Avaya IC exists as a logical subsystem with a source ID and an 
associated Real-time subsystem only.

4. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.
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Moving the Event Collector Bridge subsystem
The Event Collector Bridge subsystem can be moved only to a Windows server and to a 
server that has Business Advocate installed.

To move the Event Collector Bridge subsystem:

1. Install the Avaya IC software on the new server (see Avaya Interaction Center 
Release 7.0 Installation and Configuration).

2. Install the Source-EC Bridge (Event Collector Bridge) component on the new server 
(see Installing Avaya OA components on a Windows platform on page 32).

3. On the new server, configure the Event Collector Bridge so that its properties are set 
correctly. See Administering the Source-EC Bridge (Event Collector Bridge) on 
page 143 for more details.

Note:
Note: There are no changes in OA administration for Avaya IC. OA does not store 

location data (that is, host name or IP address) for the Avaya IC subsystem. 
In OA, Avaya IC exists as a logical subsystem with a source ID and an 
associated Real-time subsystem only.

4. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.
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Moving CMS and ACD subsystems
When you move a CMS subsystem, you must also move the ACD subsystem that applies 
to that CMS server. This section includes the following topics:

● Moving a CMS subsystem on page 228

● Moving ACDs associated with a CMS subsystem on page 230

Moving a CMS subsystem

To move the CMS subsystem to a different CMS server:

1. Install the CMS subsystem on the new server (see Installing Avaya OA components on 
a CMS server on page 92).

2. On the subsystem window of the Administration client, highlight the CMS subsystem 
and click Modify� 

3. Change the location (domain name or IP address) to location of the new machine.

The Administration client presents a list of interface services that must be disabled 
before proceeding.

4. Access the Interface Services window and select the services in the list. Get the 
current status for each service and disable each service.

Note:
Note: Depending on the number of services and whether data is being transferred 

by a forwarder or recorder, disabling the services can take a long period of 
time. The Administration client may appear to hang during this procedure, 
but it is just working on the request.

5. Return to the subsystem window and execute the change of the location of the CMS.

6. If necessary, enable the interface services on the new CMS. On the interface services 
window, select the CMS forwarders that reside on the new server and click Enable.

7. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.
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Note:
Note: Do not use the above procedure to merge two CMS servers. Successful 

handling of CMS data requires that all display names be retrieved and that 
containers be created that use the desired display names. For example, 
assume CMS-A was collecting data from ACDs 1 and 2, and CMS-B was 
collecting data from ACDs 3 and 4. Now, the customer wants to use CMS-A 
to collect data for ACDs 1, 2, 3, and 4, and eliminate CMS-B. The user 
should configure CMS-A to add support for ACDs 3 and 4. Then the user 
should move those ACDs to CMS-A by accessing their Modify� dialog and 
changing their CMS Subsystem Name to be CMS-A. Finally, the user should 
delete CMS-B. 

8. For each ACD that was moved, schedule a data collection job to retrieve its display 
names:

a. Access the scheduled jobs window. 

b. Select data collection from the Job Type drop-down list. Then click Add� 

c. In the add dialog, select the correct source subsystem and the Historical store of 
cms display names. Set the time parameters for the job such that it runs Now

d. Click OK.

e. Click Save.

9. On the Scheduled Jobs window, click Job Status. 

This displays the Job Status dialog. 

10. Select a Job Type of data collection and verify that the job has successfully 
completed. 

The job name should display in the table with a status of Successful. 
11. Access the Container Profiles window to update or add any containers that should 

now include data for the new ACDs.

12. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.
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Moving ACDs associated with a CMS subsystem

Every ACD subsystem has an associated CMS subsystem name. To move an ACD, the 
CMS subsystem name should be changed on the ACD subsystem dialog.

1. On the subsystem window of the Administration client, highlight the ACD to be moved, 
and click Modify� 

2. Change the CMS Subsystem Name drop-down list box to specify a different CMS. 

3. Click OK.
4. Click Save.

The administration client will return a list of interface services that must be disabled 
before the ACD can be moved. 

5. Access the Interface Services window and highlight the interface services from the 
list. View status for each service, then highlight each service and click Disable.

6. Return to the subsystem window and modify the ACD again. 

7. Change the CMS Subsystem Name.

8. Click OK.

9. Click Save. 

Forwarders will now exist on the new CMS subsystem for that ACD. 

10. Access the Interface Services window, and if they are not enabled, enable the 
forwarders in order to begin the data collection for the ACD.

11. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.
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Moving the Report subsystem
A Report subsystem can be moved by either changing the location field in the subsystem 
dialog box, or by installing the new subsystem, adding the new subsystem, and then 
deleting the old subsystem.

To move a Report subsystem by changing the location field in the subsystem dialog box:

1. Stop running reports on the server where the subsystem is being removed.

2. Install the Report subsystem on the new server using the OA installation CD-ROM. 
See Installing Avaya OA components on page 29.

3. On the subsystem window of the Administration client, highlight the Report subsystem 
and click Modify....

4. Change the location (domain name or IP address) to the name of the new machine.

5. Click OK.

6. Click Save.

Note:
Note: Moving the Report subsystem changes the URL to the reports window. For 

example, if you had been using the URL http://machine1/reports1, 
the new URL would be http://machine2/reports1 if you moved the 
Report subsystem to machine2.

7. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.

To move a Report subsystem by installing the new subsystem, adding the new subsystem, 
and then deleting the old subsystem:

1. Stop running reports on the server where the subsystem is being removed.

2. Install the Report subsystem on the new server using the OA installation CD-ROM. 
See Installing Avaya OA components on page 29.

3. Add the new Report subsystem. See Adding a Report subsystem on page 132.

Note:
Note: Moving the Report subsystem changes the URL to the reports window. For 

example, if you had been using the URL http://machine1/reports1, 
the new URL would be http://machine2/reports1 if you moved the 
Report subsystem to machine2.

4. Remove the original subsystem. Follow the instructions given in Removing Avaya OA 
components on page 243.
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Changing subsystem attributes
You may want to change names, IP addresses, and port numbers for subsystems on OA.

This section includes the following topics:

● Example for changing a domain name on page 232

● Changing the Historical subsystem machine name or IP address on page 233

● Changing the naming service port number on page 239

Example for changing a domain name
You may want to change the machine name or IP address of the Historical subsystem 
server without physically moving the subsystem to another machine. In this example, if the 
following subsystems are on the following servers:

● Historical subsystem on server A

● Real-time subsystem on server B

● Avaya IC subsystem on server A

● Report subsystem on server B

If you want to change the fully-qualified domain name for the subsystems on server A:

1. Refer to Appendix B: Networking on page 141 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites for more information on the TCP/IP 
administration and DNS resolution prerequisites that are required on OA machines.

2. Change the fully-qualified domain name for the Avaya IC subsystem. See Avaya 
Interaction Center 7.0 documentation for details.

3. Change the fully-qualified domain name for the Historical subsystem. See Changing 
the Historical subsystem machine name or IP address on page 233. 

If you want to change the fully-qualified domain name for the subsystems on server B:

1. Refer to Appendix B: Networking on page 141 in Avaya Operational Analyst 
Release 7.0 Installation Planning and Prerequisites for more information on the TCP/IP 
administration and DNS resolution prerequisites that are required on OA machines.

2. Change the fully-qualified domain name for the Real-time subsystem:

a. Enter the Subsystem screen in the OA Administration client.

b. Highlight the Real-time subsystem that should be changed.

c. Select Modify.
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d. Change the contents of the field labeled Internet domain name to the correct 
name.

e. Select OK.

f. Select Save in the Subsystem screen. 

3. Change the fully-qualified domain name for the Report subsystem:

a. Enter the Subsystem screen in the OA Administration client.

b. Highlight the Reports subsystem that should be changed.

c. Select Modify.

d. Change the contents of the field labeled Internet domain name to the correct 
name.

e. Select OK.

f. Select Save in the Subsystem screen. 

4. Restart Stumbras-Tomcat on the Report subsystem (in this example, on Windows):

a. Log in as an administrative user.

b. Select Start > Programs > Administrative Tools > Services. 

c. Restart the Stumbras-Tomcat service.

Changing the Historical subsystem machine name or IP 
address

You may want to change the machine name or IP address of the Historical subsystem 
server without physically moving the subsystem to another machine. These changes are 
made only to the administration of the machine.

Note:
Note: These steps assume that the database was installed using the Administrator 

login that is local to the current machine. If a different login was used during 
the installation, there may be issues with the database administration that 
must be resolved according to the database manufacturer�s instructions.

To change the name or IP address for the machine where the Historical subsystem is 
installed:

1. Log in using the appropriate user ID and password (see Creating users and setting OS 
parameters on page 95 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites).
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2. Stop all traffic to OA from every CMS and Avaya IC.

● For CMS:

i. Go to the Interface Services window and highlight each of the forwarders for each 
CMS. That is, the Subsystem column contains the name of the CMS.

ii. Press View Status.

iii. Highlight them again.

iv. Select Disable and Save.

● For Avaya IC:

i. Go to the IC Manager for each Avaya IC.

ii. In the Server tab, highlight the Event Collector and stop it.

iii. In the Server tab, highlight the Event Collector Bridge and stop it.

3. Follow the operating system instructions for changing a fully qualified domain name or 
IP address. On Windows, this includes using Control Panel to change the system�s 
domain. Make necessary changes to the DNS server IP addresses.

Note:
Note: Do not use the hosts file to resolve hostnames to IP addresses in OA 

configurations. Be sure DNS administration resolves all machine names in 
the same way.

4. On a Windows system, restart the system and log in to the new domain.

5. On the Historical server, update the following files manually:

The file path on Solaris and AIX is $PABASE/data/admin/.

The file path on Windows is %PABASE%\data\admin\.

● Change the hostname and service properties in the db.properties file from:

hostname=<old-machine-name>

service =<old-machine-name>.<db-instance-name>

to:

hostname=<new-machine-name>

service =<new-machine-name>.<db-instance-name>
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● Change the REPORT_GROUP, ADMIN_GROUP and RWRITER_GROUP properties in 
the autserver.properties file (Windows) from:

ADMIN_GROUP  =[old-domain-name]\\<admin-client-user-group>

REPORT_GROUP =[old-domain-name]\\<report-servr-user-group>

RWRITER_GROUP =[old-domain-name]\\<report-writer-user-group>

to:

ADMIN_GROUP  =[new-domain-name]\\<admin-client-user-group>

REPORT_GROUP =[new-domain-name]\\<report-servr-user-group>

RWRITER_GROUP =[new-domain-name]\\<report-writer-user-group>

● Change the REPORT_GROUP and ADMIN_GROUP properties in the 
autserver.properties file (Solaris and AIX) from:

ADMIN_GROUP  =[old-machine-name]\<admin-client-user-group>

REPORT_GROUP =[old-machine-name]\<report-servr-user-group>

RWRITER_GROUP =[old-machine-name]\\<report-writer-user-group>

to:

ADMIN_GROUP  =[new-machine-name]\<admin-client-user-group>

REPORT_GROUP =[new-machine-name]\<report-servr-user-group>

RWRITER_GROUP =[new-machine-name]\\<report-writer-user-group>

6. Stop OA by doing one of the following:

● On Windows:

i. Select Start > Programs > Administrative Tools > Services. 

ii. Select Avaya Business Intelligence Service.

iii. Select Action > Stop.

● On Solaris and AIX, enter the following commands:

. /opt/BI/.profile

pa stop all
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7. Change the following properties in the server.properties file from:

histserver=[name of historical server]

reportsServer=[name of reports server]

histDBserver=[name of database server]

histDbName=[name of database server]

to

histserver=[new name of historical server]

reportsServer=[new name of reports server]

histDBserver=[new name of database server]

histDbName=[new name of database server]

Note:
Note: If the name of the given server is fully qualified, the new name must be fully 

qualified. If the name of the given server is not fully qualified, the new name 
must not be fully qualified. If the name is blank, no change is necessary.

8. Stop and start Orbacus Naming Service.

● On Windows:

i. Select Start > Programs > Administrative Tools > Services. 

ii. Select ORBacus Naming Service.

iii. Select Action > Stop.

iv. Select Action > Start.
● On Solaris and AIX:

i. Edit /etc/inittab and change the following lines from:

in:234:respawn:/opt/BI/bin/initsrv.sh

nm:234:respawn:/opt/BI/bin/nameserv.sh

to:

in:234:off:/opt/BI/bin/initsrv.sh

nm:234:off:/opt/BI/bin/nameserv.sh

ii. Enter:

init q

This turns these daemons off. To turn them on, change the same lines back to 
respawn and enter the init q command again.

9. Stop and start the Web server.

● On Windows:
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i. Select Start > Programs > Administrative Tools > Services. 

ii. Select Stumbras-Tomcat.
iii. Select Action > Stop.

iv. Select Action > Start.
● On Solaris, enter the following commands:

cd $SUN_WEB_HOME/https-stumbras

./stop

./start

● On AIX, enter the following commands:

. /home/instanceID/.profile

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT 
-u userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

10. Start OA:

● On Windows:

i. Select Start > Programs > Administrative Tools > Services. 

ii. Select Avaya Business Intelligence Service.

iii. Click on Action > Start.
● On Solaris and AIX:

pa start all

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX
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11. On every server that is not a Historical server, manually update the following files:

$PABASE/data/admin/server.properties (Solaris and AIX)

%PABASE%\data\admin\server.properties (Windows)

Change the histserver property from:

histserver=<old-machine-name>

to:

histserver=<new-machine-name>

12. On every server that is not a Historical server, use the console to stop and start OA, 
entering:

pa stop all

pa start all

! Important:! Important:
Important: Stopping and starting all OA processes forces to restart and re-read the 

server.properties file. OA will not function correctly if this step is not 
performed.

13. On every Windows client PC where the OA Administration client is installed, edit the 
%PABASE%\AdminPol.html and %PABASE%\AdminSig.html files. The server 
name should be changed to the server name where the new Historical subsystem is 
installed. 

Change the SERVER_NAME property from:

<PARAM NAME="SERVER_NAME" VALUE="OLD-NAME">

SERVER_NAME="OLD-NAME"

to:

<PARAM NAME="SERVER_NAME" VALUE="NEW-NAME">

SERVER_NAME="NEW-NAME"

14. Restart the client software.

15. Open the Subsystems window of the OA Administration client. An asterisk (*) is 
displayed next to the Historical subsystem, indicating that the hostname and IP 
address are no longer in sync. Change the domain name to the new domain, then click 
OK and Save.

16. Enable the forwarders for CMS.

17. Start the Event Collector and Event Collector Bridge for Avaya IC using IC Manager.
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Changing the naming service port number
You may need to change the port number used by the ORBacus naming service. This is 
required if you are using another product that accesses the same port number as the 
default value used by OA. The default port number, 10000, can be changed to anything 
that is supported by the operating system. The instructions below explain how to manually 
change the port number for the naming service and the OA software. The port number 
change must be applied to all hosts of the system.

To change the naming service port number:
1. Log in using an OA user ID and password (see Creating users and setting OS 

parameters on page 95 in Avaya Operational Analyst Release 7.0 Installation Planning 
and Prerequisites).

2. In a command prompt window, enter:

. /opt/BI/.profile

pa stop all
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3. On Windows only:

a. Select Start > Programs > Administrative Tools > Services. 

b. Stop the Avaya Business Intelligence service, the ORBacus Naming Service, and 
the Stumbras-Tomcat service.

4. In the following file on the OA server running the Report subsystem:

● %PABASE%\stumbras\webapp\WEB-INF\config\ConfigService\
ConfigureService.xml (Windows)

● $SUN_WEB_HOME/https-stumbras/webapp/WEB-INF/config/
RTPAService/RTPAService.properties (Solaris Sun Java Web Server 6.0)

● $SUN_WEB_HOME/https-stumbras/webapps/WEB-INF/config/
RTPAService/RTPAService.properties (Solaris Sun Java Web Server 6.1)

● $WEBSPHERE_HOME/profiles/default/installedApps/
hostnameNode01Cell/OAReports.ear/stumbras.war/WEB-INF/config/
ConfigService/ConfigureService.xml (AIX)

change 10000 on the line <Port>10000</Port> to the port number you want to use:

5. In the following file on all OA servers, the Avaya IC server where the EC has been 
installed, and to the PCs running the Administration Client:

● %PABASE%\data\admin\server.properties (Windows)

● $PABASE/data/admin/server.properties (Solaris and AIX)

add the line NSPort=<port> where <port> is the same port number you used in the 
ConfigureService.xml file in the previous step.

6. In the registry editor (regedit) on a Windows server, change the port value located at 
HKEY_LOCAL_MACHINE\SOFTWARE\OOC\Properties\ooc\naming\port. Do 
this on all Windows OA servers, the Windows Avaya IC server where the EC has been 
installed, and to the Windows PCs running the Administration Client.

7. Using sqlplus for Oracle, Query Analyzer for Microsoft SQL, and db2 for DB2, apply 
the following query to the historical database, once for each Real-time host:

update dcProperty

set value = 'corbaname::hostname:port#CRM_BI.root/real.pkg/
RTDSSDSGatewayV1.obj'

where:

● value is similar to N'%<hostname>%RTDSSDSGatewayV1.obj'

● name is similar to 'RTPAConfig.Server%CorbaURL';

● hostname is the name of one of the real time subsystem host



Changing subsystem attributes

Issue 2.0 July 2005 241

● port is the same port number you used for the OA hosts

You need to run this query for each Real-time host. For example, if you have two 
Real-time hosts, called firstRT and otherRT, and you want to change the port 
number to 5000, you will need to run these two queries:

update dcProperty

set value = 'corbaname::firstRT:5000#CRM_BI.root/real.pkg/
RTDSSDSGatewayV1.obj'

update dcProperty

set value = 'corbaname::otherRT:5000#CRM_BI.root/real.pkg/
RTDSSDSGatewayV1.obj'

8. On Windows only:

a. Select Start > Programs > Administrative Tools > Services. 

b. Start the Avaya Business Intelligence service, the ORBacus Naming Service, and 
the Stumbras-Tomcat service.

9. On Solaris and AIX:

a. In the file $PABASE/bin/nameserv.sh, update the line -Oaport port where 
port is the port number you want to use.

b. Make a backup copy of the /etc/inittab file. Use the command:

cp /etc/inittab /etc/inittab.orig

! CAUTION:
CAUTION: Be very careful when editing the /etc/inittab file. Errors can cause the 

system to stop working.

c. Open /etc/inittab and change the following lines from:

in:234:respawn:/opt/BI/bin/initsrv.sh

nm:234:respawn:/opt/BI/bin/nameserv.sh

to:

in:234:off:/opt/BI/bin/initsrv.sh

nm:234:off:/opt/BI/bin/nameserv.sh

d. Enter:

init q

This turns these daemons off. To turn them on, change the same lines back to 
respawn and enter the init q command again.

10. In a command prompt window, enter:

pa start all
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To change the naming service port number on a Windows platform where the 
EC Server is installed:

1. Access the IC Manager tool.

2. Select the Configuration tab.

3. Add a new name/value pair for NSPort=port where port is the same port number 
you used for the OA hosts. This is done by clicking on the ->= (New) icon in the 
configuration tab dialog.

To change the naming service port number on a Solaris platform running 
CMS:

1. Log in as root.

2. In a terminal window, enter:

. /opt/BI/.profile

pa stop all

3. In the file $PABASE/data/admin/server.properties, add the line 
NSPort=port where port is the port number you want to use.

4. In the file $PABASE/bin/nameserv.sh, update the line -Oaport port where port 
is the port number you want to use.

5. Make a backup copy of the /etc/inittab file. Use the command:

cp /etc/inittab /etc/inittab.orig

! CAUTION:
CAUTION: Be very careful when editing the /etc/inittab file. Errors can cause the 

system to stop working.

6. Open /etc/inittab and change the following lines from:

in:234:respawn:/opt/BI/bin/initsrv.sh

nm:234:respawn:/opt/BI/bin/nameserv.sh

to:

in:234:off:/opt/BI/bin/initsrv.sh

nm:234:off:/opt/BI/bin/nameserv.sh

7. Enter:

init q

This turns these daemons off. To turn them on, change the same lines back to respawn 
and enter the init q command again.

8. Enter:

pa start all
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Removing Avaya OA components 
You can remove individual components or all of the OA software. When a source 
subsystem is deleted, it is not removed from the database. The associated data is not 
purged from the database, which allows reports to continue to access the data collected 
from a source prior to its deletion.

! CAUTION:
CAUTION: Before removing any components, Avaya strongly recommends that you do 

a backup of the database and file systems.

This section includes the following topics:

● Considerations when removing OA components on page 243

● Removing Avaya OA components on Windows on page 243

● Removing Avaya OA software on Solaris on page 250

● Removing Avaya OA software on AIX on page 259

Considerations when removing OA components
When removing OA components, consider the following:

● If you remove the Real-time subsystem from a server, the supporting TimesTen software 
is not removed. If there is no need to keep the software on that server, you should 
manually remove the TimesTen software.

Removing Avaya OA components on Windows
To remove OA components on Windows:

1. Stop all OA processes. See Stopping or starting processes and services before making 
changes on page 151.

2. Log in as a user with administration privileges.

3. If Terminal Services is enabled, enter change user /install in a command 
prompt window.

4. Select Start > Settings > Control Panel.
The Control Panel dialog box is displayed.
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5. Double-click Add or Remove Programs.

The Add or Remove Programs dialog box is displayed.

6. Under Avaya Operational Analyst, select Change/Remove.

After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box. If errors appear on this dialog box, the uninstall process has 
failed and you must remove the software manually. Contact support for help.

! Important:! Important:
Important: You can stop the removal at any time by clicking Cancel before you start the 

actual removal of files (see Step 10). If you click Cancel, you will be asked 
to confirm your intention to cancel. If you cancel, the removal is terminated 
and the system is restored to its previous state.

7. Click Next.
The Feature Selection dialog box is displayed. Components that are currently 
installed are shown with check marks. Components that are not installed are greyed 
out (hidden).

! CAUTION:
CAUTION: Any component that is selected will be removed. If you want to remove only 

some components, make sure that the components you want to keep are 
not checked. Do not select or clear the main Product Uninstallation or 
Install Supporting Applications check boxes; the software will 
automatically set these options depending on what components are being 
removed.
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8. Leave checks in the components you want to remove, and clear the check marks for 
the components you want to keep.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.

The following example shows that you are removing the Reporting subsystem and the 
Data API Utility.
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9. Click Next.
A confirmation dialog box is displayed.

! CAUTION:
CAUTION: Do not close the dialog box after you have clicked Next in the following step. 

If you close the dialog box after the removal has started, the removal will be 
disrupted and you must contact Avaya support to do a manual cleanup of 
the removal.

10. Click Next.
The uninstall process begins. If you receive any messages, take note of the messages 
and click Next to continue. When the uninstall is complete, which will take several 
minutes, the Uninstall Complete dialog box is displayed.

! CAUTION:
CAUTION: If you get any failure messages saying that the uninstall could not be 

completed, do not attempt to do another uninstall. Escalate the problem 
through normal channels.

11. When the uninstall process completes, which will take several minutes, the uninstall 
complete dialog box is displayed.

12. Click Next.
The Restart System dialog box is displayed.
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13. Select the option to restart your system now and click Next.

! Important:! Important:
Important: You must always restart a Windows server at this time for OA to operate 

properly. If you are not requested to restart the server, you must manually 
restart the server.

14. Do one of the following:

● If you removed all components from this server, you are finished.

● If you did not remove all components from this server, continue with Step 15. 

15. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Windows servers on page 96 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

16. Open a command prompt window.

17. In the command prompt window, enter the following command to show what processes 
are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

18. If you get the message mom is not active, enter:

pa start all

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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19. Repeat Step 4 to verify that OA has started.

20. Enter:

oalist

A message similar to the following is displayed listing what components are installed 
on this server:

21. Select Start > Programs > Administrative Tools > Services. 

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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22. Validate that the following services are started and are set to start automatically. If they 
are not administered to start automatically, administer them as such.

● If the Historical subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

● If the Real-time subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- TimesTen Data Manager 5.0

● If the Report subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- Stumbras-Tomcat

● If the Source-EC (Event Collector) subsystem is installed, check for the following:

- ORBacus Naming Service

23. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.
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Removing Avaya OA software on Solaris
To remove OA software on Solaris:

1. Stop all OA processes. See Stopping or starting processes and services before making 
changes on page 151.

2. Log in as root.

3. Move to the home directory of the OA User ID used when OA was installed. For 
example, if you used the biadmin user ID when OA was installed and you originally 
installed OA in the default location, enter the following commands:

. /opt/BI/.profile

cd /export/home/biadmin

4. Enter:

ls _uninst*

This lists the files in the uninstall directory.

Note:
Note: There may be more than one uninstall directory. If there is, you will see 

something similar to the following:

5. Enter:

cd _uninstX

where X is the highest numbered uninstall directory, if there is more than one directory. 

_uninst

_uninst2

_uninst3
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6. Enter one of the following commands, depending on which one you find in the 
directory:

./OARemove.bin

or

./AOARemove.bin

After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box. If errors appear on this dialog box, the uninstall process has 
failed and you must remove the software manually. Contact support for help.

! Important:! Important:
Important: You can stop the removal at any time by clicking Cancel before you start the 

actual removal of files (see Step 10). If you click Cancel, you will be asked 
to confirm your intention to cancel. If you cancel, the removal is terminated 
and the system is restored to its previous state.

7. Click Next.
The Feature Selection dialog box is displayed. Components that are currently 
installed are shown with check marks. Components that are not installed are greyed 
out (hidden).
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! CAUTION:
CAUTION: Any component that is selected will be removed. If you want to remove only 

some components, make sure that the components you want to keep are 
not checked. Do not select or clear the main Product Uninstallation or 
Install Supporting Applications check boxes; the software will 
automatically set these options depending on what components are being 
removed.

8. Leave checks in the components you want to remove, and clear the check marks for 
the components you want to keep.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.

The following example shows that you are removing the Historical subsystem and the 
Real Time subsystem.



Removing Avaya OA components

Issue 2.0 July 2005 253

9. Click Next.
A confirmation dialog box is displayed.

! CAUTION:
CAUTION: Do not close the dialog box after you have clicked Next in the following step. 

If you close the dialog box after the removal has started, the removal will be 
disrupted and you must contact Avaya support to do a manual cleanup of 
the removal.

10. Click Next.
The install process begins. If you receive any messages, take note of the messages 
and click Next to continue. When the uninstall is complete, which will take several 
minutes, the Uninstall Complete dialog box is displayed.

! CAUTION:
CAUTION: If you get any failure messages saying that the uninstall could not be 

completed, do not attempt to do another uninstall. Escalate the problem 
through normal channels.

11. Click Next.
The uninstall has been completed.

12. Do one of the following:

● If you removed all components from this server, you are finished.

● If you did not remove all components from this server, continue with Step 13. 

13. Log out of the desktop environment.
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14. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Solaris servers on page 99 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

15. Enter:

. /opt/BI/.profile

16. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

17. If you get the message mom is not active, enter:

pa start all

18. Repeat Step 4 to verify that OA has started.

19. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.



Removing Avaya OA components

Issue 2.0 July 2005 255

20. Enter:

oalist

A message similar to the following is displayed:

21. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv
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b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

22. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root   233     1  0   Dec 23 ?        0:01 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend
    root   234   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 0
    root   235   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 1
    root   236   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 2
    root   237   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 3
 biadmin   244   182  0 10:34:22 pts/11   0:00 grep timesten
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23. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

24. If the Report subsystem is installed, enter the following commands to start Stumbras:

cd $SUN_WEB_HOME/https-stumbras

./start

The following message is displayed.

25. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

The OA environment will be set.
.
.
.

Startup: server started successfully

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if Stumbras-Tomcat is running:

ps -ef | grep https-stumbras

A message similar to the following should be displayed.

● For Sun Java System Web Server 6.0:

● For Sun Java System Web Server 6.1:

 biadmin  6141     1  0   Dec 31 ?        0:00 ./uxwdog -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6143  6142  0   Dec 31 ?        1:01 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6142  6141  0   Dec 31 ?        0:03 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin   254   182  0 10:38:51 pts/11   0:00 grep https-stumbras

 biadmin 28604 28603  0 16:38:23 ?        1:58 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 28602     1  0 16:38:22 ?        0:00 ./webservd-wdog -r /opt/SUNWwbsvr
 -d //opt/SUNWwbsvr/https-stumbras/config -n h
 biadmin 28603 28602  0 16:38:22 ?        0:01 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 29266 29259  0 18:55:22 pts/22   0:00 grep https-stumbras
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Removing Avaya OA software on AIX
To remove OA software on AIX:

! CAUTION:
CAUTION: If you are removing the Report subsystem, WebSphere must be running, so 

do not stop WebSphere.

1. Stop all OA processes. See Stopping or starting processes and services before making 
changes on page 151.

2. Log in as root.

3. To set the monitor display, enter:

export DISPLAY=hostname:0.0

where hostname is the name of the server.

4. Move to the home directory of the OA User ID used when OA was installed. For 
example, if you used the biadmin user ID when OA was installed and you originally 
installed OA in the default location, enter the following commands:

. /opt/BI/.profile

cd /home/biadmin/_uninst

5. Enter:

./OARemove.bin

After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box. If errors appear on this dialog box, the uninstall process has 
failed and you must remove the software manually. Contact support for help.

! Important:! Important:
Important: You can stop the removal at any time by clicking Cancel before you start the 

actual removal of files (see Step 10). If you click Cancel, you will be asked 
to confirm your intention to cancel. If you cancel, the removal is terminated 
and the system is restored to its previous state.
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6. Click Next.
The Feature Selection dialog box is displayed. Components that are currently 
installed are shown with check marks. Components that are not installed are greyed 
out (hidden).

! CAUTION:
CAUTION: Any component that is selected will be removed. If you want to remove only 

some components, make sure that the components you want to keep are 
not checked. Do not select or clear the main Product Uninstallation or 
Install Supporting Applications check boxes; the software will 
automatically set these options depending on what components are being 
removed.

7. Leave checks in the components you want to remove, and clear the check marks for 
the components you want to keep.

! Important:! Important:
Important: After selecting or clearing a check box, there may be a delay before the 

dialog box refreshes and you see the check mark or the check mark is 
cleared. This may take a few seconds. Do not select or clear another check 
box until the dialog box refreshes and you can see that the check box has 
been selected or cleared.
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8. Click Next.
If the Report subsystem is being removed and WebSphere is not running, a warning 
dialog box is displayed noting that WebSphere must be running. In another command 
prompt window, start WebSphere by entering the following commands:

. /opt/BI/.profile

pa stop all

startWebSphere -u userID -p userpassword

where userID is the user ID administered for Global Security on WebSphere and 
userpassword is the password for that user ID. If a Global Security user ID has not 
been administered, do not use the user and password options.

9. Return to the installation warning and click OK.

A confirmation dialog box is displayed.

! CAUTION:
CAUTION: Do not close the dialog box after you have clicked Next in the following step. 

If you close the dialog box after the removal has started, the removal will be 
disrupted and you must contact Avaya support to do a manual cleanup of 
the removal.
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10. Click Next.
The uninstall process begins. If you receive any messages, take note of the messages 
and click Next to continue. When the uninstall is complete, which will take several 
minutes, the Uninstall Complete dialog box is displayed.

! CAUTION:
CAUTION: If you get any failure messages saying that the uninstall could not be 

completed, do not attempt to do another uninstall. Escalate the problem 
through normal channels.

11. Click Next.
The uninstall has been completed.

12. Do one of the following:

● If you removed all components from this server, you are finished.

● If you did not remove all components from this server, continue with Step 13. 

13. Log out of the desktop environment.

14. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
AIX servers on page 105 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

15. Enter:

. /opt/BI/.profile
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16. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

17. If OA is not running (mom is not active), enter:

pa start all

18. Repeat Step 4 to verify that OA has started.

19. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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20. Enter:

oalist

A message similar to the following is displayed:

21. If the Historical subsystem is still installed (not removed), use the following commands 
and responses to verify that the required services are running. If the services are not 
running, escalate the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv
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b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

22. If the Real-time subsystem is still installed (not removed), use the following commands 
and responses to verify that the required services are running. If the services are not 
running, escalate the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 biadmin 20858 48090   0 13:01:34  pts/0  0:00 grep timesten
    root 31910 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 2 -facility user
    root 32664 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 1 -facility user
    root 36302 36980   0   Apr 16      -  3:35 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 3 -facility user
    root 36980  6302   0   Apr 16      -  0:42 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend -fg
    root 40150 36980   0   Apr 16      -  0:18 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 0 -facility user
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23. If the Source-EC subsystem is still installed (not removed), use the following 
commands and responses to verify that the required services are running. If the 
services are not running, escalate the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

24. If the Report subsystem is still installed (not removed), enter the following commands 
to stop and restart the WebSphere software:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT -u 
userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

25. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX
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a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if WebSphere is running:

ps -ef | grep WebSphere

A message similar to the following should be displayed.

26. To verify that OA reports are running using the WebSphere Administrative Console:

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 biadmin 28514     1   0   Jun 03      -  4:39 /usr/IBM/WebSphere/AppServer/java/
bin/java -Xbootclasspath/p:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/
ibmorb.jar:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/ibmext.jar 
-Dwas.status.socket=53964 -classpath /usr/IBM/WebSphere/AppServer/profiles/
default/properties:/usr/IBM/WebSphere/AppServer/properties:/usr/IBM/WebSphere/
AppServer/lib/bootstrap.jar:/usr/IBM/WebSphere/AppServer/lib/j2ee.jar:/usr/IBM/
WebSphere/AppServer/lib/lmproxy.jar:/usr/IBM/WebSphere/AppServer/lib/
urlprotocols.jar:/usr/opt/db2_08_01/java/db2jcc.jar:/usr/opt/db2_08_01/java/
db2jcc_license_cu.jar:/usr/opt/db2_08_01/java/db2jcc_license_cisuz.jar -Xms50m 
-Xmx512m -Dws.ext.dirs=/usr/IBM/WebSphere/AppServer/java/lib:/usr/IBM/WebSphere/
AppServer/profiles/default/classes:/usr/IBM/WebSphere/AppServer/classes:/usr/
IBM/WebSphere/AppServer/lib:/usr/IBM/WebSphere/AppServer/installedChannels:/usr/
IBM/WebSphere/AppServer/lib/ext:/usr/IBM/WebSphere/AppServer/web/help:/usr/IBM/
WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.ejbdeploy/runtime 
-Dcom.ibm.itp.location=/usr/IBM/WebSphere/AppServer/bin 
-Djava.util.logging.configureByServer=true -Dibm.websphere.preload.classes=true 
-Duser.install.root=/usr/IBM/WebSphere/AppServer/profiles/default 
-Dwas.install.root=/usr/IBM/WebSphere/AppServer 
-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager 
-Ddb2j.system.home=/usr/IBM/WebSphere/AppServer/cloudscape -Dserver.root=/usr/
IBM/WebSphere/AppServer/profiles/default -Djava.awt.headless=true 
-Djava.security.auth.login.config=/usr/IBM/WebSphere/AppServer/profiles/default/
properties/wsjaas.conf -Djava.security.policy=/usr/IBM/WebSphere/AppServer/
profiles/default/properties/server.policy com.ibm.ws.bootstrap.WSLauncher 
com.ibm.ws.runtime.WsServer /usr/IBM/WebSphere/AppServer/profiles/default/config 
groverNode01Cell groverNode01 server1
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a. In a browser window, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the server 
where the Report subsystem is installed and port_number is the port number 
assigned to the WebSphere Administrative Console (for example, 9060).

b. Log in to the WebSphere Administration Console using the Global Security user ID 
and password (if assigned). Otherwise, enter any user ID.

c. Select Applications > Enterprise Applications.

d. Verify that there is a green arrow next to OAReports. If there is a red X, select the 
check box to the left of OAReports and select Start. This should change the status 
to a green arrow. If not, escalate the problem using the normal channels.
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Upgrading Avaya OA software

You can upgrade your Avaya OA software with a new version of software. However, you 
cannot add new subsystems while you are doing the upgrade. You must upgrade to the 
new version of OA software and then add the subsystems using the instructions found in 
Adding Avaya OA components on page 155.

! Important:! Important:
Important: You can upgrade to OA 7.0 from OA 6.1.3 or later only. 

If you want to upgrade from versions of OA prior to 6.1.3, you must first upgrade 
to 6.1.2, migrate your data to 6.1.2 schema, and then upgrade to 6.1.3. See 
Avaya Interaction Center and Operational Analyst Release 6.1.2 Software 
Upgrade and Data Migration for detailed instructions on first upgrading to 
OA 6.1.2.

To upgrade from OA 6.1.2 to OA 6.1.3, see "Upgrading Avaya OA software" in 
Avaya Operational Analyst Release 6.1.3 Installation and Configuration.

This section includes the following topics:

● Preparation checklist on page 270

● License key considerations on page 272

● Database upgrade considerations on page 272

● Upgrading Avaya OA software on page 275



Upgrading Avaya OA software

270 Operational Analyst 7.0 Installation and Configuration

Preparation checklist
Before you upgrade your OA installation, follow these important steps and 
recommendations.

Procedure

Have the original installation media available for use during the process.

Before an upgrade, the database administrator must verify that there are no open 
TTIsql sessions with the TimesTen application.

Before performing any OA upgrade, Avaya strongly recommends that you perform 
a backup of the database and file systems.

Predefined Advanced reports included with OA are overwritten when OA is 
updated. If your OA installation includes predefined Advanced reports that have 
been modified, those reports will be lost during the OA upgrade unless you protect 
them. 
Follow these steps to protect your modified Advanced reports:
● Rename the reports or move them to a folder not affected by OA upgrades.
● Upgrade to OA 7.0.
● If you renamed the reports, rename them to their original names OR if you 

moved the reports, move them back to their original location

For a configuration that includes Avaya IC, verify that the Avaya IC components 
have been installed, configured, and are started before you upgrade, configure, 
and start the OA components. For more information about Avaya IC planning and 
installation, see:
● Avaya Interaction Center Release 7.0 Installation Planning and Prerequisites
● Avaya Interaction Center Release 7.0 Installation and Configuration

Verify that there is a minimum of 512 MB of free temporary space on the c: drive 
for Windows, in /var/tmp for Solaris, and /tmp for AIX. If this space is not 
available, the installer may not run successfully.

If installing the OA Source-EC and Source-EC Bridge subsystems on an Avaya IC 
server, verify that there is at least 100 MB of free disk space for the installation 
files.

Before you upgrade OA, turn off all virus scan software. 

! SECURITY ALERT:
SECURITY ALERT: Temporarily turning off your virus scan software opens a potential 

risk for a virus attack. However, this risk should be low since the 
server is probably not being used at the same time when OA is 
being upgraded. After you complete the upgrade, remember to turn 
on the virus scan software.
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Consider the following while you are upgrading the OA components:

● Avaya recommends that you write down all user IDs and database names used when 
upgrading components as you will need them during configuration and when you make 
future changes. After installation, most of this information can be found using the 
oalist command.

● After upgrading the Administration client, you may want to customize the Administration 
client installation. See Customizing the Administration client on page 118.

● The dialog boxes that are displayed when upgrading depends on what components are 
being installed.

● After doing an upgrade of the Report subsystem, you must go to each Report client 
machine, uninstall the Report client, install JRE version 1.4.2_08 if it is not already 
installed, and reinstall the Report client. See Installing and testing the Report client on 
page 102 for more information.

Verify that no OA files are open.

Verify that all OA Administration client users have logged off and closed their 
browser windows before you upgrade the OA software.

Determine whether the naming service port number has been assigned to a value 
other than the default of 10000. If it has been changed, the upgrade will change it 
back to the default of 10000. After the upgrade, you will have to change it back to 
its original value. See Changing the naming service port number on page 239 for 
more information.

Procedure
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License key considerations
When adding Avaya IC as a data source to a configuration that only received CMS data, 
you must upgrade to an Avaya IC and Avaya CMS Analytical license. To do this, you must 
upgrade the OA software with the new license key using the procedures in this section, 
making sure to select Avaya IC as a data source.

Database upgrade considerations
With OA 7.0, only V8.1 and V8.2 of the DB2 database software are supported. If you are 
planning to upgrade to that new version of database software at the same time that you are 
upgrading to OA 7.0, consider the following upgrade scenarios:

● If you upgrade the DB2 software from V7.2 to V8.1 after you have upgraded OA to 7.0, 
you must reinstall (repair) the OA 7.0 Historical subsystem (see Repairing Avaya OA 
components on page 193). During the repair of the Historical subsystem, sets of DB2 
V8.1 libraries are installed and the db.properties file will be updated to match DB2 
V8.1. Avaya recommends using this order when upgrading DB2.

● If you upgrade the DB2 software from V7.2 to V8.1 before you upgrade OA to 7.0, the 
old version of OA 6.1.3 will continue work, but you should quickly upgrade OA to 7.0. 
After the OA upgrade, OA should work properly with DB2 V8.1. Avaya does not 
recommend using this order when upgrading DB2.
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Upgrading WebSphere
OA 7.0 supports only WebSphere 6.0. The following steps outline the recommended 
method of upgrading to WebSphere 6.0 from WebSphere 5.0.1.

Note:
Note: If your OA installation includes customized Basic reports, perform steps 1-7. 

If your OA installation does not include customized Basic reports, perform 
only steps 2-6.

1. If you have customized Basic reports, save a copy of the report files/directories into the 
/tmp directory. In general these files are found in:

● /usr/WebSphere/AppServer/installedApps/hostname/OAReports.ear/stumbras.war/
reports1/jsp/custom

● /usr/WebSphere/AppServer/installedApps/hostname/OAReports.ear/stumbras.war/
WEB-INF/classes

● /usr/WebSphere/AppServer/installedApps/hostname/OAReports.ear/stumbras.war/
WEB-INF/lib

2. Uninstall OA 6.1.3 Reports:

a. From the OA Administration Client, remove the Reporting Subsystem

b. From the command line execute: 

i. pa stop all

ii. cd /home/biadmin/_uninst

iii. java -cp $PABASE/jars/server.jar:uninstall.jar run

c. Select reports ONLY and allow uninstall to complete

3. Uninstall WebSphere 5.0:

a. cd $WEBSPHERE_HOME/bin (default is /usr/WebSphere/AppServer/bin)

b. Stop the WebSphere server in which OA Reports is deployed, for example:

stopServer.sh <servername>

where <servername> is the name of the server in which OA Reports is deployed 
(default is server1)

c. cd $WEBSPHERE_HOME/_uninst (default is /usr/WebSphere/AppServer/_uninst)
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d. Execute ./uninstall 

During the uninstall process, you may see a pop-up similar to:

If so, select OK.

e. cd to the root directory in which WebSphere is installed (default is /usr)

f. Execute: rm -r WebSphere 

g. Execute: rm -r IBMHttpServer 

4. Install WebSphere 6.0 using the WebSphere installation instructions the "Installing and 
configuring WepShere Application Server on an AIX machine" section of OA 7.0 
Installation Planning and Prerequisites.

Note:
Note: Avaya recommends that you install WebSphere in the /usr/IBM/WebSphere 

directory and HTTP Server in the /usr/IBMHttpServer directory.

5. Upgrade OA by running the ./AixSetup installation script.

6. Install OA Reports as described in Installing Avaya OA components on an AIX 
platform on page 70.

7. If you have customized Basic reports, restore saved files from /tmp to their new 
location under $WEBSPHERE_HOME/profiles/default/installedApps/
hostnameNode01Cell/OAReports.ear/stumbras.war
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Upgrading Avaya OA software
This section includes the following topics:

● Order of server upgrades on page 275

● Stopping processes before beginning an upgrade on page 276

● Upgrading Avaya OA software on page 279

● Completing an upgrade for Avaya OA on page 289

● Recovering from a failed upgrade on page 307

Order of server upgrades
The order in which you upgrade the OA subsystems on your servers is very important. For 
example, if you have the following configuration:

● Main site - server with the Historical subsystem, Report subsystem, Administration 
client, and Real-time subsystem

● Remote site #1 - server with the Real-time subsystem and Report subsystem

● Remote site #2 - server with the Real-time subsystem, Report subsystem, and 
Administration client

With this configuration, you should upgrade sites #1 and #2 first, saving the main site for 
last where the Historical subsystem resides. As a general rule, always upgrade the server 
that has the Historical subsystem last.

However, if you expand this example to include:

● Remote site #3 - server with CMS-source

Remote site #3 should be upgraded last (after the main site) because the Historical 
subsystem must be running when the CMS source is upgraded to assure the forwarders 
are updated properly.

! Important:! Important:
Important: The Historical subsystem (and especially the administration manager on 

that subsystem) must be running when you upgrade the CMS-source. If the 
Historical subsystem is not running, the forwarders will not upgrade correctly 
and will fail to operate properly.
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Stopping processes before beginning an upgrade
Before you upgrade software on an OA server, you must stop certain processes on the 
server. This is required when you currently have the Historical subsystem, Real-time 
subsystem, Report subsystem (basic), Source-CMS data collection software, or 
Source-EC (Event Collector) data collection software on the server.

Determining which components are installed on your server

Before you stop processes or traffic for data collection, use the oalist command to 
display the components currently installed on your server.

To use the oalist command:

1. Enter the following commands:

. /opt/BI/.profile (Solaris and AIX only)

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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Determine when to stop processes

When upgrading OA subsystems, you should stop processes on servers just before you 
plan on upgrading the software. In other words, do not stop the processes for a server 
upgrade until the last possible moment.

In general, you should save the upgrade of the Historical subsystem until last, doing 
subsystems on other servers first.

See Order of server upgrades on page 275 for more information.

Stopping processes and services on a Windows server

Based on the subsystems that are installed, use the following table to determine which 
procedures should be done to stop processes and services:

Subsystems Procedure

Historical
Real-time

1. Log in as an administrative user.
2. In a command prompt window, enter pa stop all.
3. Select Start > Programs > Administrative Tools > Services. 
4. Stop the Avaya Business Intelligence and ORBacus Naming 

services.

Report 1. Log in as an administrative user.
2. In a command prompt window, enter pa stop all.
3. Select Start > Programs > Administrative Tools > Services. 
4. Stop the Avaya Business Intelligence, ORBacus Naming, and 

Stumbras-Tomcat services.

Source-EC
Source-EC Bridge

1. Log in as an administrative user.
2. From IC Manager, stop the Source-EC subsystems.
3. Select Start > Programs > Administrative Tools > Services. 
4. Stop the ORBacus Naming service.

Data API Utility 1. Log in as an administrative user.
2. In a command prompt window, enter pa stop all.
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Stopping processes on a Solaris server

Based on the subsystems that are installed, use the following table to determine which 
procedures should be done to stop processes and services:

Stopping or starting processes on an AIX server

Based on the subsystems that are installed, use the following table to determine which 
procedures should be done to stop processes and services:

Subsystems Procedure

Historical
Real-time
Source-CMS
Data API Utility

1. Log in using an OA user ID and password.
2. Enter the following commands:
. /opt/BI/.profile

pa stop all

Report 1. Log in using an OA user ID and password.
2. Enter the following commands:
. /opt/BI/.profile

pa stop all

cd $SUN_WEB_HOME/https-stumbras

./stop

Source-EC From IC Manager, stop the Source-EC subsystems.

Subsystems Procedure

Historical
Report
Real-time
Data API Utility

1. Log in using an OA user ID and password.
2. Enter the following commands:
. /opt/BI/.profile

pa stop all

Source-EC From IC Manager, stop the Source-EC subsystems.
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Upgrading Avaya OA software

Note:
Note: The procedures for upgrading Avaya OA software is almost identical for all 

operating systems. For this procedure, the Windows dialog boxes are 
shown and any differences for the other operating systems are described.

To start the OA upgrade process:

1. Do one of the following to access and start the installation executable:
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! CAUTION:
CAUTION: Install from a CD-ROM drive that is local to the server where you are 

installing OA. Installing from a networked CD drive is not supported.

Operating 
System

Procedure

Windows 1. Log in with a user ID that has administration privileges.
2. If Windows Terminal Services is installed in Application mode, open a 

command prompt window and enter:
change user /install

! CAUTION:
CAUTION: If Windows Terminal Services was installed in Administration 

mode, you cannot properly install any OA subsystem on that 
machine. See Operating systems on page 48 in Avaya 
Operational Analyst Release 7.0 Installation Planning and 
Prerequisites.

3. Place the OA CD-ROM in the drive.
4. Using Windows Explorer, navigate to the CD-ROM drive and 

double-click the WinSetup.exe file.
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Solaris 1. Log in as root.
2. Place the OA CD-ROM in the drive and wait about 15 seconds. A file 

manager window is displayed showing the contents of the CD-ROM.

Note:
Note: If the File Manager window does not open, enter the 

following commands to start the volume manager:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

3. From a terminal window, enter the following commands:
. /opt/BI/.profile

cd /cdrom/cdrom0

./SolSetup

AIX 1. Log in as root.
2. To set the monitor display, enter:
export DISPLAY=hostname:0.0

where hostname is the name of the server.

3. If you are adding the Historical subsystem, enter the following 
commands to set the DB2 environment:
- As the instance owner, or any member of DB2 SYSADM group:
export EXTSHM=ON

db2set DB2ENVLIST=EXTSHM

db2stop

db2start

- As the user launching the OA Installation (root):
# export EXTSHM=ON

# ./AixSetup

4. Place the OA CD-ROM in the drive and wait about 15 seconds.
5. From the terminal window, enter the following commands:
. /opt/BI/.profile

mkdir /cdrom (if this directory does not already exist)

mount -v cdrfs -r /dev/cd0 /cdrom

cd /cdrom

./AixSetup

Operating 
System

Procedure
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After several seconds, the Initializing wizard window is displayed, followed by the 
Welcome dialog box.

! Important:! Important:
Important: You can stop the installation at any time by clicking Cancel before you start 

the actual installation of files (see Step 29). If you click Cancel, you will be 
asked to confirm your intention to cancel. If you cancel, the installation is 
terminated and the system is restored to its previous state.

2. Click Next.
The License Key dialog box is displayed.

3. Enter the provided license key for the components purchased.

4. Click Next.
The License Agreement dialog box is displayed.

5. Select I accept the terms in the license agreement.
6. Click Next. 

The User Information dialog box is displayed.

Note:
Note: The Domain field is only displayed for Windows systems.

7. Enter and confirm the password for the installed user ID.
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8. Click Next.
One of the following occurs:

● If you are upgrading a Windows or Solaris server, continue with Step 10.

● On AIX only, if the Report subsystem is being upgraded and WebSphere is not 
running, a warning dialog box is displayed noting that WebSphere must be running. 
In another command prompt window, start WebSphere by entering the following 
commands:

. /opt/BI/.profile

pa stop all

startWebSphere -u userID -p userpassword

where userID is the user ID administered for Global Security on WebSphere and 
userpassword is the password for that user ID. If a Global Security user ID has 
not been administered, do not use the user and password options.

9. Return to the installation warning and click OK. 

10. One of the following occurs:

● If you are upgrading the Report subsystem on an AIX system, and the Report 
subsystem was previously installed using a non-default WebSphere Administrative 
Console user ID, the Reports Configuration dialog box is displayed showing the 
current WebSphere Admin Console User ID. The user ID password must be 
entered and confirmed. Continue with Step 15.

● If the system being upgraded is Windows and has the Historical subsystem, Report 
subsystem, or Real-time subsystem, continue with Step 12.

● If the system being upgraded is Solaris or AIX and has the Historical subsystem or 
Real-time subsystem, the Reports Configuration dialog box is displayed, but you 
cannot change anything. Continue with Step 14.

● If the system being upgraded does not have the Historical subsystem or the Report 
subsystem, the process continues with Step 18.

11. Click Next.
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12. The ADS Configuration dialog box is displayed:

13. Administer the dialog as shown in the following table:

Field Description

ADS Version Enter the LDAP version being used on the authentication server. 
OA supports versions 2 and 3, with the default set to 3.

ADS Port Enter the port number used for ADS. OA defaults to 389, which is 
the default when ADS is installed.

OA Administration 
Group Distinguished 
Name (DN)

Enter the DN for the administration group. For typical example of 
ADS setup, if you use the default group named oaadmin, a 
domain named oalab, and the company name is Telco, you 
would enter:
CN=oaadmin,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oaadmin
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14. Click Next.
15. The Historical Server Configuration dialog box is displayed. 

Note:
Note: The fields that appear on the Historical Server Configuration dialog box 

may vary depending on your component selections.

16. Do the following:

● If you need to add a new data collection source, select that source, either IC or 
CMS.

● If you are just upgrading an existing data collection source, do not select a new 
source.

OA Report Group 
Distinguished Name 
(DN)

Enter the DN for the report group. For typical example of ADS 
setup, if you use the default group named oarpt, a domain 
named oalab, and the company name is Telco, you would enter:
CN=oarpt,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oarpt

OA Report Writer 
Group Distinguished 
Name (DN)

Enter the DN for the report writer group. For typical example of 
ADS setup, if you use the default group named oawriter, a 
domain named oalab, and the company name is Telco, you 
would enter:
CN=oawriter,CN=Users,DC=oalab,DC=telco,DC=com
If you are not using ADS, use the following format for the DN:
localhost\oawriter

Field Description
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● Complete the Alarm Services options as needed. The server name must be the 
server where the Source-EC subsystem is installed. This information may already 
be displayed, but can be changed if needed.

17. Click Next.
One of the following occurs:

● If you are upgrading the Source-CMS subsystem on a Solaris server, the CMS User 
ID dialog box is displayed and you must enter and confirm the password for the 
Informix user ID. Continue with Step 27.

● If you are upgrading the Historical subsystem, continue with Step 18.

18. The Database Configuration dialog box is displayed.

19. Enter and confirm the administrator password.

20. Click Next.
A warning message may be displayed.

21. Click OK to acknowledge the warning, if displayed.
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Note:
Note: There may be a long delay before the next dialog box is displayed. 

The following dialog box is displayed when using Microsoft SQL Server. If you are not 
using Microsoft SQL, continue with Step 25.

22. Select Use Existing DB if you want to use an existing database.

23. If you choose to not use the existing database, enter the size and location of the 
Microsoft SQL Server Transaction Log. You can use the default locations if you want.

24. Click Next.
25. One of the following occurs:

● If the system does not have a Real-time subsystem, continue with Step 27.
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● If you are upgrading a system that has a Real-time subsystem, the Real-time 
Configuration dialog box is displayed.

26. Click Next (no options can be changed).

27. The Installation Preview dialog box is displayed listing the components you have 
selected.

28. Scroll through the preview dialog box to verify the selected components and 
configuration data.

! CAUTION:
CAUTION: Do not close the Progress dialog box after you have clicked Next in the 

following step. If you close the Progress dialog box after the installation has 
started, the installation will be disrupted and you must contact Avaya 
support to do a manual cleanup of the installation.

29. Click Next to start the installation.

The Progress dialog box is displayed showing the progress of the installation, which 
will take several minutes. Near the end of the installation, the dialog box will go blank 
for some time.

When the upgrade is finished, the Install Complete dialog box is displayed.

30. Click Next.
● On Solaris and AIX, the Install Complete dialog closes and the upgrade is finished.

● On Windows, the Restart System dialog box is displayed.

Before you reboot the server, make sure that a copy of the server.properties 
file is saved in case it is deleted during the reboot. Do the following:

i. Open Windows Explorer.
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ii. Navigate to %PABASE%\BI\data\admin.

iii. Copy the server.properties file onto the Windows clipboard.

iv. Go to your Windows desktop (or some other location other than the OA 
installation directory) and paste the server.properties file there.

! Important:! Important:
Important: You must always restart a Windows server at this time for OA to operate 

properly. If you are not requested to restart the server, you must manually 
restart the server.

v. Go back to the Restart System dialog box, select the option to restart your 
system now, and click Next.

vi. After the system reboots, navigate to %PABASE%\BI\data\admin.

vii. Verify that the server.properties file is in the folder.

viii. If the file is not in the folder, go to the location where you saved a copy of 
server.properties and copy the file onto the Windows clipboard.

ix. Navigate to %PABASE%\BI\data\admin.

x. Paste the server.properties file into the folder.

31. Do one of the following:

● On Windows, press the eject button on the CD-ROM drive, remove the CD-ROM, 
and store it in a safe location.

● On Solaris, close all but one terminal window and enter:

cd /

eject cdrom

● On AIX, close all but one terminal window and enter:

cd /

umount /cdrom

32. Press the eject button on the CD-ROM drive (AIX only), remove the OA CD-ROM, and 
store it in a safe location.

33. If you upgraded the Report subsystem, uninstall and reinstall the Report client support 
files (see Installing and testing the Report client on page 102).

Completing an upgrade for Avaya OA
Depending on the platform you are using, use the procedures in the following sections to 
complete your upgrade:

● Updating the naming service port number on page 290
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● Completing an upgrade to a Windows system on page 290

● Completing an upgrade to a Solaris system on page 294

● Completing an upgrade to an AIX system on page 299

Updating the naming service port number

If the naming service port number was assigned to a value other than the default of 10000, 
you must change it back to its original value. See Changing the naming service port 
number on page 239 for more information.

Removing the localhost folder

If your system is configured as a coresident Avaya IC and OA system, after you complete 
upgrading the Reporting Subsystem you must remove the following folder:

%PABASE%\stumbras\tomcat\work\localhost_8080

Note:
Note: This folder exists on Windows systems only.

Completing an upgrade to a Windows system

To complete an upgrade to a Windows system:

1. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Windows servers on page 96 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

2. Open a command prompt window.

3. If Terminal Services is enabled, enter:

change user /execute
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4. In the command prompt window, enter the following command to show what processes 
are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If you get the message mom is not active, enter:

pa start all

6. Repeat Step 4 to verify that OA has started.

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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7. Enter:

oalist

A message similar to the following is displayed listing what components are installed 
on this server:

8. Select Start > Programs > Administrative Tools > Services. 

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. Validate that the following services are started and are set to start automatically. If they 
are not administered to start automatically, administer them as such.

● If the Historical subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

● If the Real-time subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- TimesTen Data Manager 5.0

● If the Report subsystem is installed, check for the following:

- Avaya Business Intelligence Service

- ORBacus Naming Service

- Stumbras-Tomcat

● If the Source-EC (Event Collector) subsystem is installed, check for the following:

- ORBacus Naming Service

10. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.
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Completing an upgrade to a Solaris system

To complete an upgrade to a Solaris system:

1. Log out of the desktop environment.

2. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
Solaris servers on page 99 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

3. Enter:

. /opt/BI/.profile

4. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If you get the message mom is not active, enter:

pa start all

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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6. Repeat Step 4 to verify that OA has started.

7. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

8. Enter:

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

10. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

11. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

12. If the Report subsystem is installed, enter the following commands to start Stumbras:

cd $SUN_WEB_HOME/https-stumbras

./start

The following message is displayed.

 root   233     1  0   Dec 23 ?        0:01 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend
    root   234   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 0
    root   235   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 1
    root   236   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 2
    root   237   233  0   Dec 23 ?        0:00 /export/home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -id 3
 biadmin   244   182  0 10:34:22 pts/11   0:00 grep timesten

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

The OA environment will be set.
.
.
.

Startup: server started successfully
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13. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if Stumbras-Tomcat is running:

ps -ef | grep https-stumbras

A message similar to the following should be displayed.

● For Sun Java System Web Server 6.0:

● For Sun Java System Web Server 6.1:

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 biadmin  6141     1  0   Dec 31 ?        0:00 ./uxwdog -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6143  6142  0   Dec 31 ?        1:01 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin  6142  6141  0   Dec 31 ?        0:03 ns-httpd -d /usr/iplanet/servers/
https-stumbras/config
 biadmin   254   182  0 10:38:51 pts/11   0:00 grep https-stumbras

 biadmin 28604 28603  0 16:38:23 ?        1:58 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 28602     1  0 16:38:22 ?        0:00 ./webservd-wdog -r /opt/SUNWwbsvr
 -d //opt/SUNWwbsvr/https-stumbras/config -n h
 biadmin 28603 28602  0 16:38:22 ?        0:01 webservd -r /opt/SUNWwbsvr -d //o
pt/SUNWwbsvr/https-stumbras/config -n https-st
 biadmin 29266 29259  0 18:55:22 pts/22   0:00 grep https-stumbras
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Completing an upgrade to an AIX system

To complete an upgrade to an AIX system:

1. Log out of the desktop environment.

2. Log in using an OA user ID and password (see Creating user IDs and group IDs on 
AIX servers on page 105 in Avaya Operational Analyst Release 7.0 Installation 
Planning and Prerequisites).

! CAUTION:
CAUTION: Do not use any OA commands while logged in as root. Using the root 

login ID on these commands will change ownership of files and will make 
them unusable by the OA user ID.

3. Enter:

. /opt/BI/.profile

4. Enter the following command to show what processes are running:

pa list

A listing similar to the following is displayed.

Note that:

● There should be several Java entries, and these lines should not have an exit code 
at the end of the line. 

● If there are any exit codes displayed on the Java entries, that process is not running. 
Escalate the problem to Avaya Technical Support.

● The id=aut and id=schd will only display when the Historical subsystem is 
installed.

● The recorder entries are displayed only if you are collecting data from CMS or 
Avaya IC. Forwarder entries may be displayed on a server that has the Real-time 
subsystem installed.

5. If OA is not running (mom is not active), enter:

pa start all

 .       system boot  Dec 20 07:54
   .       run-level 4  Dec 31 10:23    4       0       @
java            .       Dec 20 07:54   .      292  id=admb
java            .       Dec 20 07:54   .       52  id=adm0
java            .       Jan 02 16:16   .      995  id=ams
java            .       Dec 20 07:54   .      295  id=aut
java            .       Dec 20 07:54   .      296  id=schd

.

.

.
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6. Repeat Step 4 to verify that OA has started.

7. If you are not successful starting OA, see Starting and stopping OA-related 
processes on page 41 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting for more troubleshooting information.

8. Enter:

oalist

A message similar to the following is displayed:

Subsystems installed 
   Real Time
   Reports
   Data API Utility
   Source-EC
 
Server Names 
   Historical: bigbird
   Alarm Server Type: IC
   Alarm Server: grover
 
Database information 
   Type: DB2
   Instance Name: icoadb
   OA DB Name: icoadb
   DB2 Version: 8.x
 
User information 
   OA User ID: biadmin
   Group ID: oaadmin
 
Reports information 
   WebSphere Root: /usr/IBM/WebSphere/AppServer
   HTTP Root: /usr/IBMIHS
   WebSphere Application Server: server1
   WebSphere Admin Console User: biadmin
 
OA Software information 
   Version Installed: 7.0.0.025
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9. If the Historical subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

10. If the Real-time subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin  2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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c. Enter the following command to see if the TimesTen Data Manager 5.0 is running:

ps -ef | grep timesten

A message similar to the following should be displayed.

11. If the Source-EC subsystem is installed, use the following commands and responses 
to verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

12. If the Report subsystem is installed, enter the following commands to stop and restart 
the WebSphere software:

stopWebSphere -w $WEBSPHERE_HOME -s servername -u userID 
-p userpassword

startWebSphere -w $WEBSPHERE_HOME -s servername -h HTTP_ROOT -u 
userID -p userpassword

where $WEBSPHERE_HOME is the installation path WebSphere (default is /usr/IBM/
WebSphere/AppServer), servername is the WebSphere Application Server Name 
under which OA Reports is deployed (default is server1), HTTP_ROOT is the 
installation path for the HTTP Server (default is /usr/IBMIHS), userID is the user ID 
administered for Global Security on WebSphere, and userpassword is the password 
for that user ID. 

 biadmin 20858 48090   0 13:01:34  pts/0  0:00 grep timesten
    root 31910 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 2 -facility user
    root 32664 36980   0   Apr 16      -  0:17 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 1 -facility user
    root 36302 36980   0   Apr 16      -  3:35 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 3 -facility user
    root 36980  6302   0   Apr 16      -  0:42 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestend -fg
    root 40150 36980   0   Apr 16      -  0:18 /home/biadmin/TimesTen5.0.27/
TimesTen/avaya_bi/bin/timestensubd -verbose -id 0 -facility user

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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Note:
Note: If the default values are used for $WEBSPHERE_HOME, servername, or 

HTTP_ROOT then do not use these options. If a Global Security user ID has 
not been administered, do not use the user and password options.

The following message is displayed.

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX
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13. If the Report subsystem is installed, use the following commands and responses to 
verify that the required services are running. If the services are not running, escalate 
the problem using the normal channels.

a. Enter the following command to see if the Avaya Business Intelligence Service is 
running:

ps -ef | grep initsrv

A message similar to the following should be displayed.

b. Enter the following command to see if the ORBacus Naming Service is running:

ps -ef | grep nameserv

A message similar to the following should be displayed.

c. Enter the following command to see if WebSphere is running:

ps -ef | grep WebSphere

A message similar to the following should be displayed.

 root  2886     1  0   Dec 27 ?        0:06 /opt/BI/bin/initsrv -n oaadmin -v 30
 biadmin   229   182  0 10:28:00 pts/11   0:00 grep initsrv

 biadmin 2885     1  0   Dec 27 ?       38:41 /opt/BI/bin/nameserv -OAport 10000 
-OAnumeric
 biadmin   239   182  0 10:32:21 pts/11   0:00 grep nameserv
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 biadmin 28514     1   0   Jun 03      -  4:39 /usr/IBM/WebSphere/AppServer/java/
bin/java -Xbootclasspath/p:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/
ibmorb.jar:/usr/IBM/WebSphere/AppServer/java/jre/lib/ext/ibmext.jar 
-Dwas.status.socket=53964 -classpath /usr/IBM/WebSphere/AppServer/profiles/
default/properties:/usr/IBM/WebSphere/AppServer/properties:/usr/IBM/WebSphere/
AppServer/lib/bootstrap.jar:/usr/IBM/WebSphere/AppServer/lib/j2ee.jar:/usr/IBM/
WebSphere/AppServer/lib/lmproxy.jar:/usr/IBM/WebSphere/AppServer/lib/
urlprotocols.jar:/usr/opt/db2_08_01/java/db2jcc.jar:/usr/opt/db2_08_01/java/
db2jcc_license_cu.jar:/usr/opt/db2_08_01/java/db2jcc_license_cisuz.jar -Xms50m 
-Xmx512m -Dws.ext.dirs=/usr/IBM/WebSphere/AppServer/java/lib:/usr/IBM/WebSphere/
AppServer/profiles/default/classes:/usr/IBM/WebSphere/AppServer/classes:/usr/
IBM/WebSphere/AppServer/lib:/usr/IBM/WebSphere/AppServer/installedChannels:/usr/
IBM/WebSphere/AppServer/lib/ext:/usr/IBM/WebSphere/AppServer/web/help:/usr/IBM/
WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.ejbdeploy/runtime 
-Dcom.ibm.itp.location=/usr/IBM/WebSphere/AppServer/bin 
-Djava.util.logging.configureByServer=true -Dibm.websphere.preload.classes=true 
-Duser.install.root=/usr/IBM/WebSphere/AppServer/profiles/default 
-Dwas.install.root=/usr/IBM/WebSphere/AppServer 
-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager 
-Ddb2j.system.home=/usr/IBM/WebSphere/AppServer/cloudscape -Dserver.root=/usr/
IBM/WebSphere/AppServer/profiles/default -Djava.awt.headless=true 
-Djava.security.auth.login.config=/usr/IBM/WebSphere/AppServer/profiles/default/
properties/wsjaas.conf -Djava.security.policy=/usr/IBM/WebSphere/AppServer/
profiles/default/properties/server.policy com.ibm.ws.bootstrap.WSLauncher 
com.ibm.ws.runtime.WsServer /usr/IBM/WebSphere/AppServer/profiles/default/config 
groverNode01Cell groverNode01 server1
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14. To verify that OA reports are running using the WebSphere Administrative Console:

a. In a browser window, enter:

http://report_server_FQDN:port_number/reports1

where report_server_FQDN is the fully-qualified domain name of the server 
where the Report subsystem is installed and port_number is the port number 
assigned to the WebSphere Administrative Console (for example, 9060).

b. Log in to the WebSphere Administration Console using the Global Security user ID 
and password (if assigned). Otherwise, enter any user ID.

c. Select Applications > Enterprise Applications.

d. If there is a green arrow next to Default, select the check box to the left of Default 
and select Stop.

e. Verify that there is a green arrow next to OAReports. If there is a red X, select the 
check box to the left of OAReports and select Start. This should change the status 
to a green arrow. If not, escalate the problem using the normal channels.
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Recovering from a failed upgrade
You can recover the previous software and configuration of OA if the upgrade to a new 
version of OA fails. This recovery feature applies to the OA software only and does not 
include data migration.

! Important:! Important:
Important: If you manually stop an upgrade during file installation by closing the 

Progress dialog box, you cannot recover the upgrade using this procedure. 
You must contact Avaya technical support.

Note:
Note: Recovery of a different version than had been initially installed is not 

possible.

If a failure occurs during installation of files and a message is displayed indicating that 
recovery is required:

1. Continue with the failed upgrade, rebooting if requested.

The OA software on the machine at this point is a mixture of the new software that was 
installed before the failure occurred as well as the old software that had not yet been 
replaced.

2. Uninstall the OA software. See Removing Avaya OA components on page 243. Do not 
remove any files under the %PABASE% or $PABASE folders or directories.

3. On a Windows server:

a. Select Start > Settings > Control Panel.
b. Double-click Add or Remove Programs.

c. Scroll through the list of currently-installed programs and find all occurrences of 
Java 2 Runtime Environment (JRE) software.

d. Remove versions 1.3.1_03 and 1.3.1_06 of the JRE software, if they are installed.

4. Install the old original version of OA.

A window will indicate that a recovery is being done. The installation dialog boxes will 
then be displayed with the information that was entered when the software was 
originally installed. This information cannot be changed. Also, the Feature Selection 
and Destination dialog boxes will not be displayed, which prohibits you from changing 
that information.

5. When the installation is finished, OA will operate as it did before the upgrade attempt.

6. Contact Avaya technical support to determine what must be fixed before trying the 
upgrade again.
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Troubleshooting an installation

This section provides some troubleshooting hints to help you get OA installed and running. 
You may do some troubleshooting using the Administration client interface. To do so, 
please refer to the Administration Client Help for more information.

While this section does not present an exhaustive list of troubleshooting procedures and 
tools, following the suggestions will usually pinpoint the problem areas you need to work 
on. For more help, contact Avaya Customer Support or your Avaya Professional Services 
representative.

This section includes the following topics:

● Incorrect OS and database installation on page 310

● Diagnosing installation problems on page 310

● Installation failure after changing the domain name on page 311

● Processes not running on page 311

● Data not transferred or collected on page 311

● Missing files on page 312

● Subsystems not installed on page 312

● Unable to install Report client files on page 313

● Report access failure on page 313

● Administration client authorization failures on page 314

● Password changes on page 314

● Display problems with AIX on page 314

● Corruption in AIX terminal windows on page 314

● Microsoft SQL Server 2000 installation troubleshooting on page 316
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Incorrect OS and database installation
One of the most common causes of installation failure is improper setup of the operating 
system environment before attempting to install OA. Be sure to verify that the customer 
has followed the steps outlined in Preparing for installation on page 13. It is critical that all 
the supporting environment software is installed in the proper order.

Diagnosing installation problems
If you encounter difficulties with the OA installation, following these steps may help you 
pinpoint the cause of the trouble:

1. Access the OAInstall.log file.

For Windows, this file can be found in %TEMP% during the installation, and in 
%PABASE% after the server has been rebooted.

For Solaris and AIX, this file can be found in /tmp during the installation, and in 
$PABASE after the installation.

Note:
Note: The location of the %TEMP% folder in Windows depends on how Windows 

was installed. 

2. View the OAInstall.log file. This log file reports:

● Installed components

● Errors encountered during installation

● Rollbacks due to installation errors

If the log file information does not lead to a resolution of the difficulty, contact your Avaya 
planning and installation support representative or your Avaya Business Partner.
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Installation failure after changing the domain name
If the database software was originally installed on a server using a Windows domain login 
(not a local administrator login), and the domain name of that server is changed, the 
database software can no longer authenticate the owner of the database files and 
directories during OA installation. The installation will fail.

To fix this problem, log in as a local administrator on the database server and reinstall the 
database software. See Installing the historical database software on page 57 in Avaya 
Operational Analyst Release 7.0 Installation Planning and Prerequisites for more 
information.

If you want to preserve your data, you must do a full backup, reinstall the database 
software, then restore the data. See Backing up the historical database on page 17 in 
Avaya Operational Analyst Release 7.0 Maintenance and Troubleshooting for more 
information.

After you have reinstalled the database software, reinstall the OA software. See Installing 
Avaya OA components on a Windows platform on page 32 for more information.

Processes not running
Use the commands described in Starting and stopping OA-related processes on page 41 
in Avaya Operational Analyst Release 7.0 Maintenance and Troubleshooting to start 
processes that may not be running.

Data not transferred or collected
If data is not being transferred from data collection sources, or if data is not getting 
collected at the historical server, use the dcstat command to check the forwarders and 
recorders. This command is described in Forwarders and recorders on page 50 in Avaya 
Operational Analyst Release 7.0 Maintenance and Troubleshooting.
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Missing files
When attempting to run OA, if a window displays indicating that DLLs or other files are 
missing, you must repair the OA software. Follow the instructions regarding repair in 
Repairing Avaya OA components on page 193. 

Note:
Note: All of the components previously installed must be selected on the Feature 

Selection dialog box for repair.

Subsystems not installed
When installing subsystems on a Windows server, the Windows Terminal Services feature 
may block certain subsystems from being installed, in particular, the Source-EC 
subsystem.

If you have installed the Source-EC subsystem on a server, but later find out the 
installation failed, reinstall the Source-EC subsystem, making sure that you temporarily 
change the Terminal Services install option using the change user /install 
command. See Installing Avaya OA components on a Windows platform on page 32 for 
more information.

Report client installation fails to work
If you install the Report client files, but you cannot access any reports, do the following:

● Verify that you have not installed the Report client files on a Windows Server 2003 
machine. This installation option is not allowed.

● See Troubleshooting Basic Reports and the report server on page 175 in Avaya 
Operational Analyst Release 7.0 Maintenance and Troubleshooting.
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Unable to install Report client files
If you are unable to install the OA Report client files and JRE on reporting client machines, 
this may be caused by the IIS Lockdown tool.

If the IIS Lockdown tool is installed on the server where the Report subsystem is installed 
and the URLScan option is enabled, remove the IIS Lockdown tool before you attempt to 
install the Report client files onto the client machines.

After the client machines are all installed, reinstall the IIS Lockdown tool onto the server 
where the Report subsystem is installed.

Report access failure
If you try to access reports and receive a Page Not Found, This page cannot be 
displayed, or other similar error, it may be that the Report subsystem has not been 
administered. 

To verify that the Report subsystem has been administered:

1. Start the Administration client.

2. Access the Subsystems page.

3. Verify that there is an entry for a Report subsystem on the subsystem where you are 
attempting to run reports.

If you try to access reports and your login and password are rejected, or you receive a 
Forbidden error, it may be that the Historical subsystem is not operating or cannot be 
accessed over the network. Confirm that the Historical subsystem is operating correctly 
and that it can be accessed over the network. Verify that your user ID is a member of the 
Reports group.

If you are getting Java errors, verify that the JRE and Report client support files have been 
installed. See Installing and testing the Report client on page 102.

Refer to Adding a Report subsystem on page 132 and the Administration Client Help for 
more information on how to administer the Report subsystem and starting the web 
services.

If you still cannot access reports, see Troubleshooting Basic Reports and the report 
server on page 175 in Avaya Operational Analyst Release 7.0 Maintenance and 
Troubleshooting.
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Administration client authorization failures
If you cannot access the OA Administration client due to authorization failures, please refer 
to Avaya Operational Analyst Release 6.1 Security Guide on the Avaya OA installation 
CD-ROM for details on user ID and group creation and guidelines.

Password changes
If you change database passwords external to OA, you may need to repair OA to reset the 
passwords. See Repairing Avaya OA components on page 193 for more information.

Display problems with AIX
When installing on AIX, you may have problems displaying the installation dialog boxes if 
you do not set the monitor�s display environment. Before you begin the install, enter:

export DISPLAY=hostname:0.0

where hostname is the name of the server (uname -n) or the IP address of the server.

Corruption in AIX terminal windows
During installation of OA on an AIX server, you may see intermittent errors when creating 
logical table spaces. These errors may note that tablespaces are too small, even though 
you have set up the tablespaces to be much larger than the minimum sizes.

If this continues to happen, cancel the install, close the AIX terminal window, and restart 
the installation in a new terminal window.
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Domain controller loses connection
When adding, repairing, or upgrading OA components on a Windows system, you receive 
a message saying you are using an invalid user ID or invalid group ID. This may be caused 
by the system or domain server losing track of the system on where you are installing OA.

To work around this problem on Windows 2000:

1. From the Windows Desktop, right-click My Computer and select Properties.

2. Select the Network Identification tab.

3. Select Properties.

4. Under Identification Changes, select Workgroup.

5. Enter the new work group.

6. Select OK.

7. Select Apply.

8. Choose a domain.

9. Select Apply.

10. Reboot the computer.

To work around this problem on Windows 2003:

1. From the Windows Desktop, right-click My Computer and select Properties.

2. Select the Computer Name tab.

3. Select Change.

4. Under Computer Name Changes, select Workgroup.

5. Enter the new work group.

6. Select OK.

7. Select Apply.

8. Choose a domain.

9. Select Apply.

10. Reboot the computer.
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Microsoft SQL Server 2000 installation 
troubleshooting

If you encounter difficulty installing the OA software due to Microsoft SQL Server 2000 
database issues, it is possible the initial Microsoft SQL configuration is incorrect.

This section includes the following topics:

● Port number on page 316

● Microsoft SQL server services on page 316

● Memory usage on page 317

● Authentication on page 317

Port number
The port number, which is usually 1433, must match the entry in the file %PABASE%\data\
admin\db.properties. To verify the port number:

1. Select Start > Program Files > Microsoft SQL Server > Server Network Utility.

2. Select the General tab.

3. Select TCP/IP.

4. Click Properties.

5. Adjust the port number if necessary.

Microsoft SQL server services
The Microsoft SQL server services must be running and set to start automatically.

1. Select Start > Programs > Administrative Tools > Services. 

2. Verify that these services are running and are set to start automatically. Adjust as 
necessary:

● SQLAgent$instance name (not automatic by default)

● MSSQL$instance name
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Memory usage
You should limit the amount of memory Microsoft SQL Server can use. To verify this:

1. Open Enterprise Manager.

2. Click the SQL Server Group.

3. Right-click local host\instance name.

4. Select Properties.

5. Select the Memory tab.

6. Select Dynamically configure SQL Server memory.

7. Set Minimum to be 1/4 of available memory.

8. Set Maximum to be 1/2 of available memory.

Authentication
If OA refuses the password you enter during installation, make sure the password is 
correct. To verify the password:

1. Use the Microsoft SQL Query Analyzer tool.

2. Try to log in using the sa login ID and password in question.

3. If your password is blank, change it to a non-blank value.

If this still does not fix the problem, you may need to install the latest Microsoft SQL service 
pack.
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Appendix A: Port assignments

The OA servers require several ports to communicate with other OA servers, Avaya IC 
servers, and third-party servers and applications. Whenever possible, use the default ports 
and locations in the configuration to reduce potential conflict. 

Avaya IC servers use TCP/IP ports for communication with the other Avaya IC servers. 
These ports start at 9001 and increment from there. Before you install these servers, verify 
with your network administrator that no other network applications use the same ports. 

If a server uses a port that is already assigned to a network application or another server, 
either the server or the application may not function. 

This section describes the guidelines for assigning ports and the default port assignments 
in Avaya IC and Avaya OA. This section includes the following topics:

● Guidelines for assigning ports on page 320

● Ports used by Avaya OA components on page 322

● Ports used by Avaya IC servers on page 323

● Ports used for Business Advocate on page 328

● Ports used for third party servers on page 329

● Ports used for connections between Avaya OA and CMS on page 330

● Ephemeral ports on page 334

! CAUTION:
CAUTION: To avoid potential port conflicts, for an Avaya IC deployment that includes 

Avaya IC and Avaya OA components on the same machine, always start the 
Avaya IC components first, then start the Avaya OA components.
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Guidelines for assigning ports
This section includes the following topics:

● Allowable values on page 320.

● Multiple server instances on page 320.

● Automatic settings for Avaya IC core servers on page 320.

● Primary and secondary Avaya IC servers on page 321.

● Port verification on page 321.

● Changing default port assignments on page 321.

Allowable values
All ports must be numeric and in the range of 1024-65535. 

Multiple server instances
Multiple instances of a server that run on the same machine require different port numbers 
for each instance.

Automatic settings for Avaya IC core servers
Port numbers for the Avaya IC core servers are sequential. Avaya IC assigns port numbers 
to all core servers according to the port assigned to the ORB server. For example, Avaya 
IC automatically assigns the ports in the following table to the servers that are added when 
you configure the primary server environment. When you configure the other servers, IC 
Manager assigns port numbers sequentially, starting with 9005.

Server Default Port

ORB server 9001

Directory server 9002

Alarm server 9003

License server 9004
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Primary and secondary Avaya IC servers
If you install primary and secondary servers, use the default port number of 9001 for the 
primary port. You can use the same number for the secondary servers on another 
machine. If you select a different port, Avaya IC assigns ports sequentially from that port 
number.

Port verification
Review the current port numbers in IC Manager to verify that there are no conflicts when 
you assign ports.

Changing default port assignments
You can change the default port numbers:

● When you configure Avaya IC servers

● In IC Manager

For more information, see the section "Configuring core servers" in Avaya Interaction 
Center Release 7.0 Installation and Configuration. 
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Ports used by Avaya OA components
The following table lists the default ports used by Avaya OA components. For information 
about ports used by the various IC and third party servers, see Ports used by Avaya IC 
servers on page 323.

Avaya OA does use some other ports. However, the CORBA third party product 
(ORBAcus) does not allow you to specify a range for those ports. ORBacus dynamically 
gets whatever port the operating system provides. You can tell the operating system what 
range of port it can assign to applications. For more information, see Ephemeral ports on 
page 334.

Component Default port Assigned port Notes

Avaya OA Event Collector 
server

Sequential Sequential from the previous 
server created in IC Manager.

Orbacus 10000 Orbacus naming service

OA services 1521 Used by connection to Oracle 
database. 

OA services 1433 Used by connection to Microsoft 
SQL Server database.

OA services 50000 Used by connection to IBM DB2 
database. 
This listen port is the default for 
the first DB2 instance that is 
created. Any additional instances 
will use a different port
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Ports used by Avaya IC servers
The following table contains default port assignments for the Avaya IC servers and some 
third-party servers. To make sure that you assign unique ports to each server, write your 
port assignments in the empty cells of the Assigned Port column.

! CAUTION:
CAUTION: By default, Solaris runs the HTT Input Method Server (htt_server) on port 

9010. On non-English Solaris machines, this port assignment creates a 
conflict with any Avaya IC server that you configure to run on port 9010. To 
avoid the conflict, you can update htt_server to use a different port, or not 
assign an Avaya IC server to port 9010. In a typical installation, with the 
primary ORB server on port 9001, IC Manager automatically assigns port 
9010 to the Report server.

Server Default port Assigned port Notes

ORB server 9001 Default port assignment.

Directory server 9002 Sequential from ORB server.

Alarm server 9003 Sequential from Directory server.

License server 9004 Sequential from Alarm server

Blender server Sequential Sequential from the previous 
server created in IC Manager.

Workflow server Sequential Sequential from the previous 
server created in IC Manager.

ADU server Sequential Sequential from the previous 
server created in IC Manager.

Data server Sequential Connects to the following ports:
● Oracle database on 1521
● SQL Server database on 1433
● DB2 database on 50000
For DB2, this port is the default for 
the first DB2 instance that is 
created. Additional instances use 
a different port
Sequential from the previous 
server created in IC Manager.

EDU server Sequential Sequential from the previous 
server created in IC Manager.
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Report server Sequential Sequential from the previous 
server created in IC Manager.

HTTP Connector server Sequential Connects to HTTP protocol on 
port 80.
Sequential from the previous 
server created in IC Manager.

Notification server Sequential Sequential from the previous 
server created in IC Manager.

WebACD server Sequential Sequential from the previous 
server created in IC Manager.

ComHub server Sequential Sequential from the previous 
server created in IC Manager.

Paging server Sequential Sequential from the previous 
server created in IC Manager.

Attribute server Sequential Sequential from the previous 
server created in IC Manager.

IC Email server Sequential Connects to the following ports:
● POP3 server on 110
● SMTP server on 25
Sequential from the previous 
server created in IC Manager.

DUStore server Sequential Sequential from the previous 
server created in IC Manager.

Telephony server Sequential Sequential from the previous 
server created in IC Manager.
Note: Some switch interfaces 
require additional ports. For more 
information, see the 
documentation for your switch.

TS Queue Statistics server Sequential Sequential from the previous 
server created in IC Manager.

VOX server Sequential Connects to the IVR through 
default port 3000. You can change 
this port assignment in the IVR.
Sequential from the previous 
server created in IC Manager.

Dialing Kernel server Sequential Sequential from the previous 
server created in IC Manager.

Server Default port Assigned port Notes
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Softdialer server Sequential Sequential from the previous 
server created in IC Manager.

Content Analyzer 
Administration server

Sequential Sequential from the previous 
server created in IC Manager.

Content Analyzer Operation 
server

Sequential Sequential from the previous 
server created in IC Manager.

WebACD server - Service 
port (Legacy services)

4010 If you must change this port, see 
Avaya Interaction Center 
Release 7.0 Installation and 
Configuration.

ComHub server - Service 
port (Legacy services)

4001 If you must change this port, see 
Avaya Interaction Center 
Release 7.0 Installation and 
Configuration.

Paging server - Service port 
(Legacy services)

4200 If you must change this port, see 
Avaya Interaction Center 
Release 7.0 Installation and 
Configuration.

Attribute server - Service port 
(Legacy services)

2300 If you must change this port, see 
Avaya Interaction Center 
Release 7.0 Installation and 
Configuration.

HTTP Connector server - 
HTTP request port

9170 Can change default if required.

WebQ 9180 Can change default if required.

WebQ Router 9190 Can change default if required.

Ports reserved for ICM and 
CIRS

9500 to 9520 See cells below for details.

Internet Call Manager service 
- ICM agent

9501 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM caller

9502 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM bridge in Attribute 
server port

9503 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Server Default port Assigned port Notes
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Internet Call Manager service 
- ICM administration (Util 
port)

9504 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM tunnel

9505 If you must change this port, see 
Avaya Interaction Center 
Release 7.0 Installation and 
Configuration.

CIRS service - CIRS servlet 
port

9506 If you must change this port, see 
Avaya Interaction Center 
Release 7.0 Installation and 
Configuration.

CIRS service - CIRS 
administration (Util port)

9507 Change this port in the CIRS 
Directory server table through 
Configuration tab of IC Manager.
This port is used to monitor the 
CIRS server.

CIRS service - CIRS caller 9508 Change this port in the CIRS 
Directory server table through 
Configuration tab of IC Manager.

VMM server - VOIP caller 
port

8120 Used for Voice Chat.

Dialing Kernel server - 
serverport

7800 Used for outbound voice contacts.

IC Email server - Email 
provider port

19113 Used by Web Agent to retrieve 
email contacts from the IC Email 
server.

IC Email server - HTTP port 
for administration interface

19114 Used by Email Template 
Administration to send changes to 
the IC Email server.

Server Default port Assigned port Notes
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Website, Email Template 
Administration, QKnowledge, 
Letter Generator, Agent 
Installer, and ICM tunneling

Http - 80
Https - 443

HTTP and HTTPS connections for 
web applications.

Tomcat servlet 9600 HTTP port.
Change through the Configuration 
Tool. 
If you configure multiple Web 
applications on one machine, the 
Configuration Tool uses the 
following sequential ports:
● baseport+1 for Web License 

Manager 
● baseport+2 for Website
● baseport+3 for Email Template 

Administration
● baseport+4 for QKnowledge
● baseport+5 for Letter Generator
● baseport+6 for IC Test

Server Default port Assigned port Notes
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Ports used for Business Advocate
The following table lists the ports used for Business Advocate, plus additional information 
on how to control those ports:

Component Default port Assigned port Notes

Business Advocate Resource 
Manager server

Sequential Sequential from the previous 
server created in IC Manager.

Business Advocate 
Telephony Services Adaptor 
server

Sequential Sequential from the previous 
server created in IC Manager.

Web Advocate Adaptor 
server

Sequential Sequential from the previous 
server created in IC Manager.

Advocate Services 1521 Use by connection to Oracle 
database.

DCOM 5000 to 5050 Business Advocate servers that 
use DCOM, limit to 5000-5050.
See Microsoft Knowledge Base 
article 154596 and the article 
entitled "Using Distributed COM 
with Firewalls" by Michael Nelson

Active Directory and MSMQ per Windows 
configuration

See Microsoft Knowledge Base 
article 179442.

Windows network share to 
primary Resource Manager 
server.

per Windows 
configuration

See Microsoft Knowledge Base 
article 179442.
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Ports used for Siebel Integration
The following table lists the ports used for Siebel integration servers and components, plus 
additional information on how to control those ports:

Ports used for third party servers
Avaya IC and Avaya OA also use third party servers which are accessed through TCP/IP. 
These third party servers include, but are not limited, to those listed in the following table.

Component Default port Assigned port Notes

Siebel AED server Sequential Sequential from the previous 
server created in IC Manager.

Siebel AICD server Sequential Sequential from the previous 
server created in IC Manager.

Siebel EAI server Sequential Communicates with Siebel on 
HTTP port 80.
You can configure this port by 
setting hostname:port on the 
Configuration tab of the server.
Sequential from the previous 
server created in IC Manager.

Default port Protocol or component Avaya IC components

25 SMTP IC Email server and Web Management 
website

110 POP IC Email server and POP3 email servers

1433 SQL Server database Data server, Web Management website, 
and ICM connection for SQL Server 
installation

1521 Oracle database Data server, Web Management website, 
and ICM connection for Oracle 
installation

50000 DB2 database Data server, Web Management website, 
and ICM connection for DB2 installation
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Ports used for connections between Avaya OA and 
CMS

This section describes the port usage for communication between an OA host and a CMS 
host.

This section includes the following topics:

● Inbound ports required for a CMS host on page 330

● Outbound ports required for a CMS host on page 330

● Inbound ports required for an OA host on page 331

● Outbound ports required for an OA host on page 331

● Formulas for port usage on page 332

● Port usage example on page 332

Inbound ports required for a CMS host
● 1 port (port 10000, configurable) - All inbound CORBA processes to Naming Service 

from other host(s)

● 2x ports - Connection monitoring from recorders [1..X] to forwarders [1..X]

● 2 ports - adm0 to admb

● 2 ports - Connection monitoring adm0 to admb

● 2t ports at a time - Command-line tools that can be run across machines, such as AMUI 
to AMS and dcstat to recorders. They only run on demand and release ports when 
completed. Therefore only 2 ports at a time are needed. You can open more ports if you 
want to be able to run more than one command-line tool at a time

Outbound ports required for a CMS host
● 2x ports - Forwarder [1..X] to recorder [1..X]

● 2x ports - Connection monitoring from forwarders [1..X] to recorders [1..X]

● 2 ports - adm0 to admb

● 2 ports - Connection monitoring adm0 to admb
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● 1p port per CORBA client for Outbound Transient connection to the Naming Service, 
where p is the number of CORBA client processes connecting to a CORBA server on 
another host

● 2t ports at a time - Command-line tools that can be run across machines, such as AMUI 
to AMS and dcstat to recorders. They only run on demand and release ports when 
completed. Therefore only 2 ports at a time are needed. You can open more ports if you 
want to be able to run more than one command-line tool at a time.

Inbound ports required for an OA host
● 1 ports (port 10000, configurable) - All inbound CORBA process to Naming Service from 

other host(s)

● 2x ports - Forwarder [1..X] to recorder [1..X]

● 2x ports - Connection monitoring from forwarders [1..X] to recorders [1..X]

● 2 ports - adm0 to admb

● 2 ports - Connection monitoring adm0 to admb

● 2t ports at a time - Command-line tools that can be run across machines, such as AMUI 
to AMS and dcstat to recorders. They only run on demand and release ports when 
completed. Therefore only 2 ports at a time are needed. You can open more ports if you 
want to be able to run more than one command-line tool at a time.

Outbound ports required for an OA host
● 2x ports - Connection monitoring from recorders [1..X] to forwarders [1..X]

● 2 ports - adm0 to admb

● 2 ports - Connection monitoring adm0 to admb

● 1p port per CORBA client for Outbound Transient connection to the Naming Service

● 2t Command-line tools that can be run across machines, such as AMUI to AMS and 
dcstat to recorders. They only run on demand and release ports when completed. 
Therefore only 2 ports at a time are needed. You can open more ports if you want to be 
able to run more than one command-line tool at a time.
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Formulas for port usage
The following formulas show how to determine port usage on a CMS host and an OA host:

● Ports needed on the CMS host:

Outbound = 4 + 1p + 2t + 4x

Inbound = 5 + 2t + 2x

Total ports = 9 + 1p + 4t + 6x

● Ports needed on the OA host:

Outbound = 4 + 1p + 2t + 2x

Inbound = 5 + 2t + 4x

Total ports = 9 + 1p + 4t + 6x

Note the following about these formulas:

● CORBA connections require 2 ports, one for sending the CORBA request, one for 
receiving the CORBA response.

● CORBA connections across hosts require both the CORBA server's host to have 2 
available ports (inbound connections) and the CORBA's client host to have two 
available ports (outbound connections).

● t is the number of transient applications you want to run at one time.

● p is the number of CORBA clients that use the Naming Service on the host where the 
corresponding CORBA server is running. I am calculating that all CORBA clients may 
try to connect to the Naming Service at the same time so I'm counting one port for each. 
Those connections are transient so they will be freed automatically after use.

● x is the number of forwarders used for the given configuration.

Port usage example
In this example, if:

● A CMS host runs 6 forwarders (x = 6)

● You allow only one command-line tool to run at a time, which is a typical scenario (t = 1)

● The list processes that connect to the Naming Service on the OA box (p = 8)

● There are 6 forwarders

● There is 1 admin servers

● There is 1 command-line tool
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The number of ports needed on the CMS box is:

9 + 8 + 4 + 36 = 57

The number of ports needed on the OA box is:

9 + 8 + 4 + 36 = 57

The following figure illustrates the transient and long-term connections that occur between 
OA and CMS:

10000

10000
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Ephemeral ports
A TCP/IPv4 connection consists of two endpoints, and each endpoint consists of an IP 
address and a port number. When a client user connects to a server computer, an 
established connection can be thought of as the combination of server IP, server port, 
client IP, client port. Usually, three of the four are readily known: the client machine uses its 
own IP address, and when connecting to a remote service, the server machine's IP 
address and service port number are required. 

What is not immediately evident is that when a connection is established, the client side of 
the connection uses a port number. Unless a client program explicitly requests a specific 
port number, the port number used is an ephemeral port number. Ephemeral ports are 
temporary ports assigned by a machine's IP stack, and are assigned from a designated 
range of ports for this purpose. When the connection terminates, the ephemeral port is 
available for reuse, although most IP stacks won't reuse that port number until the entire 
pool of ephemeral ports have been used. So, if the client program reconnects, it will be 
assigned a different ephemeral port number for its side of the new connection.

This section includes the following topics:

● Limits implied by the ephemeral port range on page 334

● Traditional configuration of the ephemeral port range on page 335

● Firewalling the ephemeral port range on page 335

● Changing the ephemeral port range on page 336

Limits implied by the ephemeral port range
Another important ramification of the ephemeral port range is that it limits the maximum 
number of connections from one machine to a specific service on a remote machine. The 
TCP/IP protocol uses the connection's combination of server IP, server port, client IP, and 
client port to distinguish between connections, so if the ephemeral port range is only 4000 
ports wide, that means that there can only be 4000 unique connections from a client 
machine to a remote service at one time.

A port range of 4000 may seem large, but it is actually small for current computing 
demands when you consider that a TCP connection must expire through the TIME_WAIT 
state before it is really completed. For example, even if both sides of a connection properly 
close their ends of the connection, due to TCP's error control, each side must wait until the 
TIME_WAIT state is expired before the connection's resources can really be disposed. The 
TIME_WAIT state is twice the maximum segment lifetime (MSL) which, depending on the 
IP stack, is usually configured to be 240 seconds total. That means that you could have 
only 4000 connections per 240 second window, and in practice this can be exhausted.
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Traditional configuration of the ephemeral port range
The BSD Sockets TCP/IP stack used ports 1024 through 4999 as ephemeral ports. 
Additionally, ports 1 through 1023 were intended for systems services running as the 
superuser, so those ports are called reserved ports. 

As discussed earlier, BSD's choice of the ephemeral port range is unfortunate because of 
its relatively small size (3975 ports) and its low numbered position. Many feel that the 
default range should be 49152 through 65535, which is both much larger (16383 ports) 
and is at the very top of the full port range.

Firewalling the ephemeral port range
For firewalls, administrators often choose to restrict access to as many port numbers as 
possible. For cases where inbound connections to the ephemeral ports is required, an 
entire range of ports must be opened. It is imperative that when opening a range of ports 
on the firewall that no system services are listening on ports in the open range. 
Administrators will often want to open a specific range on the firewall, and then for each 
machine on the internal network, make sure that the ephemeral port range on the machine 
coincides with the open range on the firewall.

It must be made clear that the ephemeral port range on machines on the internal network 
often do not coincide with each other since different operating systems may use different 
ranges. That is why it can be time consuming to manually configure each machine's 
ephemeral port range so it coincides with the open range on the firewall. As a result, 
administrators often end up changing to a policy of allowing all incoming ports and deny 
access to specific ports when needed.

It may not be necessary to open the ephemeral port range. It is usually only necessary 
when FTP is being served to the outside world (Passive "PASV" data connections use 
inbound ephemeral ports), or when FTP client access must work in non-passive mode 
("PORT" connections from the server are inbound to clients using ephemeral ports).
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Changing the ephemeral port range
It is desirable to change which port numbers are used for the ephemeral port range for any 
of the following:

● To use a larger range so that more simultaneous connections are possible.

● To shift the range to the higher numbered ports. The higher numbered ports should be 
used as ephemeral ports because they are less likely to be used as port numbers for 
system services. Well known service ports have traditionally been assigned to lower 
port numbers.

● To change the range to coincide with other systems for purposes of firewalling and 
automatic network address translation. 

When changing the range, we suggest you change it to 49152 through 65535. If you need 
a larger range, continue downward from 49152, but leave 65535 as your upper bound. The 
following sections describe how to change the ephemeral port range on the OA operating 
systems:

● Microsoft Windows on page 336

● Solaris on page 337

● AIX on page 339

As noted in these sections, some systems already use the preferred range and will not 
need to be changed. Some operating systems also use two or more ranges, and to use the 
other ranges an application will have to be explicitly coded to choose the other range. 

Microsoft Windows

Windows uses the traditional BSD range of 1024 through 4999 for its ephemeral port 
range. You can only set the upper bound of the ephemeral port range. Here is information 
excerpted from Microsoft Knowledgebase Article Q196271:

To set the upper boundary of the ephemeral port range on Windows:

1. Start the registry editor (Regedt32.exe).

2. Locate the following key in the registry:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\
Parameters

3. On the Edit menu, click Add Value, and then add the following registry value:

Value Name: MaxUserPort Data Type: REG_DWORD Value: 65534

Valid Range: 5000-65534 (decimal) Default: 0x1388 (5000 decimal)

Description: This parameter controls the maximum port number 
used when an application requests any available user port from 
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the system. Normally, ephemeral (that is, short-lived) ports 
are allocated between the values of 1024 and 5000 inclusive.

4. Quit the registry editor. 

Solaris

Solaris uses the ndd utility program to change tunable IP stack parameters. The 
ephemeral ports on Solaris can be tuned individually for both TCP and UDP, so there are 
really two separate ephemeral port ranges. Solaris also provides options to change the 
privileged port range (ports only processes running with superuser privileges can use).

Solaris, by default, provides a large range at the end of the port range (32768 
through 65535, or the upper 50%) so it is unlikely you will need to change the range from 
the default values.

The example below shows how to query the existing range for the TCP ephemeral ports 
and change the range to 49152 through 61000:

1. Enter:

/usr/sbin/ndd /dev/tcp tcp_smallest_anon_port 
tcp_largest_anon_port

The current range (by default, 32768 to 65535) is displayed.

2. Enter the following commands to change the ephemeral port range to 49152 
through 61000:

/usr/sbin/ndd -set /dev/tcp tcp_smallest_anon_port 49152

/usr/sbin/ndd -set /dev/tcp tcp_largest_anon_port 61000

3. Enter the following command to display the new range:

/usr/sbin/ndd /dev/tcp tcp_smallest_anon_port 
tcp_largest_anon_port

The new range, 49152 through 61000, is displayed.

Note:
Note: If you change the range values, you must do it each time the system boots. 

Although we recommend that you just use the default range which is 
sufficient, here is a sample script you can use to change the port range to be 
32768 to 33678 at startup:

#
# copy me to /etc/init.d/ephemports
# "ln -s /etc/init.d/ephemports /etc/rc2.d/S99emphemports"
#
/usr/sbin/ndd -set /dev/tcp tcp_smallest_anon_port 32768
/usr/sbin/ndd -set /dev/udp udp_smallest_anon_port 32768
/usr/sbin/ndd -set /dev/tcp tcp_largest_anon_port 33768
/usr/sbin/ndd -set /dev/udp udp_largest_anon_port 33768
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For more information about tuning Solaris, refer to the Solaris Tunable Parameters 
Reference Manual. 
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AIX

AIX uses the no command to set network options. AIX uses two separate ephemeral port 
ranges, one for TCP and UDP, and both default to the values 32768 through 65535.

To display the current port range, enter:

/usr/sbin/no -a | fgrep ephemeral

The port range is displayed:

The default range is sufficient, but you can change it using the no command. 

For example, to set the TCP ephemeral port range to 49152 through 65535, enter:

/usr/sbin/no -o tcp_ephemeral_low=49152 -o 
tcp_ephemeral_high=65535

The options you set with no must be done each time the system starts up. One way to do 
that is to edit /etc/rc.tcpip and insert the no commands just before the script starts 
running the server daemons.

tcp_ephemeral_low = 32768
tcp_ephemeral_high = 65535
udp_ephemeral_low = 32768
udp_ephemeral_high = 65535
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Appendix B: Changing the Cognos 
installation

Normally, the Advanced Reports subsystem can only be installed on the C: drive of a 
Windows server. This is also true for the Cognos software that is used with Advanced 
Reports.

This section describes a way to modify the standard installation of Cognos so that the 
cubes can be moved to a drive other than the C: drive on a Windows server. Please 
consult your Avaya services representative for support doing this procedure.

This section includes the following topics:

● Prerequisites on page 341

● Changing the Cognos installation on page 342

Prerequisites
Before you begin this procedure, verify that the following has been done:

● The Cognos software has been installed in the standard location on the C: drive.

● The Advanced Reports subsystem has been installed on the same server. See Installing 
Avaya OA components on a Windows platform on page 32 for more information.

● The reports folder and all that is under it is copied to the new location. In the example in 
this section, drive R is being used.
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Changing the Cognos installation
This procedure is used for modifying the Advanced reports that do not have a different 
database name other than the default database names. In this example, the drive being 
used for Cognos is named D and the drive used for the cubes is named R. This procedure 
sets up the OA Advanced Reports for Cognos to the following network directory:

R:\oa advanced reports\reports\………

To change the Cognos installation:

1. Open Impromptu Administrator.

2. Select Catalog > Databases.

The Database Definition Manager dialog box is displayed.

3. Edit the database parameters to be able to connect to the databases.

4. Select OK.
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5. Select Tools > Options and select the File Locations tab.

6. Set the above paths as needed.

7. Click OK when done setting the paths.

8. Using Catalog > Open, open the Catalog file (.cat file) for each of the following:

R:\OA Advanced Reports\reports\cognos\Impromptu\CallCenterQ

R:\OA Advanced Reports\reports\cognos\Impromptu\qrepository

R:\OA Advanced Reports\reports\cognos\Impromptu\CustQ

R:\OA Advanced Reports\reports\cognos\Impromptu\HRQ

R:\OA Advanced Reports\reports\cognos\Impromptu\oadb

9. Connect to the database with the user ID and password.
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10. Open each .imr file in the related application folder. For example, if the ccq.cat file 
was opened, open each .imr file in the CallCenterQ directory and cancel out of any 
parameter prompts. See the following dialog box as an example:
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11. Select the bitmap on each report, right click the report, and select Properties.

The Picture Properties dialog box is displayed.

12. Modify the source path and select OK.
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13. Select Report > General.
The Report Properties dialog box is displayed.

14. Modify the Catalog path and select OK.

The following Impromptu message dialog box is displayed:



Changing the Cognos installation

Issue 2.0 July 2005 347

15. Select Yes.

The following Impromptu message dialog box is displayed:

16. Select Yes.

17. Repeat Steps 10 through 16 for each .imr file in the appropriate directory. You may 
also open each .imr file in the directory and the appropriate .cat file will be opened.

18. For Impromptu files under cubes/XXX subdirectories, do one of the following:

● Open all .imr files with Impromptu Administrator and do a Save as to save each 
.imr file as a *.iqd file, overwriting the existing file.

● Use a text editor to edit the file paths in all *.iqd files.

19. Open Power Play Transformer.

20. Select Files > Preferences.
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21. Select the Directories tab.

22. Set the above paths as needed.

23. Click OK when done setting the paths.
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24. Open each MDL at the following locations:

R:\OA Advanced Reports\reports\cognos\cubes\CallCenterQ

R:\OA Advanced Reports\reports\cognos\cubes\contacts

R:\OA Advanced Reports\reports\cognos\cubes\tasks

R:\OA Advanced Reports\reports\cognos\cubes\CMS

R:\OA Advanced Reports\reports\cognos\cubes\MMA

The following is an example of the Data Sources dialog box:
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25. For each MDL file, change Data Sources by right clicking on the first one and selecting 
Properties.

The Data Source - MDL_file dialog box is displayed:

26. Set the local data file parameter to the correct directory path, for example:

r:\oa advanced reports\reports\cognos\cubes\callcenterq\
timeranges.iqd

For multibyte (localized) versions of cubes, this example will be:

r:\oa advanced reports\reports\cognos\cubes\callcenterq\
timeranges.csv
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27. Select OK.

The following warning dialog box is displayed:

28. Select Yes.

29. Save the MDL file.
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30. Right click on each Measure in each MDL file and select Properties.

The properties dialog box is displayed.

31. If the Drill Through tab has an entry, you need to modify the path for each entry for 
every measure listed. Some may not have any entries in the Drill Through tab. For 
example, change to:

R:\OA Advanced Reports\reports\cognos\Impromptu\CallCenterQ

Note:
Note: There are several entries in the MDL file that will have to be changed 

manually as they are not user editable from the application. Use a text 
editor, such as Text Pad, to make these changes.

32. Open the MDL file in Powerplay Transformer.

33. Under the Run menu, run Generate Categories and Update PowerCubes.

34. Open PowerPlay
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35. Go to File > Preferences and select the Directories tab.

36. Set the paths as appropriate for the reports on which you will be working. For example,

R:\OA Advanced Reports\reports\cognos\PowerPlay\CallCenterQ

R:\OA Advanced Reports\reports\cognos\PowerPlay\qrepository

R:\OA Advanced Reports\reports\cognos\PowerPlay\tasks

37. Click OK when finished.
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Appendix C: Remote installation of CMS data 
collection software

It is common for contact center configurations to include many CMS systems in 
geographically disperse locations. This appendix describes a process that allows you to 
remotely install the CMS data collection software from a central location where OA is 
installed.

Follow these steps:

1. Log in as root to the CDE on the local CMS machine.

2. Telnet (or rlogin) to the remote CMS machine.

3. Create a temporary user account on the remote machine, for example oainstall.
4. Assign a home directory (for example: /export/home/oainstall) or simply create a 

temporary directory where the OA setup files will be copied.

5. Open an xterm window on the local CMS machine.

6. Use FTP to connect to the remote CMS machine.

7. Copy the SolSetup and setup.jar files from the OA installation CD to the desired 
directory on the remote machine.

8. Terminate the FTP session.

9. On the local machine, execute xhost +remote-CMS where remote-CMS is either a 
host name as defined in /etc/hosts, or the IP address of the remote CMS machine.

10. On the local machine, execute rlogin remote-CMS where remote-CMS is either a 
host name as defined in /etc/hosts, or the IP address of the remote CMS machine.

11. Enter the commands:

DISPLAY=local-machine:0.0

export DISPLAY

where local-machine is either a host name of the local CMS machine as defined 
in /etc/hosts, or the IP address of the local CMS machine.

12. Use cd to move to the directory where SolSetup and setup.jar were copied.

13. Enter the command ./SolSetup

14. The Java virtual machine initializes and the OA Welcome dialog box appears.

15. Click Next.
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16. Continue with Step 4 of Installing Avaya OA components on a CMS server on page 92.
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Glossary

Administration screen Screen on the right side of the OA Client interface that contains information 
about configuration settings which are selected in the navigation tree.

ADU Agent data unit

Agent A customer service representative (CSR). An agent is a person qualified to 
handle customer requests. He or she may deal with customers directly or just 
process customer requests.

Aggregated data Data that OA has aggregated or summarized. Aggregated data has the 
minimum value (least), maximum value (greatest), sum, or a combination of 
those values, for each data period. Each column in the schema can be set to 
a different aggregation behavior, as long as it contains numeric data.
Aggregation occurs at an offset after the end of each base interval. The 
default offset is 10 minutes, but the offset can be set from 10 to 25 minutes 
by modifying the system scheduled aggregation job.

Aggregation OA aggregates or summarizes data by selecting the minimum value (least), 
maximum value (greatest), or sum of a numerical measure for a particular 
data period. A data period involves one base interval. 

Aggregation job Job that aggregates data. An aggregation job summarizes data by selecting 
the minimum value (least), maximum value (greatest), sum of each data 
period, or a combination of those options. 
A system scheduled aggregation job runs at an offset after the end of a base 
interval. The default offset is 10 minutes, but the offset can be set from 10 to 
25 minutes by modifying the system scheduled aggregation job. This job 
aggregates data for that interval only.
An on-demand aggregation job can aggregate data for multiple intervals, up 
to 24 hours of data.

Aggregation recovery 
job

Job that re-aggregates and archives container data that was not successfully 
aggregated in the past 30 hours. If enabled, the aggregation recovery job 
runs every six hours and aggregates data that was not successfully 
aggregated in previous attempts.
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API Application Program Interface. An API is a set of routines that allows an 
application program to gain access to the operating system or application 
program. A developer who wants to build a program that makes requests to 
the operating system or application must use the prescribed method.

Archive The act of compressing and summarizing aggregated data into the historical 
database. While aggregation occurs for every base interval, archiving occurs 
on a daily, weekly or monthly basis, with the frequency determined by your 
configuration, which is specified in the Container Archives administration 
screen.

Archived data Aggregated data that has been stored in the historical database. The data is 
categorized into daily, weekly and monthly archives.

Avaya CMS Analytical 
license

This license is used for configurations that allow only Avaya CMS as a data 
source to Avaya OA (no Avaya IC data source). With this license, you get 
both Basic Reports and Advanced Reports.

Avaya IC and Avaya 
CMS Analytical license

This license is used for configurations that allow Avaya IC and Avaya CMS 
as data sources to Avaya OA. With this license, you get both Basic Reports 
and Advanced Reports.

back-end database A database that is located on a different machine than where the Historical 
subsystem software is installed.

Base interval OA lumps IC real-time data into 30-minute intervals in the Historical 
subsystem.
Also called intervals.
See also base interval data.

Base interval data Real-time data that OA has lumped into 30-minute intervals. The Real-time 
subsystem summarizes IC data into 30-minute intervals and transfers it to 
the Historical subsystem, which proceeds to aggregate the base interval data 
into containers.

CDE Common Desktop Environment, a windows-like desktop environment used 
with Solaris.

Container Metadata that defines how data should be sifted and stored in the historical 
database. The term "container" can represent both the table definition as well 
as the data contained in the table.
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Container aggregation 
job

Scheduled job that aggregates selected containers. You specify the 
aggregation period and select the containers in the Scheduled Jobs 
administration screen.

Container data purge 
job

Scheduled job that purge aggregated and archived data. You specify which 
data in the containers and archives to delete in the Scheduled Jobs 
administration screen.

Container filter Container definitions that you customize. A filter determines which fields of 
the base interval data are aggregated into a container. It specifies the name, 
data fields and default values for each container.

Container limit Limit or constraint that you set on your containers. This enhances data 
calculation performance and disk usage. You can configure the maximum 
number of containers and rules in the Container Archives administration 
screen.

Container profile Includes the definition and the name of a container. Container profiles 
contain rules that detail what fields a container should have and what sort of 
data it should collect. Each container has a profile which has a filter that may 
contain from one to 100 rules.

Container rule Defines which rows of data in the historical store should be collected. Each 
container has a profile and a profile may have from one to 100 rules.
Also called filter rules or rules. 

Coordinated Universal 
TIme

Coordinated Universal Time (UTC). Formerly called Greenwich Mean Time 
(GMT). UTC reflects the time in the prime meridian and uses a 24-hour 
format. For example, it uses 14:00 to represent 2:00 p.m.
OA stores data in UTC but converts the time to the local time of the client.

CORBA Common Object Request Broker Architecture. CORBA is a way to create 
and manage distributed program objects in a network. It lets programs 
developed by different vendors or programs scattered throughout different 
servers communicate. A program in a client can request services from a 
program in a server without having to understand where the server is in a 
distributed network or what the interface to the server program is.

Current schema The existing schema that is being used. The current schema is the 
pre-migration schema. 

Daemon A program that runs continuously in the background and handles periodic 
service requests. The daemon forwards the requests to other programs or 
processes them as appropriate. 
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Daily interval A 24-hour shift that OA uses for real-time statistical reporting.

Data dictionary A database about data and databases. The data dictionary holds the name, 
type, range of values, source, and authorization for access for each data 
element in the contact center's files and databases.

Data manager An interface service that resides on a server where a Real-time subsystem is 
installed. The data manager receives events, maintains real-time status 
information, summarizes data into fixed thirty-minute intervals, and forwards 
the data to the forwarders, a set of Real-time subsystem services.

Data type Category of data. Each type is a set of data with values that have predefined 
characteristics and has a specified range of values and a specific way of 
being processed by the computer and stored by the database. 

Database check job A job that inspects the overall state of the historical database. A database 
check job fine-tunes the database by scanning the database and its error 
logs, as well as updating the statistics on tables. It also reports inconsistent 
metadata and rolls over the error log file to prevent it from growing 
unbounded. It runs daily if enabled.

Default schema Schema that is pre-configured in OA. You can revert back to the 
pre-configured default schema if you decide to discard your changes. You 
need to migrate your data, however.

Detail data Historical data that cannot be aggregated.
Detail data contains information about the work item, such as the customer 
ID, work item ID and the origination.

Detail data purge job Scheduled job that purges selected detail data. You select which detail data 
to purge in the Scheduled Jobs administration screen.

Disabled container Container that is not collecting or aggregating data.

Disabled interface 
service

Data collection service that is not running.

Disabled job A job that has been configured but is not activated to run.

Display name A meaningful name associated with a value in the database. For example, 
instead of displaying the agent ID, OA Administration Client displays the 
agent name; so it will display "John Smith" instead of "1021454540554."

EDU Electronic Data Unit
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Enabled container Container that is collecting or aggregating data. 

Enabled interface 
service

Data collection service that is running.

Enabled job A job that will execute at scheduled times. See also disabled job.

Event An activity or change of state that occurs in a contact center. Examples 
include: a change in port state, an agent logging in, or a call transfer.

Execution frequency See recurrence.

External job Custom-designed instruction set that specifies when certain processes 
should be executed. You can add an external job, whose scripts reside in the 
historical server, into OA Administration Client and schedule its execution.

Failed Data collection status that indicates database errors.

Filter See container filter.

Filter rule See container rule.

Forwarder An interface service that resides on CMS or Real-time subsystems. The 
forwarder transfers the data it receives to its corresponding recorder. When 
the recorder is not available, the forwarder buffers the detailed data until the 
recorder is on-line again.

FQDN Fully-qualified domain name

GMT Greenwich Mean Time. Also known as UTC (Coordinated Universal Time). 
GMT reflects the time at the prime meridian and uses a 24-hour format. For 
example, it uses 14:00 to represent 2:00 p.m.
OA stores data in UTC but converts the time to the local time of the client.

historical database Where historical data about your contact center is collected and stored.

historical server The server where the Historical subsystem is installed.
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Historical store Storage location where historical or long-term contact center performance 
information is stored in a database. Each historical store consists of a 
database table or a group of database tables. OA has 11 stores that 
accumulate a variety of report-related data from IC or ACD systems.
The IC historical stores are: 

● Agent service class

● Agent state

● Agent outcome code

● Agent job

● Agent reason code

● Job summary

● Reason code summary

● Service class summary

● Service class state

● System completion code

● Display names

The ACD historical stores are:

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

● CMS call history

● CMS display names

Historical subsystem Along with the source subsystem, Real-time subsystem, Report subsystem, 
and CMS subsystem, the Historical subsystem constitutes the OA data 
collection system. The Historical subsystem pertains to all OA components 
and services that involve historical data.

IC Avaya Interaction Center.

IDL See Interface Definition language.

IIS Internet Information Service, the Web server software for Windows.
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Incomplete Data collection status that indicates there is missing data and the container 
or archive is missing the data for at least one base interval.

Info store Historical store with a group of database tables that keeps track of the 
display names for the data fields.

Interface definition 
language

A language used to communicate with various software components in a 
CORBA network.

Interface service Process that automatically collects data in the background while the system 
is up. An interface service handles periodic service requests and forwards 
the requests to other programs or processes as appropriate. The OA 
interface services include:

● Data manager

● Report data server

● Report Subsystem

● The respective forwarders and recorders for each historical store.

Interface service name The internal name that the OA Administration client uses to identify, enable 
and disable the services. You cannot change the names of the services. 

Interval data See base interval data.

Java database 
connectivity

Java Database Connectivity. An application program interface (API) 
specification for connecting Java programs to a database. The API lets you 
request statements in Structured Query Language (SQL) which are then sent 
to the program that manages the database.

JDBC See Java database connectivity.

JDK Java Developer�s Toolkit

Job Instruction set that specifies when certain processes should be executed. 
The Scheduled Jobs administration screen enables you to automate certain 
tasks such as data purges and aggregation.

JRE Java RunTime Environment

Migration The process by which OA alters the database tables to conform to a new 
schema and moves the data to the new tables.

MSMQ Microsoft Message Queue. MSMQ is a software program that allows 
programs to send messages to other programs.



Navigation tree

364 Operational Analyst 7.0 Installation and Configuration

Navigation tree Tree that appears on the left side of your OA Administration client interface, 
and contains various configuration tools for customizing and managing data 
collection.

No data Data collection status that indicates no data exists. OA did not find matching 
records. 

Not null Clause in a column or field that specifies that the column or field cannot 
contain a null value. You must define a default value.

Null Special value in the database which represents an unknown value. A null 
value is not the same as blank (which is a valid character), zero (which is a 
valid number), or a zero length string.

On-demand job A scheduled job you define to execute tasks on specific data only once at a 
particular time or regularly on a recurring basis. An on-demand job is 
different from a system scheduled job in that it is limited in scope and applies 
to selected data. On-demand job types include:

● Aggregation

● Container purge

● Detail purge

● Data collection

● External

ORB In distributed computing, an Object Request Broker (ORB) is an agent that 
dispatches requests to other agents.

Parameter A piece of information, such as a file name, a coordinate, or a range of 
values, that is passed to a program by a user or another program.

Pending schema A custom-defined schema that is not implemented until migration.

pid See Process ID.

Process ID Identification name or number for an OA process.

Purge The deletion of selected container data or detail data.

Purge job A job that deletes selected containers and detail data from the historical 
database. A purge job is different from a system-scheduled purge job in that 
it is more focused and deletes only particular pieces of data you specify in 
the Scheduled Jobs administration screen.
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RAID Redundant Array of Inexpensive Disks

Real-time subsystem Along with the source subsystem, Historical subsystem, Report subsystem, 
and CMS subsystem, the Real-time subsystem constitutes the OA data 
collection system. The Real-time subsystem pertains to all OA components 
and services that involve real-time data.

Recorder An interface service that resides in the Historical subsystem. The recorder 
time stamps the data it receives from the forwarder and inserts the data into 
the historical database.
There are up to 11 recorders, one for each historical store. 

Report subsystem The self-contained OA reporting subsystem application programming 
interface (API) that provides an environment to create reports based on the 
OA real-time data. It is a subsystem that lets you develop servlet-based 
applications for Web-based reporting and monitoring for your contact center.

Reporting Framework 
(Stumbras) API

Provides a programming interface for report writers with useful functionality 
such as RTPA Service for the real-time data access and DB Pool Service for 
connecting the historical database.

Retention period The length of time OA retains data.

Rule See container rule.

Schema The overall structure of the database tables that store information: user 
profile data, content metadata, or pure structured information. In the simplest 
case, a database schema has a single database table of user information. 
Each record (row) within this table might represent a unique customer, with 
each field (column) representing relevant customer information (address, 
city, phone number, and so on.). More complex schema would involve 
multiple database tables related to one another through a common unique 
identifier. Such relational database tables are necessary for more complex 
data schemas for performance and easier administration.

Select To select an item, click the item's name or icon. Selected items appear 
highlighted on the screen.

Service See interface service.

Service class A logical category used to measure service levels and define goals for that 
work. A particular service class can consist of any combination of interaction 
source (such as call, fax, or email), customer class (such as Platinum, Gold, 
or Silver), or activity (such as new loan or account inquiry). 
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Source-CMS 
subsystem

OA subsystem that collects CMS historical data.

Source-EC subsystem OA subsystem that collects data from Avaya IC.

Source-EC Bridge 
subsystem

OA subsystem that collects data from Business Advocate.

SQL See Structured Query Language.

Status window Window on the results screen that lets you view the status of elements such 
as your schemas or interface services that you have set up.

Store See historical store.

String A data type of a column in a table which is composed of a sequence of 
characters usually representing human-readable text. The column must be a 
contiguous set of alphanumeric characters that does not contain numbers 
used for calculations. Names, addresses and error messages are examples 
of strings.

Structured Query 
Language

Structured Query Language. The standard programming language for getting 
information from and updating a database. Queries let you select, insert, 
update, find out the location of data, etc.

Subsystem A major component that constitutes the OA data collection system. The 
available subsystems are:

● Historical 

● Real-time

● Report

● Source (CMS, EC, and EC-Bridge)
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Summary data Data that pertains to the performance of the contact center. While detail data 
tracks work items, summary data tracks agents and IVR systems. Summary 
data is also aggregated and, if configured, stored in containers and archives.
These historical stores contain summary data:

● Agent service class

● Agent state

● Service class summary

● Service class state

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

Summary historical 
store

A historical store that contains aggregated data. Available summary 
historical stores are:

● Agent service class

● Agent state

● Service class summary

● Service class state

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

Sun Java System Web 
Server

The new product name for the Solaris Web Server, formerly Sun ONE Web 
Server, and before that, iPlanet.

System scheduled 
aggregation job

A job that aggregates base interval data. This job executes on every base 
interval, that is, in 30-minute increments, if enabled.

System scheduled job A job that is executed on a system-wide level. This job applies to all the 
containers and data in the system. The following types of jobs are system 
scheduled jobs: aggregation, aggregation recovery, ACD display name 
collection, database check and database purge.
See also on-demand jobs.
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System scheduled 
purge job

A job that deletes container and detail data from the historical database 
according to the data retention limits defined in the Retention Periods 
administration screen. A system-scheduled purge job is different from 
on-demand purge jobs in that it executes on the entire system and not just on 
a particular set of data. This executes daily, if enabled.

TNS Transparent Network Substrate

Tree A way of structuring information, where sublevels are shown as branches of 
a higher level. The navigation tree in OA Administration client contains a tree 
of configuration tools. Items on a tree are also referred to as nodes.

Unicode A character set that can accommodate the alphabet of most of the world's 
languages. Unicode can accommodate 65,536 different characters rather 
than just 256, and uses two bytes for each character rather than one.

UTC Coordinated Universal Time. Formerly called Greenwich Mean Time (GMT). 
UTC reflects the time in the prime meridian and uses a 24-hour format. For 
example, it uses 14:00 to represent 2:00 p.m.
OA stores data in UTC but converts the time to the local time of the client.

Widget A graphical user interface element that lets you interact with the application. 
Examples of widgets include drop-down lists, buttons, text boxes, and radio 
buttons.

Work item Data that describes the flow of work through a business process. This data 
may include details about the agents involved with the work, the amount of 
time the item spent in various queues, and any followup calls.

Workflow The flow of work in a business process; work travels from one point to 
another so that necessary tasks can be completed on that piece of work.

x-axis On graphical reports, the x-axis applies to the left-to-right labels of the report 
floors, left walls, and right walls.

y-axis On graphical reports, the y-axis applies to:

● the front-to-back labels on the report floor.

● the bottom-to-top labels on the report left walls and right walls.
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